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Welcome to your printer

Your printer is a color inkjet printer designed for printing high-quality images on paper up to 1118 mm (44 in)
wide. Some major features of the printer are shown below:

e  Print resolution of up to 2400 x 1200 optimized dpi, from a 1200 x 1200 dpi input, using the Best print-
quality option, the Maximum Detail option and photo paper.

e  The printer can be controlled from its front panel or from a remote computer using the Embedded Web
Server, HP DesignJet Utility, or HP Click Printing Software (see http://www.hp.com/go/designjetclick).

e  Touch-sensitive front panel in color, with an intuitive graphical user interface.

e  Job previews in the front panel.

e  Job previews on remote computers.

e Includes Web-connected features such as automatic firmware updates, HP ePrint, and Mobile Printing.

e  Driverless printing: Files in common graphical formats can be printed directly without needing a printer
driver. Just insert a USB flash drive or use HP Click Printing Software.

e  Paper flexibility and automatic easy load, see Paper handling on page 24, with information and presets
accessible from the front panel and the HP DesignJet Utility.

e  Handles cut-sheet and roll paper.

e  Six-ink system.

e  Accurate and consistent color reproduction with automatic color calibration.
e  Economode for printing economically.

e  Tworolls loaded at once (T1700dr only) provide fast and easy switching between different rolls, or long
runs of unattended printing.

e  High productivity features such as job previewing and nesting using HP Click Printing Software.

e Ink and paper usage information available from the Embedded Web Server, see Embedded Web Server
on page 14.

e  Access to the online HP Support Center (see HP Support Center on page 169).

Printer models

This guide covers the following printer models, normally referring to them by their short names for brevity.

Full name Short name
HP DesignJet T1700 T1700
HP DesignJet T1700 PostScript Printer T1700 PS
HP DesignJet T1700dr T1700dr
HP DesignJet T1700dr PostScript Printer T1700dr PS
Safety precautions
Read these safety precautions before using your printer. Also read your local Environmental, Health, and Safety
regulations.
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This equipment is not suitable for use in locations where children are likely to be present.

For any maintenance or part replacement, follow the instructions provided in HP documentation to minimize
safety risks and to avoid damaging the printer.

General safety guidelines

There are no operator-serviceable parts inside the printer except those covered by HP’s Customer Self Repair
program (see http://www.hp.com/go/selfrepair). Refer servicing of other parts to qualified service personnel.

Turn off the printer and call your service representative in any of the following cases:
e  Thepower cord or plug is damaged.

e  The printer has been damaged by an impact.

e  Thereis any mechanical or enclosure damage.
e  Liquid has entered the printer.
e  Thereis smoke or an unusual smell coming from the printer.

e  The printer has been dropped.

e  The printeris not operating normally.

Turn off the printer in either of the following cases:

e  During a thunderstorm.

e  During a power failure.

Take special care with zones marked with warning labels.

Ventilation measures for your location, whether office, copy room, or printer room, should meet local
environmental health and safety (EHS) guidelines and regulations.

Electrical shock hazard

AWARNING! The internal circuits of the built-in power supplies and power inlet operate at hazardous voltages
capable of causing death or serious personal injury.

Unplug the printer's power cord before servicing the printer.

The printer requires a building installation circuit breaker, which must meet the requirements of the printer and
should be in accordance with the Electrical Code requirements of the local jurisdiction of the country in which the
equipment is installed.

To avoid the risk of electric shock:

e  The printer should be connected to earthed mains outlets only.

e  Avoid overloading the printer's electrical outlet with multiple devices.

e Do not remove or open any closed system covers or plugs.

e Do notinsert objects through slots in the printer.

e  Take care not to trip over the cables when walking behind the printer.

e Insert the power cord securely and completely into the wall socket and printer inlet.

e Never handle the power cord with wet hands.
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Fire hazard

To avoid the risk of fire, take the following precautions:

The customer is responsible for meeting the printer’s requirements and the Electrical Code requirements
according to the local jurisdiction of the country where the printer is installed. Use the power supply voltage
specified on the nameplate.

Use only the power cord supplied by HP with the printer. Do not use a damaged power cord. Do not use the
power cord with other products.

Do not insert objects through slots in the printer.

Take care not to spill liquid on the printer. After cleaning, make sure all components are dry before using
the printer again.

Do not use aerosol products that contain flammable gases inside or around the printer. Do not operate the
printer in an explosive atmosphere.

Do not block or cover the openings of the printer.

Mechanical hazard

The printer has moving parts that could cause injury. To avoid personal injury, take the following precautions
when working close to the printer.

Keep your clothing and all parts of your body away from moving parts.

Avoid wearing necklaces, bracelets, and other hanging objects.

If your hair is long, try to secure it so that it will not fall into the printer.

Take care that sleeves or gloves do not get caught in moving parts.

Do not operate the printer with covers bypassed.

If you need to replace the cutter assembly, take care not to cut yourself on the sharp cutting edge.
Internal fan blades are hazardous moving parts. Disconnect the printer before servicing.

Never insert your hands into the printer while it is printing, due to the moving parts inside.

Heavy paper hazard

Special care must be taken to avoid personal injury when handling heavy papers.

Ink handling

Handling heavy paper rolls may require more than one person. Care must be taken to avoid back strain
and/or injury.

When handling heavy paper rolls, wear personal protective equipment, including boots and gloves.

Follow your local Environmental Health and Safety regulations for handling heavy paper rolls.

HP recommends that you wear gloves when handling ink supplies.

Warnings and cautions

The following symbols are used in this manual to ensure the proper use of the printer and to prevent the printer
from being damaged. Follow the instructions marked with these symbols.
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AWARNING! Failure to follow the guidelines marked with this symbol could result in serious personal injury or

death.

A CAUTION:  Failure to follow the guidelines marked with this symbol could result in minor personal injury or

damage to the printer.

Warning labels

Explanation

Electric shock hazard. Hazardous voltages inside the electrical box.
Disconnect the power cord before servicing. Before starting, read
and follow the operating and safety instructions.

Moving part. Keep your fingers and hands away from the moving
paper system.

Moving fan blade. While servicing, keep your fingers and hands
away from the blades.

Sharp edges. Avoid handling the cutting system.

When replacing the cutter assembly, handle with care and follow
the safety instructions.

Risk of inlet damage. Maintain the end stoppers always assembled.
Only disassemble if needed for printer relocation.

[%”f NOTE: The final label position and its size on the printer may vary slightly, but labels should always be visible

and close to the potential risk area.
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Main components

The following front and rear views of the printer illustrate the main components.

Front view

1. Window

2. Printhead carriage

3. Printhead

4.  Front panel

5. Ink cartridge slot

6. Ink cartridge

7. OQutput platen

8.  Paper alignment lines

9. Basket
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Rear view

B’ NOTE:  This illustration shows the T1700dr.

1.  Gigabit Ethernet port

2. Communication port

3. Power socket
4.  Roll cover
5. Paperroll

¥ NOTE:  The upper rollis roll 1 and the lower rollis roll 2.

6.  Spindle stop

7. Spindle

ENWW Main components 7
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Communication ports
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2. Gigabit Ethernet port, to connect to a network

A

g

1. Power socket

3. Communication port

4.  Diagnostic LEDs, to be used by service engineers

The Hi-Speed USB host port is on the other side of the printer, beside the front panel.

Chapter 1 Introduction
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Wall spacers (some models only)

If you place the printer close to a wall, ensure that there is some space between the printer and the wall.
Otherwise, you may experience paper advance problems. If your model has wall spacers, lower them to ensure a
minimum distance.

Turn the printer on and off

ENWW

¥ TP The printer can be left powered on without wasting energy. Leaving it on improves response time and

overall system reliability. When the printer has not been used for a certain period of time (the default time is
determined by Energy Star), it saves power by going into sleep mode. However, any interaction with the printer's
front-panel display, or sending a new job to print, returns it to active mode, and it can resume printing
immediately. To change the sleep mode time, see Change system options on page 12.

ﬂ#’f NOTE: Insleep mode, the printer performs maintenance service to the printheads from time to time. This

avoids long preparation times after long idle periods. Therefore, it is strongly recommended to leave the printer
powered on or in sleep mode to avoid wasting ink and time.

If you want to turn the printer on or off or reset the printer, the normal and recommended method is to use the
power key beside the front panel.

However, if you plan to store the printer for a long period or the power key does not seem to work, you are
recommended to unplug the power cord at the rear.

To turn it back on, plug in the power cord.

When the printer is powered back on, it takes about three minutes to initialize and check and prepare the
printheads. Preparing the printheads takes about 75 seconds. However, if the printer has been off for six weeks
or more, preparing the printheads could take up to 45 minutes.

Turn the printer on and off



Front panel

The front panel is a touch-sensitive screen with a graphical user interface, located on the front right of the
printer.

It gives you complete control of your printer: from the front panel, you can view information about the printer,
change printer settings, monitor printer status, and perform tasks such as supplies replacement and
calibrations. The front panel displays alerts (warning and error messages) when necessary.

o

\

o }
A\ v
/9

/T ]

It includes the following components:

1. AHi-Speed USB host port, intended for connecting a USB flash drive, which can provide files to be printed.
When a USB flash drive is inserted, a USB icon is displayed on the front panel's all-apps page.

2. The front panel itself: a 4.3 inch, full-color, touch-sensitive screen with a graphical user interface.
3. The power key, with which you can turn the printer on or off, or wake up from sleep mode.

The front panel has a large central area to display dynamic information and icons.

Left fixed icons

e Tap @ to return to the home page.
e  Tap P4 to view help about the current page.

e Tap to go back to the previous page. This does not discard any changes made to the current page.
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Home pages
There are three top-level pages that you can move between by sliding your finger across the screen:

e  Theall-apps page displays a list of all apps available in your printer, and the status of each of them.

[ X
1 © ¢ ©
Print from Paper Ink Job queue
uUsB
Optimize Connectivity Settings Usage
quality

User guide About printer

e If you swipe left to the widget page, you can see at a glance the status of ink and paper supplies.

24" Glossy
paper | | |
G

24" Bond
paper
D 36" Plain
paper PK MK Y M C

e  Atthe top of the all-apps page there is a dashboard that displays alerts related to the main functions of the
printer. Swipe down the dashboard to access the Status Center.

ENWW Frontpanel 11



Dim mode

After some time with no activity (5 minutes by default), the printer goes to dim mode, which reduces the
brightness of the front panel by 25%. Any activity, such as the use of the front panel or the arrival of a print job,
ends dim mode and restores normal brightness. After some time in dim mode (15 minutes by default), the
printer changes to sleep mode. The time periods can be changed from the front panel.

Sleep mode

Sleep mode puts the printer into a reduced power state after a period of inactivity, turning off some elements to
save energy. Printer features can be enabled from this mode, and the printer maintains network connectivity,
waking up only as necessary.

The printer can be woken from sleep mode any of the following ways:
e By pressing the power button

e Byopeningadoor

° By sending a print job

The printer wakes up in several seconds, more quickly than if it is completely turned off. While in sleep mode, the
power button blinks.

To change the time that elapses before sleep mode, see Change system options on page 12.

Printer Monitoring (with the Print Spooler) and Remote Printer Management with the HP Utility and Web
JetAdmin continue to be available during sleep mode. Some remote management tasks offer the option of
remotely waking up the printer if needed to perform the task.

Change the language of the front-panel display

There are two possible ways to change the language of the front-panel menus and messages.
e Ifyou can understand the current front-panel display language, tap @ then System > Language.

e Ifyou cannot understand the current front-panel display language, start with the printer powered off. Press
the power key to turn it on. When you see icons appear on the front panel, tap @ and then . The front
panel acknowledges this sequence by turning the icons on and off rapidly.

Whichever method you used, the language selection menu should now appear on the front-panel display. Tap
your preferred language.

The available languages are English, Portuguese, Spanish, Catalan, French, Dutch, Italian, German, Polish,
Russian, Simplified Chinese, Traditional Chinese, Korean, and Japanese.

Change system ODtiOﬂS
You can change various printer system options from the front panel. Tap @ then System.

° Date and time options to view or set the printer's date and time.

Speaker volume to change the volume of the printer's loudspeaker. Select Off, Low, or High.

Display brightness to change the brightness of the front-panel display. The default brightness is 50.
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HP Utility

Power options > Printer sleep to change the length of time the printer waits before going into sleep mode
(see Sleep mode on page 12). You can set the time from 5 to 240 minutes. The default time is 20 minutes
(total time including 5 minutes in dim mode).

Power options > Auto-off due to inactivity to turn off the printer automatically after 120 minutes of
inactivity.

Unit selection to change the units of measurement in the front-panel display. Select English or Metric. By
default, units are set to Metric.

Restore factory settings to restore the printer settings to their original values as set in the factory. This
option restores all of the printer settings except the administrator password and the paper presets.

Language.

Firmware update to configure the automatic firmware update.

The HP Utility enables you to manage your printer from a computer with a TCP/IP connection.

[%f> NOTE: The HP Utility under Mac OS X and the HP DesignJet Utility under Windows have similar functions and
are sometimes referred to collectively as the HP Utility in this guide.

You can install the HP Utility from http://www.hp.com/qo/T1700/drivers.

How to launch the HP Utility

ENWW

Under Windows, start the HP DesignJet Utility from the [ icon on your taskbar or from the Start menu >
HP > HP DesignJet Utility. This launches the HP DesignJet Utility, showing the printers installed on your
computer. When you open the HP DesignJet Utility for the first time, it may offer you an automatic update
with enhanced functionality that we recommend you to accept.

Under Mac 0S X, start the HP Utility from your Dock shortcut or by clicking Applications > HP > HP Utility.
This launches the HP Utility, showing the printers installed on your computer.

When you select your printer in the left pane, everything that appears in the right pane is specific to that
printer.

() v Designiet utiiy

Devices ($] Overview Supplies Support Admin Color Center O ?
i Printer details Supplies Alerts
@ T1700dr PostScript
HP DesignJet T1700dr 44-in Estimated ink levels (%)

PostScript Printer
6 pK mK Y M c

P |
83 84 a8 83 86 80
Estimate only. actual ink levels may vary

Product number

Paper in use
Serial number: Status Roll 1 ready
W versi i
FW version Paper type: HF Universal
Comnection Gloss Photo Paper
Width 914 mm

HP Utility

13


http://www.hp.com/go/T1700/drivers

HP Print Preview

The HP Print Preview application enables you to see a basic preliminary preview of how your job will be printed.
This application is available only under Windows. You can install the HP Print Preview by downloading the
integrated installer from http://www.hp.com/go/T1700/drivers.

-3 »
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Embedded Web Server

14

The following browsers are known to be compatible with the Embedded Web Server:
e  Microsoft Internet Explorer 11 and later for Windows 7 and later

e  Apple Safari 8 and later for 0S X 10.10 and later

e  Mozilla Firefox (latest version)

e  Google Chrome (latest version)

To use the Embedded Web Server on any computer, open your Web browser and enter the printer's IP address in

the browser's address bar. You can find your printer's IP address in the printer’s front panel: tap and then

Network. See Configure your printer on page 15.

& NOTE:  Your browser may display a security warning when you enter the IP address. If you have entered the

correct address, it is safe to ignore the warning and continue to access the Embedded Web Server.

The Embedded Web Server window displays a menu used to access all the supported functionality. It supports
the following languages: English, Portuguese, Spanish, Catalan, French, Dutch, Italian, German, Polish, Russian,
Simplified Chinese, Traditional Chinese, Korean, and Japanese. It uses the language that you specified in your
Web browser options. If you specify a language that it cannot support, it is displayed in the language selected in
the printer, or else in English.

To change the language, change your Web browser's language setting. To complete the change, close and
reopen your Web browser.

Demo prints

The demo prints give various kinds of information about your printer. They can be requested from the front
panel.
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Before requesting a demo print, check that the printer and the paper are ready for printing.

e  The loaded paper should be at least A3 landscape—419 mm (16.53 in) wide—otherwise the print may be
clipped.

e  The front panel should be displaying the Ready message.

To print a demo print, tap @ then scroll down and tap Internal prints, then Demo prints, and select a print.
The following prints are available:

e  Render

e  (ADblack & white

e GIS

Configure your printer

Connect the printer to your network

The printer is able to configure itself automatically for most networks, in a similar way to any computer in the
same network. The first time you connect it to a network, this process may take a few minutes.

Once the printer has a working network configuration, you can check its network address from the front panel:

% TIP: Consider making a note of the printer’s IP address, because you may need it during the setup process of
connecting your Windows or Mac OS computer clients.

Network Services {:}

Gigabit Ethernet

Connected

IP ADDRESS

Modify network configuration

To modify the current network configuration, go to the front panel and tap , then o then Network >

Gigabit Ethernet. From here it is possible, though not normally necessary, to change the settings manually; this
can also be done remotely using the Embedded Web Server.

For full details of the available connectivity settings, see Networking on page 41.

If you accidentally misconfigure the printer's network settings, you can restore the network settings to their

factory values from the front panel: tap , then Network > Restore factory settings. Then you must restart

the printer. This automatically provides a working network configuration for most networks. The printer’s other
settings remain unchanged.

ENWW Configure your printer 15



Install your printer under Windows

The following instructions apply if you intend to print from software applications using a printer driver. See
Printing on page 49 for alternative ways of printing.

Before you begin, check your equipment:
e  The printer should be set up and on.
e  The Ethernet switch or router should be on and functioning correctly.

e  The printer and the computer should be connected to the network (see Connect the printer to your network
on page 15).

Now you can proceed to install the printer software and connect to your printer.

Printer software installation

1. Make a note of the printer’s host name and IP address from the front panel (see Connect the printer to your
network on page 15).

2. Install the printer software from http://www.hp.com/go/T1700/drivers, following the software installation
instructions. By default, the following driver is installed:

e  Non-PostScript printers: The raster driver
o  PostScript printers, with Windows 7 or Windows Server 2008R2: The PostScript driver
° PostScript printers, with Windows 8, Windows Server 2012, or later: The PDF driver

3. Once downloaded, openiit, and follow on-screen steps.

If your computer fails to find any printers on the network, the Printer Not Found window is displayed, which helps
you to try to find your printer. If you have a firewall in operation; you may have to disable it temporarily in order
to find the printer. You also have the options of searching for the printer by its hostname, IP address or MAC
address.

Uninstall the printer software under Windows

Use the Control Panel to uninstall the software, in the same way as you can uninstall any other software.

Install your printer under Mac 0S X
You can connect your printer to a network under Mac OS X by using the following methods:
° Bonjour

e  TCP/IP (important: select HP Jetdirect-Socket)

r.%f' NOTE: The printer does not support AppleTalk.

The following instructions apply if you intend to print from software applications using a printer driver. See
Printing on page 49 for alternative ways of printing.

Before you begin, check your equipment:
e  The printer should be set up and on.
e  The Ethernet switch or router should be on and functioning correctly.

e  The printer and the computer should be connected to the network (see Connect the printer to your network
on page 15).
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Now you can proceed to install the printer software and connect to your printer.

1.  Goto the front panel and tap O then Network, and note the IP address of your printer. If you intend

to connect with Bonjour, click the network card and note the Bonjour name.

2. Install the printer software from http://www.hp.com/go/T1700/drivers.

3. Select Windows or Mac 0S X software, and choose which specific software you want to install (by default,
all of it).

B NOTE:  You can download HP Click with the other software.

4.  Double-click the HP DesignJet Installer icon. You will be guided through the steps to install the HP software
for your printer.

5. When the software has been installed, the HP Utility Setup Assistant starts automatically, to set up a
connection to your printer.

6.  Inthe Setup Assistant, look for your printer's Bonjour name or IP address (which you noted in step 1) in the
table.

e Ifyou find the right name, scroll sideways if necessary to see the Connection column, and check that it
shows Bonjour. Then highlight that line. Otherwise, continue searching further down the list.

e If you cannot find your printer's name, just click Continue and do the setup manually. Access System
Preferences, and in Printers and Scanners select the + sign at the bottom of the table. Then go to the
IP tab, enter your IP address, and select the protocol HP Jetdirect-Socket.

Click Continue.

7.  Follow the instructions on the screen.

Uninstall the printer software under Mac 0S X

During the previous installation step, you have the option to install the HP Uninstaller application in your system.
This should be available under HP in the system Applications folder.

I!ij”f IMPORTANT:  The HP Uninstaller application will uninstall all HP Software installed in your system.

To delete the print queue only, select the Printers & Scanners dialog from the system preferences. Click the name
of the printer and then click the — button.

Set up printer services

ENWW

You can set up the following services:

e  Receive automatic firmware updates

e  Enable email printing

e  Participate in the Product Data Sharing Agreement
e  Enable additional printer services

A network connection is required, so the printer will test its own connectivity. Remember to connect the network
cable to the printer.

Each printer service can be enabled or disabled individually as explained below.

Configure your printer
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During initial printer setup, you are asked whether you want to enable these services. That decision can be

changed later by tapping , then o then Services > Printer Data Sharing Agreement.

If you are part of the HP Partner Link Pay-per-use service, tap , then Services > <+« > Register new

service in order to register the printer service.

Verify printer connection to HP

You can check that the printer is able to connect to HP services by tapping and viewing the status there.

You can see detailed information by clicking the Network or Service card.

Gigabit Ethernet

Connected

GENERAL INFORMATION
STATUS

1/0 card ready
MAC ADDRESS

LINK SPEED

If there is any problem connecting to HP, you will be provided with a description of the problem and some
possible solutions.

Enable email printing with HP ePrint

The HP Connected service makes it easy to send jobs to your printer by attaching them to an email message.

You must accept the Printer Data Sharing Agreement in order to use HP Connected.

To configure the email printing configuration, tap , then Services. Scroll down until you find the HP ePrint

card, which will display your printer’'s email address, which can be used to send jobs to the printer. Double-click
the HP ePrint card to access the printer's code and other configuration details.

If you are the printer administrator, log in at HP Connected (http://www.hpconnected.com) to customize your
printer’s email address or manage printer security for remote printing.

You must also visit http://www.hpconnected.com to register yourself and your printer (using the printer code).

Configure your HP ePrint connection

By default, the jobs sent by email are directly printed. To change the settings, tap , then o at the right

top corner of the page, then Services > HP Connected > HP ePrint jobs > On hold.

You can disable the connection to HP ePrint if required for security. At the front panel, tap , then o at

the right top corner of the page, then Services > HP Connected > HP ePrint Connectivity > Disable.

Disable just puts the remote printing function on hold. If you want to resume using it, you just need to re-enable
it in the same menu. No more setup steps are required.
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If you want to disable remote printing permanently, tap Remove. To use remote printing again, you will need to
set it up again from scratch.

Configure firmware updates

You can choose from the Embedded Web Server or from the front panel whether and how to download firmware
updates.

[%”r NOTE: If an administrator password has been set, it will be required to change these settings.

e Inthe Embedded Web Server: Click About printer > Firmware update.

e  Using the front panel: Tap @ then System > Firmware update.

The following settings are available:

e  Download new firmware automatically: If you select Automatically (the default setting), the printer will
automatically download new firmware whenever it becomes available. Deactivate this option to download
new firmware manually.

’L%y NOTE: Downloading the firmware does not mean that you have installed it in your printer. To install the
new firmware, you must confirm the installation manually.

Control access to the printer

Manage printer security with HP Connected

When you have set up Web Services, the printer is in unlock mode. In unlock mode, anyone who knows your
printer's email address can print to your printer just by sending a file to it. Although HP provides a spam filtering
service, you should be careful about giving out your printer's email address, as everything sent to that address
may be printed on your printer.

If you are the printer administrator, you can manage printer security or change your printer status to lock mode
by visiting HP Connected at http://www.hpconnected.com. You can also customize your printer's email address
and manage print jobs from there. At your first visit, you will need to create an account at HP Connected using
the printer's code.

Embedded Web Server security settings

From the Embedded Web Server menu, you can click Security and then Administrator password to control access
to the printer by specifying an administrator account to control access to the Embedded Web Server and the
printer’s front panel.

The administrator can also define other types of permissions in the control panel through the Access control
menu option. In this section, the administrator can create new printer user accounts and assign them specific
permissions depending on their role.

Other security settings are available under the Security settings menu option, which apply to all users.
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Front-panel security settings

From the front panel, you can tap @ then Security, to control some of the features of the printer:

e  Usersessions: Enable or disable automatic log-out after 1, 3, or 5 minutes.
e  Embedded Web Server: Enable or disable the Embedded Web Server.

e  Printing & management Web services: Enable or disable Web services that are used by printing and
management tools such as the HP Utility, HP Click, and SDK for RIPs.

If an administrator password has been set, it must be given in order to perform the following operations:
e  (hange the security settings (including the administrator password itself).

e  (Change the configuration of the Internet connection.

e  (Change the Automatic Firmware Update configuration.

e  Enable or disable automatic downloading and/or installation of automatic firmware updates.

e  Restore an earlier firmware version.

e  Reset factory defaults.

[%,/r NOTE: The administrator password can contain only characters that appear on the front panel's on-screen
keyboard. If you set a new password with the Embedded Web Server, it will reject characters that do not appear
in that limited character set.

Require account ID
If you want to keep records of printer usage by different users, you can set your printer to require an account ID
for each job. At the front panel, tap @ then Job management > Account ID required.
If this setting is turned on, the account ID field will be mandatory and jobs with no account ID will be kept "on hold
for accounting".

The account ID can be set in the printer driver when sending the job. If the job is set "on hold for accounting” by
the printer, you can introduce the account ID in the driver or front panel, by going to the job queue and clicking
the job that is on hold. A window with a text box is displayed and you can enter the account ID into it.

Drivers
There are various different drivers for your printer; which is best for you depends on your circumstances:
e  Your operating system
e  The type of applications from which you print
e  The number of printers you have
° The output accessories you have
You may wish to install one or several drivers according to your needs.

You can find the latest driver software at http://www.hp.com/go/T1700/drivers/.
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Specific Windows drivers
The following driver is recommended:
e  Non-PostScript printers: The raster driver
e  PostScript printers, with Windows 7 or Windows Server 2008R2: The PostScript driver

° PostScript printers, with Windows 8, Windows Server 2012, or later: The PDF driver

HP DesignJet Universal Print Driver for Windows

The Universal Print Driver (UPD) is recommended if you have a fleet of HP Designlet and PageWide XL printers: it
facilitates installation and queue management.

HP Universal Print Driver configuration tool

The HP UPD configuration tool is a utility that allows you to personalize Designlet and PageWide UPDs by
modifying the default settings or locking some of them, preventing users from changing them. This tool is
intended for IT administrators.

To install the tool, go to http://www.hp.com/qo/T1700/support and click Software and drivers > Software —
Utility > UPD configuration tool > Download.

For information about how to install and use the tool, go to https://support.hp.com/us-en/document/
c05658213.

Mac OS drivers

Raster driver
e  Specifically for Mac 0S X 10.9, 10.10, 10.11, 10.12,and 10.13

e  Best for CAD, GIS, and office applications

PostScript 3 driver
e  Specifically for Mac 0S X 10.9, 10.10, 10.11, 10:12, and 10.13

e  Best for applications requiring accurate color

Set Windows driver preferences

You can change some default settings in your printer driver according to your own preferences, for instance to
set color or paper-saving options. To do this, click the Start or Search button on your computer's screen, then
click Devices and Settings or Devices and Printers. In the next window, right-click your printer's icon, and click
Printing Preferences. Any settings you change in the Printing Preferences window will be saved as default values
for the current user.

To set the default values for all users of your system, right-click the printer’s icon, click Printer Properties, go to
the Advanced tab, and click Printing Defaults. Any settings you change in the printing defaults will be saved for all
users.

Change the graphic language setting

You can change the graphic language setting from the front panel. Tap @ then Default printing

configuration > Graphics language.

ENWW Configure your printer 21


http://www.hp.com/go/T1700/support
https://support.hp.com/us-en/document/c05658213
https://support.hp.com/us-en/document/c05658213

Then select one of the following options:

e  Select Automatic to let the printer determine which type of file it is receiving. This is the default setting; it
works for most software applications. You should not normally need to change it.

e  Select PS (PostScript) only if you are sending a file of that type directly to the printer, without going through
a printer driver.

e  Select PDF only if you are sending a file of that type directly to the printer, without going through a printer
driver.

e  Select HP-GL/2 only if you are sending a file of that type directly to the printer, without going through a
printer driver.

e  Select CALS/G4 only if you are sending a file of that type directly to the printer, without going through a
printer driver.

e  Select TIFF only if you are sending a file of that type directly to the printer, without going through a printer
driver.

e  Select JPEG only if you are sending a file of that type directly to the printer, without going through a printer
driver.

Mobile printing

With HP Mobile Printing Solutions you can print straight from your smartphone or tablet in just a few simple
steps wherever you are; using your mobile device 0S or sending an email to your printer with PDF, TIFF, or JPEG
attachments.

e  AppleiOS printing is enabled through AirPrint, which comes pre-installed in iOS devices.

e  For Android printing, install the HP Print Service App from Google Play. If you have have already installed it,
check that it is up to date. You can obtain the latest version from https://play.google.com/store/apps/
details?id=com.hp.android.printservice.

e  You can also download the HP Smart App to enhance your printing capabilities from a smartphone or
tablet.

—  LatestiOS version from https://itunes.apple.com/app/id469284907

—  Latest Android version from https://play.google.com/store/apps/details?id=com.hp.printercontrol

e To enable email printing, ensure that the service is enabled, and retrieve the printer's email address from
the front panel.

For more detailed information, see http://www.hp.com/go/designjetmobility.

Accessibility

Front panel

If required, the front-panel display brightness and the loudspeaker volume can be changed (see Change system
options on page 12).

Embedded Web Server

From the Embedded Web Server, you can see the status of the printer, and perform other actions without using
the front panel.

For information about the accessibility features of the Embedded Web Server, click Support > Accessibility.
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{3} Home Accessibility
See accessibilty features
Job queue
Accessibility
O Ink ~
© Paper v Refresh rate (seconds): -
E Usage v List of area access keys
Area
& Security ~
Header
@  About printer v
Menu
Network v Sontents
@ support ~ Move through elements

Note: Keyboard shortcuts are supported under Windows and Mac OS
Online support links

Service support

Accessibility

QN  Outof paper: Roll 2

Access key combination
ALT +1
ALT +2
ALT+3

TAB

See http://www.hp.com/hpinfo/abouthp/accessibility/ for information about the HP Accessibility Program, and
HP's commitment to making its products and services accessible to people with disabilities.

Other sources of information

The following documents can be downloaded from http://www.hp.com/ao/T1700/manuals/:
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e Introductory information
e  Userguide
e Legalinformation

e Limited warranty

Other sources of information
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2  Paper handling

e  (General advice

° Load a roll onto the spindle

° Load a roll into the printer

° Unload a roll

° Load a single sheet

° Unload a single sheet

e  Sensitive-paper mode (T1700dr only)

e View information about the paper

° Paper presets

° Printing paper info

° Move the paper

° Maintain paper

e  (Change the drying time

° Turn the automatic cutter on and off

° Feed and cut the paper
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General advice

A CAUTION: Before starting a paper loading process, ensure you have enough room around the printer, both in
front and behind.

A CAUTION:  Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer from
moving.

A CAUTION:  All paper must be 280 mm (11 in) or longer. A4 and letter paper cannot be loaded in landscape
orientation.

% TIP: For photo paper wear cotton gloves to avoid transferring oils onto the paper.

A CAUTION: Keep the basket closed throughout the loading process.

Load a roll onto the spindle

1.  Opentheroll cover.
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2. Remove the black end of the spindle from the printer, then the blue end.

A CAUTION: Be sure to remove the black end first. Removing the blue end first could damage the black end.

A WARNING! Do not insert your fingers into the spindle supports during the removal process.

3. Thespindle has a stop at each end to keep the roll in position. The blue stop can be removed to mount a
new roll; it slides along the spindle to hold rolls of different widths. Remove the blue paper stop from the
end of the spindle.

4. If therollis long; rest the spindle horizontally on a table and load the roll on the table.

¥ TP You may need two people to handle a large roll.
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5. Slide the new roll onto the spindle. Make sure the paper type is oriented as shown (the black stop shows
the correct orientation of the paper). If it is not, remove the roll, turn it 180 degrees and slide it back on to
the spindle. There are labels on the spindle showing the correct orientation.

[% NOTE: Theillustrations show the printer as viewed from the front. However, if you load the paper while
standing behind the printer, the blue stopper is inserted into the right-side holder.

Ensure that the end of the rollis as close to the spindle stop as possible.

6.  Put the blue paper stop on to the open end of the spindle, and push it towards the end of the roll.

i
SN 1%

y N

7. Ensure the blue paper stop is pushed in as far as it goes; until both ends are against the stoppers.

If you are a regular user of different paper types, you can change rolls more quickly if you preload rolls of
different paper types on different spindles. Extra spindles are available for purchase, see Accessories
on page 124.
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Load a roll into the printer

To start this procedure, you must have a roll loaded on the spindle. See Load a roll onto the spindle on page 25.

X TIP: O your printer accepts two rolls, do not try to open both roll covers at once; this may cause problems.
Always close one cover before opening the other.

[%’ NOTE: The first three steps below are optional: you can start with step 4. However, in this case the printer will
not keep track of the length of the roll, and will print no barcode on the roll when it is next unloaded. So you are
recommended to follow all the steps, starting with step 1, unless you have turned off the Printing paper info
option. See Printing paper info on page 35.

1. Onthe front panel, tap @ then the roll icon, then Load.

If the roll you have selected is already loaded, you have to wait while it is automatically unloaded.

You should stand behind the printer when loading the lower roll (roll 2). You may stand behind or in front of
the printer when loading the upper roll (roll 1).

/\ CAUTION:  If your height is less than 1.6 m (5 ft 3 in), loading a roll while standing in front of the printer
may cause back pain or other physical problems.

2. T1700dr only: If you start to load roll T while roll 2 is already loaded, roll 2 is withdrawn to the standby
position, so that it can be printed on again without reloading whenever required.

[%9 NOTE: If at any time you open a roll cover while that roll is in the standby position, the roll is unloaded,
and you will have to reload it the next time you want to print onit.

3. Opentheroll cover, if it is not already open.

4.  Rest the spindle's black end on the right roll holder (as seen from the front of the printer). Do not put the
end completely into the roll holder.

28 Chapter 2 Paper handling ENWW



5. Rest the blue end of the spindle on the left roll holder.

6.  With both hands, push the spindle into both roll holders at the same time.

7. If the edge of the roll is not straight or torn (sometimes due to tape used to hold end of the roll), pull the
paper slightly and cut a straight edge.

8. Insert the edge of the paper into the printer.

A WARNING! Do not push your fingers inside the printer's paper path.

% TIP: When loading the upper roll, avoid inserting roll paper into the cut-sheet slot. If you do so, the printer
beeps and the front panel asks you to remove the paper.
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9. Roll the paper into the printer until you feel resistance and the paper flexes slightly. When the printer
detects the paper, it beeps, then feeds it in automatically.

10. If the leading edge of the paper has a barcode, the printer reads and then cuts off the barcode; you should
remove and discard the cut strip of paper.

11. If the leading edge of the paper has no barcode, the front panel prompts you to select the paper category
and type.

TP if you have loaded a paper type whose name does not appear in the paper list, see Paper type is not
in the driver on page 132.

12. If the Printing paper info option is enabled, the front panel may ask you to specify the length of the roll. See
Printing paper info on page 35.

13. The printer checks the alignment and measures the width, then the front panel prompts you to close the
roll cover.

If the paper is not correctly aligned, the printer automatically proceeds to realign it.

[%9 NOTE: If you have an unexpected issue at any stage of the paper loading process, see Paper cannot be loaded
successfully on page 131.

Unload a roll

Before unloading a roll, check whether there is paper on the roll or if the roll is out of paper, and follow the
appropriate procedure as described below.

Quick procedure with paper on the roll

If there is paper on the roll, just open the roll cover, and the roll is unloaded automatically.
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[ NOTE:  When the roll is unloaded in this way, no barcode is printed on it, so the printer will not know the length
of the roll when it is next loaded. See Printing paper info on page 35.

[%’ NOTE: If you open the cover of any roll while a sheet is loaded, the sheet is also unloaded.

Front panel procedure with paper on the roll

If there is paper on the roll, you can unload it from the front panel.

1. Tap @ then the roll icon, then Unload.

2. Youmay need to open the roll cover.
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Roll out of paper procedure
If the end of the paper is no longer attached to the core, pull out the paper from the printer.

Pull from wherever the paper is accessible; the rear of the printer is recommended. You may need to open the
roll cover.

Load a single sheet

1. Ensure that all roll covers are closed. If any cover is opened while a sheet is loaded, the sheet will be
immediately unloaded.

2. Onthe front panel, tap @ then Sheet > Load.

3. Select your paper category and type.

TP If you have loaded a paper type whose name does not appear in the paper list, see Paper type is not
in the driver on page 132.

4. T1700dr only: If arollis already loaded, you have to wait while it is withdrawn to the standby position; it can
be printed on again without reloading as soon as the sheet paper has been unloaded.

[’_ﬁ”f NOTE: On dual-roll models, if at any time you open a roll cover while that roll is in the standby position,
the roll will be automatically unloaded, and you will have to reload it the next time you want to print on it.

5. When prompted by the front panel, insert the sheet into the cut-sheet slot on the right-hand side of the
printer. The side to be printed is facing us in the illustrations; it will be facing up within the printer.

Load your sheet aligned with the load line and insert until the paper will not continue; with thicker sheets,
you feel resistance.

AWARNING! Do not push your fingers inside the printer's paper path.

6.  Tap the OK key on the front panel to feed the paper into the printer. Guide the sheet into the printer; this is
especially important with thicker papers.

7.  The printer checks the alignment and measures the sheet.
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B NOTE: Depending on the length of the sheet, it feeds out the front of the printer.

8. If the sheetis not correctly aligned, you may be asked to reload it. Follow the instructions on the front-
panel display.

[%,/r NOTE: If you have an unexpected problem at any stage of the paper loading process, see Paper cannot be
loaded successfully on page 131.

Unload a single sheet

To unload a single sheet after printing, you can simply pull the sheet free from the front of the printer.
To unload a sheet without printing, go to the front panel and tap @ then the sheet card, then Unload.

The sheet unloads out of the front of the printer; either catch it manually or allow it to fall into the basket.

Sensitive-paper mode (T1700dr only)

The printer’s sensitive-paper mode is designed to ensure the highest-quality prints on paper particularly
vulnerable to deformations or scratches, such as film. By default, for some categories of vulnerable paper, the
printer will ask whether you want to load it as sensitive paper.

If you want the printer to ask you every time you load a roll, go to the front panel and tap @ then o then

Paper source > Ask how to load.

When loading paper in sensitive-paper mode, the front panel guides you through a step-by-step process. At the
end, you are asked to keep the roll cover open while sensitive-paper mode is active. Apart from that, you can
print as usual.

A CAUTION: Do not put your fingers into the printer's roll-paper input path and gear system.
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[ NOTE: Whileitis active, it is indicated with an icon on the front panel's paper information screen.

Notes

e  Sensitive-paper mode remains active until the roll is unloaded. While it is active, it is indicated with anicon
on the front panel’s paper information screen.

e Whenarollis loaded or treated as sensitive paper, it cannot be parked by the printer. This means that no
other paper will be available for printing as long as sensitive-paper mode is active; thus, in this mode the
printer works like a single-roll printer.

e Ifasecondrollis loaded while sensitive-paper mode is active, the sensitive-paper roll is automatically
unloaded.
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View information about the paper

To view the loaded paper information, tap @ then the roll icon.

The following information is displayed on the front panel:

e  Paper type you have selected

e  Rollor sheet status

e  Width of the paper in millimeters (estimated)

e  Length of the paper in millimeters (estimated)

e  (alibration status

If no paper is loaded, the message Out of paper is displayed.

The same information is displayed in the HP DesignJet Utility for Windows (Overview tab > Supplies tab), the
HP Utility for Mac OS X (Information group: Printer Status > Supplies Status) and the Embedded Web Server
(Paper tab > Paper Source, then click the card for the loaded paper to see the extra details of calibration and
length).

Paper presets

Each supported paper type has its own characteristics. For optimum print quality, the printer changes the way it
prints on each different paper type. For example, some may need more ink and some may require a longer
drying time. So the printer must be given a description of the requirements of each paper type. This description is
called the paper preset. The paper preset contains the ICC profile, which describes the color characteristics of the
paper; it also contains information on other characteristics and requirements of the paper that are not directly
related to color. Existing paper presets for your printer are already installed in the printer's software.

However, as it is inconvenient to scroll through a list of all paper types available, your printer contains paper
presets only for the most commonly used paper types. If you have a paper type for which your printer has no
preset, you cannot select that paper type in the front-panel display.

You can download additional paper presets from the Web and install them: see To install a downloaded paper
preset on page 33.

To install a downloaded paper preset

1. After finding the right paper preset at http://hp.globalbma.com/paperpresets (you can select your
language at the top of the page), or the paper manufacturer's website, click the Download Now button and
save the paper preset (an .oms file) on your computer.

[% NOTE: If you do not find the paper preset you want on the Web, you may find that it has been added to
the latest firmware for your printer. You can check the firmware release notes for information, see Update
the firmware on page 121.

2. Before starting to install the new preset, make sure that the printer is idle and the print queue is stopped.
Installing a new paper preset will interrupt any printing that is in progress.

3. Start the HP DesignJet Utility or the Embedded Web Server.
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e Inthe HP DesignJet Utility for Windows, select the Color Center and then Import Paper Preset.
e Inthe HP Utility for Mac 0S X, select All Settings > Import Paper Preset.

e Inthe Embedded Web Server, click the Paper tab. In the Paper Management section, click the Paper
preset tab.

4.  Onthe Import page, select the paper preset file that you downloaded in step 1.
5. Click the Import button and wait for the update process to finish. It may take some time.

6.  Check that the new paper type appears in the Additional paper or Custom paper category in your printer's
front panel.

7. Synchronize the new paper type with the driver by opening the HP DesignJet Utility. Select your printer,
then Paper Preset Management and Synchronize Paper Presets (¢ button).

Now that you have imported the paper preset, you can select the paper type from the front panel and from the
driver. The ICC profile for the new paper type is ready to use by your application.

To create your own paper preset
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Before using a custom paper type with your printer, you should add a paper preset for the new paper. You can
create a new paper preset using the Color Center in the HP Utility.

The paper preset name will appear in the printer driver and the front panel.
To create a paper preset, you can follow this simple procedure:

1. Goto the Color Center tab in the HP Utility for Windows, or to the Paper Preset Management group in the
HP Utility for Mac 0S.

2. Click Create Paper Preset under Windows, or the + icon under Mac OS X.

3. Select a paper category from the drop-down menu. The paper category determines the amount of ink used
and other basic printing parameters. For more information, see the online help ? in the Color Center. Some
of the common categories are (depending on the model):

e  Bond and Coated Paper: Fiber-based, thin papers with a matte surface. These papers use matte black
ink, no gloss enhancer, relatively low ink limits and high carriage position.

e  Photo Paper: Photo-base, relatively thick papers with a variety of finishing from matte to satin to
glossy. These papers use photo black ink and gloss enhancer, with the exception of Photo Matte
Papers, relatively high ink limits and low carriage position, with the exception of Baryte and Photo
Matte Papers. Generally they will print with the starwheels up.

e  Backlit: Synthetic translucent materials that use photo black and no gloss enhancer with high ink
limits, high carriage position and starwheels up.

4. Enter your paper's name.

% TIP:  The paper's commercial name is likely to be the most understandable for other users of the printer.

5. Select the appropriate settings: drying time, horizontal cutter, and so on.
6.  Click Next or Done under Windows (depending on your printer model), Continue under Mac 0S.
7. You will find the paper name in the Custom paper category in the front panel and HP Utility.

8.  To profile your paper, go to the section "Profile management" of the Color Center in the HP Utility. Choose
the ICC profile name.

Now that you have created the paper preset, you will be able to select the paper type from the front panel and
from the driver under the Custom paper category.
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You can export the new paper preset to your computer and use it on other HP DesignlJet T1700 series printers. In
the Color Center, select Paper Preset Management, select the paper preset, and tap ; at the bottom of the page.
Then follow the instructions on the screen. To install the preset on another printer, see To install a downloaded
paper preset on page 33.

Printing paper info

Enable the Printing paper info option to record the printer’s estimate of the remaining roll length, paper width
and type. The information is a combination of barcode and text that is printed on the leading edge of the roll
when the paper is unloaded from the printer.

@ WIRIIERAERIR AN AN Rne

24 inch wide (610 mm.) Plain Paper

[:?’”r NOTE: The paper-length estimate is available only if the printer registered the amount of paper that was on the
roll when you loaded it. To provide this information to the printer, specify the roll length on the front panel when
loading the paper, or load a roll that has the paper-data barcode printed on it.

[%" NOTE: The barcode and text are printed on the roll only when the loading and unloading processes are started
from the front panel's Paper menu.
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B NOTE:  This option can be expected to work only with papers that are completely opaque: it may fail with
transparent or translucent papers.

To enable the Printing paper info option, go to the front panel and tap @ then Paper source > Printing

paper info > Enable.

[:?’”r NOTE: Enabling this option slightly changes the paper loading and unloading procedures.

Move the paper
If the printer is idle (ready to print), you can move the paper forwards or backwards from the front panel. You

may want to do this in order to have more or less white space between the last print and the next one.

To move the paper, tap @ then Paper source > Move paper.

Tap the up arrow to advance the paper and the down arrow to rewind it.

Maintain paper
To maintain paper qguality, follow the recommendations below.
e  Storerolls covered by another piece of paper or cloth
e  Store cut sheets covered and clean or brush them before loading them in the printer
e  (leaninput and output platens

e  Always keep the window of your printer closed

[% NOTE: Photo and coated paper requires careful handling, see Print is scuffed or scratched on page 144.
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Change the drying time
You may wish to change the drying time setting to suit special printing conditions such as multiple prints where
time is of higher importance or when you need to be sure ink is dry before handling.

Tap @ then Default printing configuration > Print retrieval > Drying time. You can select:

e  Extended, to set a longer than recommended time to ensure ink is completely dry
e  Optimal, to set the default and recommended time for your selected paper (this is the default setting)
e  Reduced, to set a shorter than recommended time when guality is of lower importance

e None, to disable the drying time and remove your print as soon as it finishes printing

A CAUTION:  If the ink is not dry when the print is removed it could leave ink in the output tray and marks on the
print.

[%’/]" NOTE: If you cancel the drying time during a print, the printer may not feed and cut the paper right away due to
the printhead maintenance, which runs in parallel. If the dry time is zero, the printer cuts the paper and then
performs the printhead maintenance. However, if the dry time is greater than zero, the printer does not cut the
paper until after the printhead maintenance has completed.

Turn the automatic cutter on and off

To turn the printer's paper cutter on or off, go to the front panel and tap @ then Default printing
configuration > Cutter > Horizontal cutter, and change the cutter option.

The default setting is On.

r.%’ NOTE: If the cutter is turned off, it will not cut the paper between jobs, but it will continue to cut the paper on
loading, unloading and switching between rolls.

{'} TIP:  To cut roll paper while the automatic cutter is disabled, see Feed and cut the paper on page 36.

Feed and cut the paper

There are two ways to feed and cut the paper from the front panel:
e Tap @ then Paper source, then tap the cutter icon at the top of the page.

e Inthe Status Center, tap the cutter icon.

The printer then advances the paper and makes a straight cut across the front edge. There are several possible
reasons why you might want to do this:

e  Totrim the leading edge of the paper if it is damaged or not straight.
e Tofeed and cut the paper when the automatic cutter has been disabled.

e  To cancel the waiting time and print the available pages immediately, if the printer is waiting to nest more
pages.

[%,/r NOTE: The printheads are serviced after each print, and the paper cannot be cut until the process completes, so
you may notice a delay.

36 Chapter 2 Paper handling ENWW



/\ CAUTION:  Remove the cut piece from the output tray. If strips or short prints are left in the output tray the
printer could jam.

Ej?y NOTE: Photo and coated paper requires careful handling, see Print is scuffed or scratched on page 144.

{} TIP:  To move the paper without cutting it, see Move the paper on page 35.
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3 Working with two rolls (T1700dr only)

° Advantages of a multiroll printer

° How the printer allocates jobs to paper rolls
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Advantages of a multiroll printer

A multiroll printer can be useful in several different ways:
e  The printer can automatically switch between different paper types according to your needs.

e  The printer can automatically switch between different paper widths according to your needs. This enables
you to save paper by printing smaller images on narrower paper.

e Ifyou load two identical rolls into the printer, you can leave it printing unattended for a long time, because it
can switch from one roll to the other automatically when the first is exhausted. See Unattended printing/
overnight printing on page 62.

The current status of both rolls is shown on the front panel if you tap @

[Z?’”r NOTE: Bear in mind that a paper type is protected from use unless that paper type is specifically requested. See
Protect a paper type on page 62.

[%“f NOTE: If you use a paper not supported by your printer, you may find that automatic switching is disabled, in
which case jobs sent to the standby roll are put on hold until the roll is manually unloaded.
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[ NOTE:  When you print from a USB flash drive, multiroll printing is considerably simplified: either you specify
manually which roll you want to use, or you can select Save paper, in which case the printer chooses the
narrowest roll on which the print will fit. You cannot specify the paper type.

How the printer allocates jobs to paper rolls

ENWW

When you submit a print job from the printer driver, you can specify (using the Paper type or Type is option) that
you want it to be printed on a particular paper type; you can even specify (using the Paper source, Source is or
Paper Feed option) that you want it to be printed on a particular roll (1 or 2). The printer will try to satisfy these
requirements, and it will also look for a paper roll large enough to print the image without clipping.

e Ifbothrolls are suitable for the job, the roll will be chosen according to the roll switching policy. See Roll
policies on page 70.

e Ifjust one of the rolls is suitable for the job, it will be printed on that roll.

e If neither rollis suitable for the job, it will be put on hold for paper, or printed on an unsuitable roll,
depending on the paper mismatch action. See Solve paper mismatch on page 71.

The printer driver for Windows will tell you which paper types and widths are currently loaded in the printer, and
on which rolls.

Here are some settings that may be used in typical situations.

[Z?’”r NOTE: The Paper settings are in the printer driver; the Roll switching policy is set in the front panel.

e  With different paper types loaded:
—  Paper types: select the paper type you require
—  Paper source: Use printer settings
—  Roll switching policy: doesn't matter

e  With different paper widths loaded:
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- Paper type: Use printer settings
—  Paper source: Use printer settings

—  Roll switching policy: Minimize paper waste

¥ TIP: You can also save paper in some cases by rotating or nesting your images. See Use paper
economically on page 59.

e Withidentical rolls loaded:
—  Paper type: Use printer settings
—  Paper source: Use printer settings

—  Roll switching policy: Minimize roll changes
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Networking

° Introduction

° Control network protocols

° Front-panel menu items

e Link configuration methods

e  Troubleshooting
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Introduction

The printer provides a single RJ-45 connector port for a network connection. In order to meet Class B limits, the
use of shielded I/0 cables is required.

The embedded Jetdirect print server supports connection to IEEE 802.3 10Base-T Ethernet, IEEE 802.3u
100Base-TX Fast Ethernet and 802.3ab 1000Base-T Gigabit Ethernet compliant networks. When connected and
powered on, the printer auto-negotiates with your network to operate with a link speed of 10, 100, or 1000
Mbps, and to communicate using full- or half-duplex mode. However, you can manually configure the link using
the printer's front panel, or through other configuration tools once network communication is established.

The printer can support multiple network protocols simultaneously, including TCP/IPv4 and TCP/IPv6. For
security, it includes features to control IP traffic to and from the printer and supports configuration of IP Security
(IPsec) protocols.

Control network protocols

The printer can simultaneously support multiple network communication protocols. This allows network
computers that may be using different protocols to communicate with the same printer.

Each protocol may require some configuration before the printer can communicate on the network. For some
protocols, required parameters are automatically sensed and user-specified settings are not needed. However,
for other protocols, there may be many parameters to configure.

Enable or disable network protocols

If a network protocol is enabled, the printer may actively transmit on the network even when there are no
computers on the network that use the protocol. This may increase network traffic. To eliminate unnecessary
traffic, you can disable unused protocols. Disabling unused protocols lets you:

e  Reduce network traffic by eliminating broadcast messages from unused protocols

e  Provide better control over who prints to the printer by eliminating users from other networks who might
route print jobs to this printer

e  Display protocol-specific error conditions for enabled protocols only

To disable unused protocols through the device’s control panel menu, see Front-panel menu items on page 42.
For other tools, such as system command access to the embedded Telnet server, see the HP Jetdirect Print Server
Administrator’s Guide for your print server model.

Front-panel menu items

To access the printer network configuration settings, go to the front panel and tap , then o then

Network > Gigabit Ethernet > Modify Configuration.

Menu item Sub-menuitem  Sub-menuitem  Values and description

Information Print Sec Report Yes: Prints a report.

No (default): Does not print a report.

TCP/IP Host Name An alphanumeric string, up to 32 characters, used to identify the device. This name is listed on
the HP Jetdirect configuration page. The default host name is NPIxxxxxx, where xxxxxx is the
last six digits of the LAN hardware (MAC) address.
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Menu item Sub-menuitem  Sub-menu item

Values and description

IPV4 Settings Config Method

Specifies the method that TCP/IPv4 parameters will be configured on the HP Jetdirect print
server.

Bootp: Use BootP (Bootstrap Protocol) for automatic configuration from a BootP server.
DHCP (default): Use DHCP (Dynamic Host Configuration Protocol) for automatic configuration
from a DHCPv4 server. If selected and a DHCP lease exists, DHCP Release and DHCP Renew

menus are available to set DHCP lease options.

Auto IP: Use automatic link-local IPv4 addressing. An address in the form 169.254.x.x is
assigned automatically.

Manual: Use the Manual Settings menu to configure TCP/IPv4 parameters.

DHCP Release

This menu appears if Config Method was set to DHCP and a DHCP lease for the print server
exists.

No (default): The current DHCP lease is saved.

VYes: The current DHCP lease and the leased IP address are released.

DHCP Renew

This menu appears if Config Method was set to DHCP and a DHCP lease for the print server
exists.

No (default): The print server does not request to renew the DHCP lease.

Yes: The print server requests to renew the current DHCP lease.

Manual Settings

(Available only if Config Method is set to Manual) Configure parameters directly from the
printer control panel:

IP Address: The unique IP address of the printer (n.n.n.n).
Subnet Mask: The subnet mask for the printer (n.n.n.n).

Syslog Server: The IP address of the syslog server (n.n.n.n) used to receive and log syslog
messages.

Default Gateway: The IP address (n.n.n.n) of the gateway or router used for communications
with other networks.

|dle Timeout: The time period, in seconds, after which an idle TCP print data connection is
closed (default is 270 seconds, O disables the timeout).

Default IP

Specify the IP address to default to when the print server is unable to obtain an IP address
from the network during a forced TCP/IP reconfiguration (for example, when manually
configured to use BootP or DHCP).

Auto IP: A link-local IP address 169.254.x.x is set.

[Legacy: The address 192.0.0.192 is set, consistent with older HP Jetdirect devices.

Primary DNS

Specify the IP address (n.n.n.n) of a Primary DNS Server.

NOTE:  This item appears only if Manual configuration is a higher priority than DHCP in the
Config. Precedence table, configured through the embedded Web server.

Secondary DNS

Specify the IP address (n.n.n.n) of a Secondary Domain Name System (DNS) Server.

NOTE:  This item will appear only if Manual configuration is a higher priority than DHCP in the
Config. Precedence table, configured through the embedded Web server.

IPV6 Settings Enable

Use this item to enable or disable IPv6 operation on the print server.
Off: IPv6 is disabled.

On (default): IPv6 is enabled.
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Menu item Sub-menuitem  Sub-menuitem  Values and description

Address Use this item to manually configure an IPv6 address.

Manual Settings: Use the Manual Settings menu to enable and manually configure a TCP/ IPv6
address.

Enable: Select this item and choose On to enable manual configuration, or Off to disable
manual configuration.

Address: Use this item to type a 32 hexadecimal digit IPv6 node address that uses the colon
hexadecimal syntax.

DHCPV6 Policy Router Specified: The stateful auto-configuration method to be used by the print server is
determined by a router. The router specifies whether the print server obtains its address, its
configuration information, or both from a DHCPv6 server.

Router Unavailable: If a router is not available, the print server should attempt to obtain its
stateful configuration from a DHCPv6 server.
Always: Whether or not a router is available, the print server always attempts to obtain its
stateful configuration from a DHCPv6 server.

Primary DNS Use this item to specify an IPv6 address for a primary DNS server that the print server should
use.

NOTE:  This item will appear only if Manual configuration is a higher priority than DHCP in the
Config Precedence table, configured through the embedded Web server.

Secondary DNS  Use this item to specify an IPv6 address for a secondary DNS server that the print server
should use.

NOTE:  This item will appear only if Manual configuration is a higher priority than DHCP in the
Config Precedence table, configured through the embedded Web server.

Proxy Server Specifies the proxy server to be used by embedded applications in the device. A proxy server is
typically used by network clients for Internet access. It caches Web pages, and provides a
degree of Internet security, for those clients.

To specify a proxy server, enter its IPv4 address or fully-qualified domain name. The name can
be up to 255 octets.

For some networks, you may need to contact your Independent Service Provider (ISP) for the
proxy server address.

Proxy Port Type the port number used by the proxy server for client support. The port number identifies
the port reserved for proxy activity on your network, and can be a value from 0 to 65535.

Security Print Sec Page Yes: Prints a page that contains the current IPsec security settings on the HP Jetdirect print

server.

No (default): A security settings page is not printed.

Secure Web

For configuration management, specify whether the embedded Web server will accept
communications using HTTPS (Secure HTTP) only, or both HTTP and HTTPS.

HTTPS Required: For secure, encrypted communications, only HTTPS access is accepted. The
print server will appear as a secure site.

HTTP/HTTPS optional: Access using either HTTP or HTTPS is permitted.

NOTE: The factory default setting depends on the print server model.

IPSEC

Specify the IPsec or Firewall status on the print server.
Keep: IPsec/Firewall status remains the same as currently configured.

Disable: IPsec/Firewall operation on the print server is disabled.

802.1x

Enable Wipe
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Menu item

Sub-menu item

Sub-menu item

Values and description

Reset Security

Specify whether the current security settings on the print server will be saved or reset to
factory defaults.

No (default): The current security settings are maintained.

VYes: Security settings are reset to factory defaults.

Link Speed

The link speed and communication mode of the print server must match the network. The
available settings depend on the device and installed print server. Select one of the following
link configuration settings:

CAUTION:  If you change the link setting, network communications with the print server and
network device might be lost.

Auto (default): The print server uses auto-negotiation to configure itself with the highest link
speed and communication mode allowed. If auto-negotiation fails, either T00TX HALF or 10TX
HALF is set depending on the detected link speed of the hub/switch port. (A T000T half-duplex
selection is not supported.)

10T Half: 10 Mbps, half-duplex operation.

10T Full: 10 Mbps, Full-duplex operation.

T00TX Half: 700 Mbps, half-duplex operation.

T00TX Full: T00 Mbps, full-duplex operation.

100TX Auto: Limits auto-negatiation to a maximum link speed of 100 Mbps.

T000TX Full: 1000 Mbps, full-duplex operation.

Link configuration methods

The printer supports 10, 100, or T000 Mbps network link speeds using full-duplex or half-duplex communication
modes (a T000T half-duplex selection is not supported). By default, it will attempt to auto-negotiate its link
operation with the network.

ENWW

When connecting to network hubs and switches that do not support auto-negotiation, the printer will configure
itself for 10 Mbps or 100 Mbps half-duplex operation. For example, when connected to a non-negotiating 10
Mbps hub, the print server will automatically set itself to operate at 10 Mbps half-duplex.

If the printer is not able to connect to the network through auto-negotiation, you can set the link setting by one
of the following methods:

The front panel

The Embedded Web Server

The Telnet interface, through a system command prompt

A TFTP (Trivial File Transfer Protocol) configuration file that is downloaded, for example, from a BootP or

DHCP server

Network management tools such as HP Web Jetadmin

Link configuration methods
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Troubleshooting

|0 Configuration card

The 10 Configuration card provides comprehensive print server status. The information provided is an important
diagnostic tool, especially if network communication is not available. For a description of messages that may
appear on the card, see the HP Jetdirect Print Servers Administrator’s Guide for your print server model.

For detailed connectivity information, go to the Connectivity menu and click Network card or Services card to see
all the information available.

The network card provides details about the network configuration and status. The services card provides
information about the state of connections to HP services, such as HP ePrint.

To verify correct operation:

1. Onthe network card, look for the status message 1/0 Card Ready.

2. If1/0 Card Ready appears, the print server is operating properly. Proceed to the next section.
If a message other than I/0 Card Ready appears, try the following:
a.  Turnthe printer off and then on again to re-initialize the print server.
b.  Check that the status indicator lights (LEDs) are providing proper status.

See the HP Jetdirect Print Servers Administrator’s Guide for your print server model to interpret and troubleshoot
other messages.

Reset network parameters

If you accidentally misconfigured the printer's network settings, they can be reset to factory default values by

tapping O then o then Network > Restore connectivity factory settings.

A CAUTION: A factory-installed HP Jetdirect X.509 certificate will be saved during reset to factory default values.
However, a Certificate Authority (CA) certificate that has been installed by the user to validate a network
authentication server will not be saved.

Link troubleshooting

The printer has status lights (LEDs) beside the network connector that indicate the link status and network
activity.

e  When the green light is on, the printer has successfully linked to the network.
e  When the yellow light is blinking, there is network transmission activity.

If the printer does not successfully connect to the network:

e  Both LEDs will be off.

e  The alert No network cable connected will appear on the front panel.

If a link failure is indicated, try the following:

1. Check the cable connections at both ends.

2. Consider replacing the cables by known good ones.
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6.

Consider switching to another network connector in the network switch, hub, or device to which the printer
is connected.

Manually configure the link setting to match the port configuration of the network hub or switch. For
manual configuration methods, see Link configuration methods on page 45. Turn the printer off, then on
again, to re-initialize the setting.

Print a Connectivity Configuration page and check link settings.

Item Description

Port Config If the printer is properly linked, this item has one of the following values:
. TOBASE-T HALF: 10 Mbps, half-duplex
. TOBASE-T FULL: 10 Mbps, full-duplex
. 100TX-HALF: 100 Mbps, half-duplex
. 100TX-FULL: 100 Mbps, full-duplex
e  1000TX FULL
If the printer is not properly linked, one of the following messages will appear:
o  UNKNOWN: The printer is in an initialization state.

e  DISCONNECTED: A network connection has not been detected. Check network cables. Reconfigure the
link settings, or restart the printer.

Auto Negotiation Indicates whether auto-negotiation for link configuration is on or off.

e  ON (default): The printer will attempt to automatically configure itself onto the network at the proper
speed and communication mode.

e  OFF: You must manually configure the link speed and communication mode using the front panel. Your
settings must match those of the network for proper operation.

In case of doubt or misconfiguration of link settings, reset the network parameters to their factory settings.
See Reset network parameters on page 46.

Communication failures between computer and printer

ENWW

Some symptoms are:

The front-panel display does not show the Received jobs message when you have sent jobs to the printer.
Your computer displays an error message when you are trying to print.

Your computer or printer hangs (stays idle), while communication is taking place.

Print jobs get stuck in your computer’s print spooler.

Your printed output shows random or inexplicable errors (misplaced lines, partial graphics, and so on).

To solve a communication problem:

Ensure that you have selected the correct printer when sending your job.
Ensure that the printer works correctly when printing from other applications.

If your printer is connected to your computer through any other intermediate devices, such as switch boxes,
buffer boxes, cable adapters, or cable converters, try using it when connected directly to your computer.

Try another network cable.

Troubleshooting

47



Remember that very large prints may take some time to receive, process and print.

If your printer displays warning or error messages that require action, take the required action before trying
to print.

Cannot access the Embedded Web Server

1.
2.

6.

If you have not done so already, read Embedded Web Server on page 14.

Make sure that Embdedded Web Server functionality is enabled in the printer: from the front panel, tap

@, then Security > Connectivity > Embedded Web Server (EWS) > On.

Check the proxy configuration in your Web browser in case it is preventing communication with the printer.
Ensure that the printer works correctly when printing or accessed from other applications.

If the printer displays warning or error messages that require further action, take the action to resolve the
problems.

If all else fails, turn the printer off and on again with the power key on the front panel.

Cannot access the printer from the HP Utility

1.
2.

If you have not done so already, read HP Utility on page 13.

Ensure that your printer is not in sleep mode.

Ensure that your printer driver is available and working correctly for the HP DesignJet Utility in Windows.

From the front panel, tap @ then Security > Web services > Printing & management, and make sure

that it is enabled. If it is disabled, some parts of the HP Utility may not work properly.

Print jobs take too much time to be received by the printer

If you send a very large print to the printer, there will normally be some delay before it starts printing. However, if
you think you are experiencing abnormally long delays, there are various things you could check:

Make sure the network cable connected to the printer is rated at least Cat5e.

Make sure that gigabit-speed networking equipment and cabling interconnects your computer client to the
printer.

Make sure that there are no network link issues. See Link troubleshooting on page 46.

Take into account that, in network deployments with IPSec security protocols enabled and configured in the
printer, network performance may be reduced due to the use of cryptographic algorithms to protect
network communications.

Try resetting the network configuration to its factory settings in order to get default settings that are
suitable for most standard network environments. See Reset network parameters on page 46.

You may also find it helpful to test connecting the computer to the printer directly, using a normal Ethernet
(Cat5e or Cat6) cable point-to-point, without passing through an Ethernet switch or router. In this
configuration, the printer and the computer should both automatically change their IPv4 addresses to the
form 169.254.x.x . In this point-to-point configuration you can discard any issues caused by other network
equipment.
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Printing

° Introduction

° Print from a USB flash drive

° Print from a computer using a printer driver

e  Advanced print settings
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Introduction

There are various different ways in which you can choose to print, depending on your circumstances and
preferences:

° Print a TIFF, JPEG, HP-GL/2, RTL, PDF, or PostScript file directly from a USB flash drive. See Print from a USB
flash drive on page 50.

e  Printa TIFF, JPEG, HP-GL/2, or PDF file directly from a computer connected to the printer, using HP Click.
See http://www.hp.com/go/DesignJetclick.

e  Print any kind of file from a computer connected to the printer, using a software application that can open
the file, and a printer driver supplied with your printer. See Print from a computer using a printer driver

on page 51.

e  Print from a smartphone or tablet. See Mobile printing on page 64.

Print from a USB flash drive

1. Insert a USB flash drive containing one or more TIFF, JPEG, HP-GL/2, RTL, PDF, or PostScript files into the
printer's USB port.

Y NOTE:  To print PDF or PostScript file, you must have a PostScript printer.

[%’/r NOTE: The use of USB flash drives with your printer may be disabled by the administrator.

2. Atthe front panel, go to the home page and tap

You can tap folders to browse their contents. Files are shown as document thumbnails, and you can
preview a file by tapping the preview icon. When the preview is displayed, you can zoom in and out. Files

that cannot be printed are indicated with| &) | For more details, press the information button.

3. Select afile to be printed. Multipage documents are supported only in PDF files; in this case, you can also
select a page to print.

4.  The list of print-from-USB quicksets is displayed. You can choose and/or edit one of the quicksets for the
selected job.

[% NOTE: If you edit a quickset after selecting a job, the changed settings are applied only to the current job
and are not saved permanently. You can change any of your own quicksets permanently by tapping o on

the quicksets page, or by tapping @ , then Quicksets.

[ NOTE: The factory quicksets cannot be modified.
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The following settings are available:
e  Quickset name allows you to name the quickset you are working with.

e  QOutput scale allows you to resize the print in two different ways: to a percentage of its original size, or
to fit a particular paper size. The default is 100% (its original size).

e  Print quality allows you to set the print quality to Fast, Normal, or Best.
e  C(olor options allows you to choose color or grayscale.

e  Paper source allows you to specify printing on roll 1 or roll 2, or you can choose Save paper, which
automatically chooses the narrowest roll on which the print will fit (if two rolls are loaded).

e  Paper category allows you to choose the type of paper.
e  Page order allows you to choose first page on top, or last page on top.
e  (ollate allows you to turn collation on or off.

e  Rotation allows you to rotate the print by any multiple of 90°, or you can choose Automatic, which
rotates the print automatically if that will save paper.

e  Alignment allows you to align the printer to the left, center, or right of the roll.
e  Printer margins allows you to change the default printer margins.

e  Storage mode offers two options, print and delete (the job is not retained in the job queue) and print
and store (the job is retained in the job queue).

5. When you are satisfied with the quickset settings, tap OK to continue.

6. A page with the following settings appears: Copies, Page order, and Collate. You can check and change
them in this step, regardless of the settings in the quickset. Tap Print to continue.

7.  After printing, you can choose to print another file or go to the job queue. If you print another file
immediately without returning to the home page, the temporary settings used for the previous file are
used again.

Print from a computer using a printer driver

This is the traditional way of printing from a computer. The correct printer driver must be installed on the
computer (see Install your printer under Windows on page 16 or Install your printer under Mac OS X on page 16),
and the computer must be connected to the printer.

When the printer driver has been installed and the computer is connected to the printer, you can print from a
software application by using the application's own Print command and selecting the correct printer.

Advanced print settings

The rest of this chapter explains the various print settings that you can use when printing with a printer driver or
the front panel. These methods offer a relatively large number of settings in order to satisfy all requirements.

¥ TP In general you are recommended to use the default settings unless you know that they do not meet your
requirements.

TIP:  If you intend to reuse a particular group of settings repeatedly, you can save those settings under a name
of your own choice and recall them later. A saved group of settings is known as a 'quick set' in the Windows
printer driver, and as a 'preset’ in the Mac OS printer driver.
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Select print quality

The printer has various print-quality options because best-quality printing requires some loss of speed, while
fast printing implies some reduction in print quality.

Therefore, the standard print-quality selector is a slider that allows you to choose between quality and speed.
With some paper types, you can choose a compromise position between the two.

Alternatively, you can select from the custom options: Best, Normal and Fast. If you select Fast, you can also
select Economode, which uses a lower rendering resolution and consumes less ink. It therefore increases printing
speed even further, but reduces print quality. Economode can be selected only from the custom options (not
from the slider).

There is also a supplementary custom option that may have an effect on print quality: Maximum detail. See
High-guality printing on page 58.

[%f NOTE: Inthe Windows driver dialog, the rendering resolution for your job is displayed in the Custom Print
Quality Options dialog box (click Custom options > Settings).

You can select print-quality options in the following ways:

e  Inthe Windows driver dialog: Go to the Paper/Quality or Paper tab (depending on the driver version) and
look at the Print Quality section. If you use Standard Options, you will see a simple slider with which you can
select speed or guality. If you use Custom Options or Advanced(depending on the driver version), you will
see the more specific options described above.

L]

|

Paper/Qualty |Layout/Output Color  Job Storage  Services Advanced
i

Quick sets:

Factory defauilts v Save Delete

|
| Paper Options
Document size:

A4 ~ Custom...
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cutt | Quaity level:

‘ Fast hd
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[]EconoMode Print Quality
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Pap
[ OK Cancel

Paper type:

|©Custnm options Settings...

‘ Use printer setings V‘ Rendering resolution (pp): 500

Printing resolution (dpi): Automatic

0K Cancel
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e Inthe Mac OS X Print driver dialog: Go to the Paper/Quality panel and look at the Quality Options section. If
you select Standard quality options, you will see a simple slider with which you can select speed or gquality.
If you select Custom guality options, you will see the more specific options described above.

Print

Printer: @ HP DesignJet T1700dr a
Presets: = Default Settings E
Copies: |1
Paper Size: A1 E 23,38 by 33,11 inches
Paper/Quality E
Paper Source: | Roll 2 E (i ]
Paper Type: Any E
Roll 1: Unknown
Roll 2: Unknown
Single Sheet: Unknown
Quality Options: | Standard E
Speed Quality
» Constraints & Device Status {0)
7, poF [ | Hide Details cancel | [ESCHN

e  Using the front panel: Tap @ then Default printing configuration > Print quality.

r_ﬁ”f NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front
panel.

[:?’”f} NOTE: You cannot change the print quality of pages that the printer is already receiving or has already received
(even if they have not started to print yet).

Select paper size

The paper size can be specified in the following ways.

[% NOTE: The paper size specified here should be the paper size in which the document was created. It is possible
to rescale the document to a different size for printing. See Rescale a print on page 56.

e Inthe Windows driver dialog: Select the Paper/Quality or Paper tab (depending on the driver version), then
select your paper size from the Document Size list.

In the Mac 0S X Printer Setup dialog: Select your printer from the Print settings list, then select your paper
size from the Paper Size list.

[% NOTE: If you are printing with the V4 driver and from Adobe Acrobat, the page size and orientation are
determined by the application.

[% NOTE: If your application offers no Page Setup dialog, use the Print dialog.

Using the front panel: tap @ then Default printing configuration > Paper options > Paper size.

[’_5/]" NOTE: If the paper size is set from your computer, it overrides the paper size setting in the front panel.

Custom paper sizes

If you want to choose a paper size that is not included in the list of standard paper sizes, there are various
different ways to specify it.
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Use the Windows printer driver (version 3)

1.
2.
3.
4.

Click the Paper/Quality tab.
Click Custom.
Enter the name and dimensions of your new paper size.

Click OK. The new paper size is automatically selected.

Use the Windows printer driver (version 4)

1.
2.
3.
4.

Click the Paper tab.
Click Document size.
Enter the dimensions of your new paper size into the two fields in the custom area.

Click the arrow button.

A custom paper size created with the printer driver has the following characteristics:

The paper size is permanent. It will not disappear if the driver is closed or the computer is turned off.

The paper size is local to the printer queue. It will not be seen from other printer queues in the same
computer.

In Domain server networks, the paper size is local to the computer. It will not be seen from other
computers sharing the printer queue.

In Workgroup netwaorks, the paper size will be shared among all the computers sharing the printer queue.

If the printer queue is deleted, the paper size is deleted with it.

Use Windows forms

1.
2.

7.
8.

From the Start menu, or from the Control Panel, select Printers and Faxes.

From the File menu, select Server Properties.

In the Forms tab, check the Create a new form box.

Enter the name and dimensions of your new paper size. Leave the margins as 0.00.

Click the Save Form button.

Go to the printer driver, and select the Paper/Quality or Paper tab (depending on the driver version).
Select More... from the drop-down list of paper sizes.

Select your new paper size from the group of Custom sizes.

A custom paper size created with Windows forms has the following characteristics:

Chapter 5 Printing

The paper size is permanent. It will not disappear if the driver is closed or the computer is turned off.

Restricted users cannot create paper forms. The “manage documents” role in the Windows Active Directory
is the minimum required.

The paper size is local to the computer. It will be seen in all the printer queues that have been created on
the computer and that support paper of that size.

If a printer queue is shared, this paper size will appear in all the client computers.
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e Ifaprinter queue is shared from another computer, this paper size will not appear on the driver s
document size list. A Windows form in a shared queue needs to be created in the server.

e |If the printer queue is deleted, the paper size is not deleted.

Use the Mac 0OS X printer driver
1.  Go to the Page Setup dialog.

[%”f’ NOTE: If your application offers no Page Setup dialog, use the Print dialog.

2. Select Paper Size > Manage Custom Sizes.

Select margin options

By default, the printer leaves a 3 mm margin between the edges of your image and the edges of the paper
(increased to 17 mm at the foot of cut-sheet paper). However, you can change this behavior in several ways.

Choose between 3 and 5 mm margins

e Inthe Windows V3 driver dialog: Select the Advanced tab, then click Advanced features > Document options
> Printer features > Margin, and select the margin size.

e Inthe Windows V4 driver dialog: Select the Layout tab and select your margins from the With Margins list.

e Inthe Mac OS X Print dialog: Select the Paper size. The following variations are available for each paper
size:

—  The default version has 3 mm margins.
—  The “extended margins” version has 5 mm margins.
—  The “on sheet paper” version has 3 mm margins, except for the bottom margin, which is 17 mm.

—  The “on sheet paper extended margins” version has 5 mm margins, except for the bottom margin,
whichis 17 mm.

—  The “no margins” version has zero margins.

e  Using the front panel: Tap @ then Printing preferences > Margins.

Choose margin layout options

e Inthe Windows V3 driver dialog: Select the Paper/Quality tab, and click the Margins/Cutter Settings button.
The Layout and Margins window is displayed.

e Inthe Windows V4 driver dialog: Select the Layout tab and go to the Layout Mode area.

e Inthe Mac OS X Print dialog: Select the Margins/Layout panel.
e  Using the front panel: Tap @ then Default printing configuration > Margins layout.

You will then see at least some of the following options.
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e  Use application settings (drivers)/Use standard (front panel). Your image will be printed on a page of the
size you have selected, with a narrow margin between the edges of the image and the edges of the paper.
The image should be small enough to fit between the margins.

e  Oversize. Your image will be printed on a page slightly larger than the size you have selected. If you cut off
the margins, you will be left with a page of the size you selected, with no margins remaining between your
image and the edges of the paper.

e  (lip contents by margins. Your image will be printed on a page of the size you have selected, with a narrow
margin between the edges of the image and the edges of the paper. In this case, if the image is the same
size as the page, the printer assumes that the extreme edges of the image are either white or unimportant,
and do not need to be printed. This may be useful when your image already contains a border.

[%”f NOTE: Under Mac 0S X, the Qversize and Clip contents by margins options are available only when you have
selected a “no margins” paper size.

Print on loaded paper

To print a job on whichever paper is loaded in the printer, choose the following Paper Type option in your printer
driver:

e Inthe Windows driver dialog: Select the Paper/Quality or Paper tab (depending on the driver version), then
select Use Printer Settings in the Paper Type drop-down list.

e  Inthe Mac 0S X Print dialog: Select the Paper/Quality panel, then select Any in the Paper Type drop-down
list.

E¥ NOTE:  Use Printer Settings (Windows) or Any (Mac 0S X) is the default Paper Type selection.

Rescale a print

You can send an image to the printer at a certain size but tell the printer to rescale it to a different size (normally
larger). This may be useful:

e  Ifyour software does not support large formats

e Ifyourfileis too large for the printer's memory—in this case, you can reduce the paper size in your
software and then scale it up again using the front-panel option

You can rescale an image in the following ways:

e Inthe Windows driver dialog: Go to the Layout Qutput or Layout tab (depending on the driver version) and
look at the Resizing Options section.

—  The Actual size option leaves the size of the image unchanged.

—  The Fit to option adjusts the image size to the paper size you have selected. For example, if you have
selected ISO A2 as the paper size and you print an A3-sized image, it is enlarged to fit the A2 paper. If
the ISO A4 paper size is selected, the printer reduces a larger image to fit the A4 size.

—  The % of actual size or Scale % option (depending on the driver version) enlarges the printable area of
the original paper size (the page minus the margins) by the percentage indicated, then adds the
margins to create the output paper size.
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e Inthe Mac 0S X Print dialog: Click Paper handling, check the box Scale to fit paper size, and select the paper
size to which you want to scale the image. For example, if you have selected ISO A2 as the paper size and

you print an A3-sized image, it is enlarged to fit the A2 paper. If the ISO A4 paper size is selected, the printer
reduces a larger image to fit the A4 size.

Print

Printer: @ HP DesignJet T1700dr a
Presets: Default Settings a
Copies: |1
Paper Size: AZ E 16,54 by 23,38 inches
Paper Handling a
Collate pages
Pages to Print:  All pages E
Page Order:  Automatic E
Scale to fit paper size
Destination Paper Size: Suggested Paper: A2 E
?) | PDF a Hide Details Cancel | [EEEVCIN

e  Using the front panel: Tap @ then Default printing configuration > Paper options > Resize.

If you are printing to a single sheet, you must ensure that the image can actually fit onto the sheet, otherwise the
image will be clipped.

Change the treatment of overlapping lines

B’ NOTE:  This topic applies only when printing an HP-GL/2 job.

The merge option controls the overlapping lines in an image. There are two settings:
e  Off: Where the lines cross, only the color of the top line is printed. This is the default setting.

e On: Where the lines cross, the colors of the two lines merge.

To turn merge on, go to the front panel and tap @ then Default printing configuration > HP-GL/2 options >

Merge. You can set the merge option from your software in some applications. Settings in your software override
the front-panel settings.

Preview a print

Previewing a print on the screen allows you to check the layout of the print before printing, which may help you
to avoid wasting paper and ink on a bad print.

e  Topreview a print under Windows, you have the following options:

—  Use the HP Print Preview application:

Check the Show preview before printing box, which you can find in the right bottom corner of the
driver dialog. Click Print, then wait a few seconds for the HP Print Preview application to be launched.

Check that the preview of the job is what you wanted. If so, click Print, otherwise click Cancel; you can
readjust the driver settings before trying again.
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Print a draft

r_ﬁf NOTE: The Show preview before printing box appears in the driver dialog only if HP Print Preview is
installed in your computer. See HP Print Preview on page 14.

—  Use your application's print preview option.
To preview a print under Mac OS X, you have the following options:
—  Use your application’s print preview option.

—  Thereis no Preview button at the bottom of the Print dialog box in the latest versions of Mac 0S X. A
print preview is always shown at the upper left of the Print dialog box for most applications.

—  Choose the HP Print Preview option from the PDF menu at the bottom of the Print dialog box. The
print preview is displayed by a separate HP Print Preview application.

You can specify fast draft-quality printing in the following ways:

In the Windows driver dialog: Go to the Paper/Quality or Paper tab (depending on the driver version) and
look at the Print Quality section. Move the print-quality slider to the extreme left ('Speed’).

In the Mac 0S X Print dialog: Go to the Paper/Quality panel, click Standard in the quality options, and move
the print-quality slider to the extreme left (‘Speed').

Using the front panel: Tap @ then Default printing configuration > Print quality > Select quality level >

Fast.

You can specify even faster draft-quality printing by using Economode, as follows. This is intended mainly for
documents containing only text and line drawings.

In the Windows driver dialog: Go to the Paper/Quality or Paper tab (depending on the driver version) and
look at the Print Quality section. Select Custom Options or Advanced (depending on the driver version), then
set the quality level to Fast and check the Economode box.

In the Mac 0S X Print dialog: Go to the Paper/Quality panel and set the quality options to Custom, then set
quality to Fast and check the Economode box.

Using the front panel: Tap @ then Default printing configuration > Print quality > Enable economode.

[%]’9 NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front panel.

High-quality printing
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You can specify high-quality printing in the following ways:

In the Windows driver dialog: Go to the Paper/Quality or Paper tab (depending on the driver version) and
look at the Print Quality section. Move the print-quality slider to the extreme right (‘Quality).

In the Mac OS X Print dialog: Go to the Paper/Quality panel, click Standard in the quality options, and move
the print-quality slider to the extreme right (‘Quality’).

Using the front panel: Tap @ then Default printing configuration > Quality level > Best.

[%9 NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front panel.
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If you have a high-resolution image

If your image has a resolution greater than the rendering resolution (which you can see in the Custom Print
Quality Options box under Windows), print sharpness may be improved by selecting the Maximum detail option.
This option is available only if you are printing on glossy paper and you have selected Best print quality.

e Inthe driver dialog (Mac 0OS X Print dialog): Select Custom instead of Standard print-quality options, then
click Best and check the Maximum detail box.

e  Using the front panel: Tap @ then Default printing configuration > Print quality > Enable maximum

detail.

[:?’”r NOTE: The Maximum detail option results in slower printing with photo papers, but it does not increase the
amount of ink used.

Print in gray shades

You can convert all colors in your image to shades of gray: see Printing in grayscale on page 80.

Print with crop lines

Crop lines indicate where the paper should be cut to reduce it to your selected page size. You can print crop lines
with individual jobs in the following ways:

e Inthe Windows V3 driver dialog: Select the Paper/Quality tab, then click the Margins/Cutter Settings button.
Check the Draw cutting lines box in the Layout and Margins window.

e Inthe Windows V4 driver dialog: Select the Output tab and check the Crop lines box.
e Inthe Mac OS X Print dialog: Select the Finishing panel, then Crop lines.

Alternatively, you can choose to print crop lines with all jobs by default:

e  Using the front panel: Tap , then Default printing configuration > Paper options > Enable crop lines >
On.

To print crop lines with nested jobs (see Nest jobs to save roll paper on page 60), you must select a different

option:

e  Using the front panel: Tap , then Job management > Nest options > Enable crop lines > On.

Use paper economically
Here are some recommendations for making economical use of paper:

e Ifyouare printing relatively small images or document pages, you can use nesting to print them side by
side instead of one after another. See Nest jobs to save roll paper on page 60.

e  You may be able to save some roll paper by using the following options:
— Inthe Windows driver dialog:

o With aversion 3 driver: Click the Paper/Quality tab, then the Margins/Cutter Settings button,
then check the box Remove blank areas.

o  Withaversion 4 driver: Click the Output tab, then Roll options, then check the box Remove blank
areas.
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You can also select the Layout/Output or Layout tab (depending on the driver version) and then select
one of the Rotation options.

— Inthe Mac 0S X Print dialog: Select the Finishing panel, then Remove Blank Areas and/or Rotate.

e Ifyou check the print preview on your computer before printing, you can sometimes avoid wasting paper
on prints containing obvious mistakes. See Preview a print on page 57.

Nest jobs to save roll paper

Nesting means automatically printing images or document pages side by side on the paper, rather than one after
the other. This is done to avoid wasting paper.

r o ‘ Fm====== l

1. Direction of paper flow
2. Nesting off
3. Nestingon

4.  Paper saved by nesting

When does the printer try to nest pages?
When both of the following are true:
e  The printeris loaded with roll paper, not sheet paper.

e  The printer's Nest option is turned on. See How to turn nesting on and off on page 61.

What pages can be nested?

All pages can be nested, unless they are so large that two of them cannot fit side by side on the roll, or unless
there are too many of them to fit into the remaining length of the roll. A single group of nested pages cannot be
split between two rolls.

Which pages qualify for nesting?
In order to be in the same nest, the individual pages must be compatible in all of the following ways:
e  All pages must have the same print quality setting (Economode, Fast, Normal or Best).
e  The Maximum Detail setting must be the same on all pages.
e  The Layout/Margins setting must be the same for all pages.
e  The Mirror Image setting must be the same for all pages.
e  The Rendering Intent must be the same for all pages.

e  The Cutter setting must be the same for all pages.
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e  Pages must be all color, or all grayscale: not some in color and some in grayscale.

e  All pages must be in one or other of the following two groups (the two groups cannot be mixed in the same
nest):

—  PCL3, RTL, TIFF, JPEG
—  PostScript, PDF

e  JPEG and TIFF pages with resolutions greater than 300 dpi may not nest with other pages in some cases.

How to turn nesting on and off

To turn nesting on or off, you must first make sure that the start of printing is set to After Processing (see Select
when to print a job on page 70).

Then go to the front panel and tap @ then Job management > Nest options > Nesting.

You will see the following options:

e Inorder: Pages are nested in the order in which they are sent to the printer (this is the default option). The
nested pages are printed as soon as one of three conditions is met:

—  The next page will not fit on the same row as the other pages already nested.
—  No page has been sent to the printer during the specified wait time.

—  The next page is incompatible with the pages already nested (see Nest jobs to save roll paper
on page 60).

e  Optimized order: Pages are not necessarily nested in the order in which they are sent to the printer. When it
receives an incompatible page, the printer holds it and waits for compatible pages to complete the nest.
The nested pages are printed as soon as one of three conditions is met:

—  The next page will not fit on the same row as the other pages already nested.
— No page has been sent to the printer during the specified wait time.

—  Theincompatible-page queue is full. The printer can queue up to six incompatible pages while nesting
compatible pages. If it receives a seventh incompatible page, the nest is printed as it is.

e  Off:nesting is disabled.

& TIP: Optimized order uses the minimum amount of paper; however, it may take longer to print because the

printer waits for compatible pages to arrive.

How long does the printer wait for another file?

ENWW

So that the printer can make the best nest possible, it waits after a file has been received to check whether a
subseguent page will nest with it or with pages already in the queue. This waiting period is the nest wait time;
the factory default nest wait time is 2 minutes. This means that the printer waits for up to 2 minutes after the
last file is received before printing the final nest. You can change this waiting time from the printer's front panel:

tap @ then Job management > Nest options, and select the wait time. The available range is 1 to 99

minutes.

While the printer is waiting for nesting to time out, it displays the remaining time on the front panel and in the
Embedded Web Server.

Advanced print settings
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Use ink economically

Here are some recommendations for making economical use of ink:

For draft prints, use plain paper and move the print-quality slider to the left end of the scale (‘Speed'). For
further economy, select custom print quality options, then select Fast and Economode.

Clean the printheads only when needed, and clean only those printheads that need cleaning. Cleaning the
printheads can be useful, but it uses a small amount of ink.

Leave the printer permanently turned on so that it can maintain the printheads in good condition
automatically. This reqular printhead maintenance uses a small amount of ink. However, if it is not done,
the printer may need to use much more ink later to restore the health of the printheads.

Wide prints make more efficient use of ink than narrow prints, because printhead maintenance uses some
ink, and its frequency is related to the number of passes made by the printheads. Therefore, nesting jobs
can save ink as well as saving paper (see Nest jobs to save roll paper on page 60).

Protect a paper type

You can protect selected paper types to avoid printing on them unintentionally. A protected paper type will be
printed on only when the paper type is explicitly specified in the job.

To protect a paper type, tap @ then Job management > Roll policies > Protected paper types, then select

the category of paper you want to protect.

When a paper type is protected, the § icon appears before the paper name.

To print on a protected paper category, just select the paper type explicitly when submitting the job from a
printer driver or other job submission software.

[%,/r NOTE: If a protected paper type is not explicitly selected, and no other paper types are available, an out-of-
paper message will appear.

Unattended printing/overnight printing

The printer is well suited to long, unattended print jobs, having multiple rolls plus robust and consistent image
quality.

Here are some recommendations to help you deal with a long queue of printing jobs.

If feasible, use brand-new long rolls of paper.

If you want to print on partly-used rolls, you can check the paper type and the remaining length in the
Embedded Web Server or in the front panel, to confirm that you have enough paper to print all your jobs.

[%r NOTE: Information on the remaining length is available only if you told the printer the length of the roll

when you loaded it, or if the printer read the length of the roll from the barcode printed on it.

If you have a T1700dr printer, load two rolls of paper suitable for your jobs. If the printer finishes one roll, it
will automatically switch to the other.

HP recommends the use of papers approved for your printer. See Accessories on page 124.

Check that you have paper wide enough to print all of your jobs. Any jobs that are too wide may be put on
hold for paper if the paper mismatch action is set to Put job on hold (see Solve paper mismatch

on page 71).

Check the ink levels remaining in your ink cartridges.
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e  When you have submitted your print jobs, you can use the Embedded Web Server from a remote location
to monitor their status.

e  Drying time should be set to Optimal.
e Tap @ then Job management > Roll policies > Use most depleted roll > On.

We recommend the following settings, depending on the paper type and what kind of prints you are making.

Recommended settings for unattended printing

Print type Print mode Maximum detail Drying time Paper types

Lines Normal Off Optimal Coated, Bond, Heavyweight
Coated, Glossy

Lines and fills Normal Off Optimal Coated, Bond, Heavyweight
Coated, Glossy

Maps Best Off Optimal Coated, Heavyweight Coated,
Glossy

Renderings, photographs Best Off Optimal Coated, Heavyweight Coated,
Glossy

Advanced print settings
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6 Mobile printing

° Mobile printing
e  Print fromin-0S

e  Print by email (HP ePrint)

° Print and share from the HP Smart App

° Mobile specifications
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Mobile printing

You can print to your printer from many mobile devices and from almost any location. There are two main
methods of mobile printing:

e  Direct printing by connection to the same network
e  Printing by email
Your printer can be connected to the Web, providing various benefits:

e  Automatic firmware updates (see Update the firmware on page 121)

° Print on HP printers from almost anywhere
e  Print on HP printers from almost any device, including smartphones, tablets, and laptops

See http://www.hp.com/go/designjetmobility for more detailed information.

You can enable Web Services when setting up the printer: see Set up printer services on page 17 or the Assembly
Instructions for more information.

@ IMPORTANT:  The printer must be connected to a network with Internet access: connect an Ethernet cable. See

Connect the printer to your network on page 15.

Print from in-0S

B4 NOTE:  Printing is available only from applications that implement printing or sharing facilities.

iOS (iPhone, iPad) with AirPrint

Printing with AirPrint is simple, all you have to do is make sure your device and printer are operating on the same
network and follow the steps below:

1. Choose your content. Open the document or photo you want to print, tap the share button.

2. Select the print icon. Swipe the screen to reveal the print button at the bottom, then tap the print icon.

3. Confirm that the correct printer and print setting are selected. Tap Print and collect your printed documents.

Android with HP Print Service Plugin

Printing with an Android device is simple. Ensure that you have downloaded the HP Print Service Plugin from the
Google Play store: https://play.google.com/store/apps/details?id=com.hp.android.printservice. Ensure that the
plugin is updated to the latest version. Also ensure that your device and printer are operating on the same
network, and follow the steps below:

1. Choose your content. Open the document or photo you want to print, tap the menu icon and select Print.

If the content type is a JPEG, PNG, or PDF file, you can alternatively tap the Share button and select the HP
Print Service Plugin icon.

2. Choose your printer. Select from the list of printers that appears.

3. Confirm that the correct printer and print setting are selected. Tap Print and collect your printed documents.

Chromebook with HP Print for Chrome

ENWW

Printing from Chromebook devices is as easy as installing the HP Print for Chrome extension from the Chrome
Web Store: https://chrome.google.com/webstore/detail/hp-print-for-chrome/
cianmonomjogheabiocdamfpknlpdehm.

Mobile printing

65


http://www.hp.com/go/designjetmobility
https://play.google.com/store/apps/details?id=com.hp.android.printservice
https://chrome.google.com/webstore/detail/hp-print-for-chrome/cjanmonomjogheabiocdamfpknlpdehm
https://chrome.google.com/webstore/detail/hp-print-for-chrome/cjanmonomjogheabiocdamfpknlpdehm

Ensure that your device and printer are operating on the same network, and follow the steps below:
1. Choose your content. Open the document or photo you want to print, tap the menu icon and select Print.
2. Choose your printer. Select from the list of printers that appears.

3. Confirm that the correct printer and print setting are selected. Tap Print and collect your printed documents.

r.%’ NOTE: Printing will be available only from applications that offer printing or sharing.

Print by email (HP ePrint)

[Q” IMPORTANT:  To enable email printing, see Enable email printing with HP ePrint on page 18.

If you can email it, you can print it. Simply attach a PDF or other print-ready file to an email message, and send it
to your printer’s dedicated address.

In this way, you can print from anywhere with an Internet connection, without needing any printer driver. There
are a few limitations that you should bear in mind:

e  The attached files to be printed must be in PDF, JPEG, or TIFF formats.
e  The maximum file size is 10 MB, but your email server may have a lower limit.

e  Files are printed in the original document size (at 100% scale), in normal quality, in color, and normally in
portrait orientation (some printers may offer autorotation).

Print and share from the HP Smart App

Use the screen on your mobile device to control the printer and print. Print PDF files, photos, email attachments,
and more from virtually anywhere.

Download the HP Smart App:

° For Android: https://play.google.com/store/apps/details?id=com.hp.printercontrol

e  ForiOS: https://itunes.apple.com/app/id469284907

Make sure your device and printer are operating on the same network, and follow the steps below:
1. Open the HP Smart App and select your printer.

2. Select whether you want to print documents or photos from your local device or link to your Google Drive,
Dropbox, or Facebook accounts to access your content there.

3. Use the edit options to adjust quality, color and other settings, if there are any adjustments that you wish to
make.

4.  Tap Print and collect your printed documents.

Mobile specifications
e  Mobile devices must have an Internet connection and email capability.
e  Print, scan, and copy control requires the mobile device and printer to be on the same network.
e  Printing by email also requires the printer to be connected to the Internet.

e i0S7.0and above, or Android KitKat4.4 and above, is required.
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Job queue management

e  Job queue in the front panel

° Job queue in the Embedded Web Server or HP DesignJet Utility
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Job queue in the front panel

7

Tap "’_ on the home screen to view the job queue on the front panel.

The print queue includes jobs that are being received, parsed, rendered, printed, already printed, and so on.

Print Q -
1. ONHOLD 2 jobs v |
| €O History 32 jobs ~
| ) Done Yester...
&) Done Yester...
Canceled —
Tap the name of the job to see all the job details, including information about status, pages, copies, total, and
preview.
JPEG job
&) Printed 1:28:39 PM

_ _ | paces COPIES TOTAL
[ Q 1/1 11 1 e

i

& SENT BY thoumm °

In an active queue, the job you are printing appears in the middle of the queue, with printed jobs below and jobs
to be printed above. You can scroll up and down. Once scrolled, the queue remains static and does not move
automatically.

Jobs in the left pane are divided into four categories (Up next, Now printing, On hold, and History) in chronological
order starting from the top. On hold is shown only when there are one or more jobs on hold. Below the job name,
you can see its status:

Up next
e  Waiting to process: The job has been received by the printer and is waiting to be rendered.
e  Processing: The printer is parsing and rendering the job.
e  Waiting to print or Paused: The job is processed and waiting for the print engine to be ready to proceed with
printing.
Now printing

The job is being printed.

e  Paused: The jobis paused.

r.%? NOTE: Sometimes, while printing, you may see a Self-servicing status, which means that the printer is
performing some task such as paper type change or print mode change between pages of the same job.
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Onhold
The job will not be printed until you take some action. You should respond in one of the following ways:

e  Onhold: Private job: Enter the PIN required to print the job. The job will be deleted from the queue after
printing.

e  Ohhold: Personal job: The job is not automatically printed: you must select it from the queue. No details
can be seen.

e  Onhold to preview: The job is not automatically printed: you must select it from the queue.
e  Onhold for paper mismatch: Load the paper required by the job.
e  Onhold for accounting: Enter an account ID to be used for the job.

e  On hold: Recovered job: After a printer recovery, some jobs that were not printed are kept on hold.

History
e  Printed: In chronological order, divided into today, yesterday, last week, and so on.
e  (anceled: Canceled by the user.

e  Failed: The job has failed for one or more reasons.

Job queue actions
Some of the actions in the job queue are determined by the settings selected. Some default settings may be

worth changing, depending on your environment. To do so, tap @ in the home screen, then Job

management. Alternatively, in the job queue app, tap =+« at the top right, then Settings.

Print |-
{:} Settings

Delete all Print Jobs
X0 History 32jobs ~

1. ONHOLD 2j

Pause the job queue

You can pause the job queue by tapping m and resume by tapping [O] The pause takes effect at the end
of the page that is currently printing.

Reprint

In the History section, tap the job you want to reprint. On the details screen, tap the Printer button, then e

then Reprint. On the next screen, you can select the number of copies, the source, and the destination.
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Print next

If you want to change the position of a job in the queue to be printed immediately after the currently printing job,
select the desired job and tap the Print next button.

Select when to print a job

993

B NOTE: The When To Start Printing options cannot be used with PostScript jobs.

You can select at what point you want to print a job in the queue. Tap @ then Job management > When to
start printing.
There are three options you can select:

e  When After Processing is selected, the printer waits until the whole page has been processed and then it
starts to print. This is the slowest setting but ensures the best print quality in large or complex prints.

e  When Immediately is selected, the printer prints the page as it is processed. This is the quickest setting, but
the printer may stop halfway through a print to process data. This setting is not recommended for complex
images with dense color.

e  When Optimized is selected (this is the default setting), the printer calculates the best time to begin printing
the page. It is usually the best compromise between the After Processing and Immediately settings.

See job details

Tap the name of the job to show its details, including information about status, pages, copies, total, and preview.
Scroll down as necessary to see all of the information.

By tapping the thumbnail, you can navigate over all pages of the job. From there you can zoom in and out (pinch
and zoom) and see more information about each page: tap the iicon at the bottom of the page.

In an active queue, the job you are printing appears in the middle of the queue, with printed jobs below and jobs
to be printed above.

Roll policies

[

At the front panel, tap |! then «e«, then {) then Roll policies.

Alternatively, tap @ then Job management > Roll policies.

The following options are available:
e Increase productivity: To increase the productivity of the printer.

—  Job autorotation: The printer can rotate a job automatically in order to save paper.
e  Automatic roll selection:

—  Roll width selection: The printer can be more or less restrictive when selecting the roll width on which
to print. You can select:
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o Print on the same width only: Each page prints on a roll with the same page width.
o Print on the same width or wider: Each page prints on a roll with the same width or wider.

—  Use most depleted roll (T1700dr only): When there are two or more rolls with the same paper type
and width, the roll selected is the roll with less paper.

Paper type protection (T1700dr only): You can avoid printing accidentally on special paper types by
protecting them. Protected types are eligible for printing only when paper type or roll are specified in the
job.

See also Protect a paper type on page 62.

Solve paper mismatch

If the paper currently loaded in the printer is not suitable for a particular job or page, the printer can
automatically solve the conflict or give a number of choices depending on the printer policies. Such a conflict may
be caused by a job sent to the printer with no specific roll or paper type assigned to it, or by a roll coming to its
end during printing. The following options are available in the paper mismatch settings menu; you can reach this

menu from the job queue by tapping ««, then o then Mismatch actions > Paper mismatch; or by tapping

@, then Job management > Mismatch actions > Paper mismatch.

@]

©

Settings )...) Paper mismatch

Pause and ask

After mismatch is detected, job queue pauses and
printer asks for intervention.

Hold job and continue with next

Pause and ask (the most restrictive option): Printing stops until the correct paper is loaded. This option is
recommended when the printer is attended. A message appears, asking what you want to do: cancel the
job, print anyway, put on hold, or load paper. These options are also available in the job queue.

Hold job and continue with next: Put mismatched jobs on hold until the correct paper is loaded, and
continue printing the rest of the job queue. The printer sends an alert whenever ajob is put on hold. This
option is recommended when the printer is unattended, even though the integrity of a job may be
disrupted, to avoid stopping the queue. Once the paper required for the job is loaded, the job or pages are
automatically resumed.

Print anyway (the least restrictive option): Print on whatever paper is loaded. The printer will choose the roll
to print according to the following criteria: first where the page fits and then the same paper type. This
option will never select a paper type that has been protected.

Job queue options

To change the job queue options, tap @ then Job management > Job queue.

You can select the maximum number of printed jobs to have in the queue, when to delete printed jobs, and
whether to delete jobs on hold after a specified time.
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Default printing preferences

At the front panel, tap @ then Default Printing configuration to define the default properties of jobs sent to

your printer from remote locations.

You can define settings in the following areas: Print quality, Color, Paper, Margins, HP-GL/2, PostScript, Print
retrieval.

Job deletion

If the printer runs out of storage space for new jobs, the oldest printed jobs are automatically deleted from the
queue.

You can request that printed jobs should be automatically deleted from the queue when the total number of
printed jobs exceeds a specified limit (the maximum number in the history setting), or when the jobs were
printed more than a specified time ago (clear history settings).

To delete jobs on hold, the setting Delete jobs on hold allows you to define the time after which these jobs will be
removed (2—48 h).

To delete a job manually, select the job and tap Delete in the <+« menu. To delete all jobs, tap Delete all jobs in
the <+« menu; the whole job queue will be deleted.

The Delete option deletes the job from the queue, while the Cancel option cancels the job but leaves it in the
gueue, marked as Canceled by the user in the history category.

To cancel a job while printing, tap X. To cancel a job from the Up Next category, tap the job name on the list and
then tap Cancel job on the bottom right.

BY NOTE: If you tap X, you cancel the currently printing job only.

Job queue in the Embedded Web Server or HP DesignJet Utility

The HP DesignJet Utility provides a different way of accessing the Embedded Web Server's job management
facilities, but the facilities are exactly the same whether you use the Embedded Web Server or the HP DesignJet
Utility.

To see the queue in the Embedded Web Server, select Job queue in the Main menu.

Job queue page

By default, access to the job queue is open to all users. An administrator can set a password so that users are
required to enter a password to access the page.

The job queue page shows all jobs that are available in the print queue. The print gueue includes jobs that are
being received, parsed, rendered, printed and already printed.

The Embedded Web Server displays the following information for each print job:
e  File name: The name of the job.

e  Status: The current status of the job.

e  Pages: The number of pages in the job.

e  (opies: The number of copies printed.

e  Total: The total number of pages (including copies).

e  Sentby: The username.
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e  Account ID: The account ID for the job.

e Date: The date and time attached to the job that was received by the printer, shown in the locale of the
Embedded Web Server.

e  File source: The application from which the job was sent to print.
e  Paper destination: The output option selected for the printed job.

Jobs in the queue can be sorted by any of the information items (except Preview) by clicking on the title of the
corresponding column. You can perform the following operations on one or all jobs in the queue:

e  (ancel: Cancels the selected jobs. You are asked to confirm before the job is canceled. The job remains
stored in the printer, but will not be printed unless you click Reprint.

e Hold: Holds the select jobs until you click Continue to print.

e  Resume: All selected jobs, which are on hold, continue printing.

e  Reprint: Prints more copies of a job.

e  Next print: Sends all selected jobs to the top of the job queue.

e  Print anyway: The printer will try to print the job even if there is some problem with it.

e  Delete: Deletes selected jobs from the job queue. You are asked to confirm before the job is deleted.

Prioritize a job in the queue

You can select any job in the queue and make it the next one to be printed. After selecting the job, click Move to
front.

If nesting is turned on, the prioritized job may still be nested with others. If you really want this job to be printed
next, and not nested with others, first turn nesting off in the front panel and then move it to the front of the
queue.

In the following cases, the Next print button is not displayed:

e Thejobis already at the front of the queue.

e Thejobis on hold—in this case the Resume printing button is displayed instead.
e  Thejob has finished—in this case the Reprint button is displayed instead.

e Thejob has some error condition.

Delete a job from the queue

Under normal circumstances, there is no need to delete a job from the queue after printing it, as it will just fall off
the end of the queue as more files are sent. However, if you have sent a file in error, and want to avoid printing it,
you can simply select the job and then click Delete.

In the same way, you can delete a job that has not been printed yet.

If the job is currently being printed (its status is printing), you can click Cancel and then Delete.

Reprint a job in the queue
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To reprint an already-printed job, select the job from the queue, then click Reprint. When reprinting a print job,
you cannot change the print settings, because the job has already been rasterized.

Job queue in the Embedded Web Server or HP DesignJet Utility
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Job status messages

These are the possible job status messages, approximately in the order in which they may be seen:

Downloading: The printer is receiving the job from the computer.
Processing: The printer is parsing and rendering the job.
Waiting to print: The job is waiting for the print engine to become free to proceed with printing.

Nested: The printer is set up with Nesting=0n and is waiting for other jobs in order to complete the nest and
proceed with printing.

Preparing to print: The printer is performing writing system checks before printing the job.

On hold for preview: The job was sent with the on hold for preview option.

[%’ NOTE: If the printer hangs up while printing a job, and the queue facility is turned on, the partially printed

job will appear in the queue as on hold when the printer is next turned on. When you resume the job, it will
start printing at the page at which it was interrupted.

On hold for paper: The job cannot be printed because the right paper is not loaded in the printer. Load the
required paper, see Paper handling on page 24, and click Continue to resume the job.

On hold for accounting: The job cannot be printed because the printer requires all jobs to have an account
ID: enter the account ID and then click Continue to resume the job.

% TIP:  Toset an account ID, see Require account ID on page 20.

Printing

Drying

Cutting paper

Ejecting page

Canceling: The job is being canceled, but will remain in the printer job queue.
Deleting: The job is being deleted from the printer.

Printed

Canceled: The job has been canceled by the printer.

Canceled by user

Empty job: The job does not contain anything to print.

Reactivate a job on hold

When the printer puts a job on hold you receive an alert, see Alerts on page 166, which explains why the job is
on hold. Follow the instructions on the screen to remove the hold and continue printing.
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Color management

° Introduction

° How colors are represented

e  Asummary of the color management process

° Color calibration

° Color profiling

° Color management from printer drivers

° Color management from the front panel
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Introduction

Color management is performed using a set of software tools that allow you to reproduce a color as accurately
as possible on any display or printing device.

In addition, your printer has been engineered with advanced hardware and software features to ensure
predictable and dependable results.

° Color calibration for consistent colors

e  The Photo Black ink provides pure blacks when printing on photo papers

How colors are represented

Color is usually represented as an array of numbers: three numbers in the RGB color model or four in the CMYK
color model. These numbers are a measure of the base colors used in a mixture to create a given color. RGB
means that we are using a mixture of Red, Green, and Blue to create any specific color. In the case of CMYK, the
mixture is of Cyan, Magenta, Yellow, and Key (where Key means black, for historical reasons).

Most monitors use the RGB color model, while most printers use the CMYK color model.

An image can be converted from one color model to another, but in general the conversion is not perfect. Your
printer uses the RGB color model: the same color model that is used by your monitor.

This simplifies but does not completely solve the problem of matching colors. Each device represents colors a
little differently from another device, even if they use the same color model. However, color management
software can adjust the colors in animage according to the characteristics of the particular device, using a color
profile of the device, in order to achieve correct colors.

A summary of the color management process
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To get the accurate and consistent colors that you want, you should follow these steps for each paper type that
you use.

1. Color-calibrate the paper type, for consistent colors. Calibration should be repeated every now and then
(see Color calibration on page 76). In addition, you may wish to calibrate immediately before a particularly
important print job for which color consistency is vital.

2. When printing, select the correct paper preset for the paper type you are using. The paper preset contains
the color profile as well as various other characteristics of the paper. See Paper presets on page 33.

Color calibration

Color calibration enables your printer to produce consistent colors with the particular printheads, inks and paper
type that you are using, and under your particular environmental conditions. After color calibration, you can
expect to get similar prints from any two different printers situated in different geographical locations.

Some paper types cannot be calibrated. For all other paper types, calibration should be done in any of the
following circumstances:

e  Whenever a printhead is replaced

e  Whenever a new paper type is introduced that has not yet been calibrated with the current set of
printheads

e  Whenever the environmental conditions (temperature and humidity) change significantly
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You can check the color calibration status of the currently loaded paper at any time by going to the front panel

and tapping \g then o then Color calibration status. The status may be one of the following:

e  Recommended: The paper has not been calibrated.

[’_ﬁ”f NOTE: Whenever you update the printer's firmware, the color calibration status of all papers is reset to
Recommended.

e  Obsolete: The paper has been calibrated, but the calibration is now out of date because a printhead has
been replaced, and should be repeated.

° Done: The paper has been calibrated, and the calibration is up to date.

e Disabled: This paper cannot be calibrated.

[%9 NOTE: Color calibration cannot be performed on plain paper, nor on any kind of transparent material.

You can start color calibration from the front panel: tap \g then Color calibration.

The calibration process is fully automatic and can be performed unattended after you have loaded paper of the
type you wish to calibrate—which should be wider than 355 mm (14 in). If you have more than one roll loaded,
the printer will ask which roll you want to use for the calibration.

The process takes about 3—5 minutes and consists of the following steps:

1. Acalibration chart is printed, which contains patches of each ink used in your printer.
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2. Thechartis allowed to dry for a period of time that depends on the paper type, so that the colors have time
to stabilize.

3. Thechartis scanned and measured.

4. From the measurements, the printer calculates the necessary correction factors to apply for consistent
color printing on that paper type. It also calculates the maximum amount of each ink that can be applied to
the paper.

Color profiling

Color calibration provides consistent colors, but consistent colors are not necessarily accurate. For instance, if
your printer prints all colors as black, its colors may be consistent but they are not accurate. In order to print
accurate colors, it is necessary to convert the color values in your files to the color values that will produce the
correct colors from your printer, your inks, and your paper. An ICC color profile is a description of a printer, ink, and
paper combination that contains all the information needed for these color conversions.

Install a color profile

ENWW

If you have obtained an ICC profile from a third-party profiling software package, you can install it for use with
your printer and paper.

Color profiling
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Windows procedure

1. Go to the Color Center in the HP Utility. Click Profile Management, then 1.

2. Select the paper type that you will use with the ICC profile, and select the file containing the ICC profile.

EJ?’/ NOTE: ICC profile file names have the extensions ".icc” (for International Color Consortium) or ".icm" (for
Image Color Matching).

3. Check the ICC profile name, then click Next.

4.  TheICC profile is installed in your computer and will be available to use in your applications.

Mac OS X procedure

1. Goto Paper Preset Management in the HP Utility and select the color profile to be installed.

2. Click o at the bottom of the window, then click Install profile.

Export a color profile

An ICC profile associated with a paper type can be exported, enabling it to be used on a different printer or with a
different paper preset..

Windows procedure

1. Goto the HP Color Center in the HP Printer Utility. Click Profile Management, then tat the bottom of the
page.

2. Select the paper type and the ICC profile to be exported.
3. Choose the pathname of the folder in which the ICC profile will be saved in your computer.

4.  The ICC profile file is saved in the specified folder.

Mac OS X procedure
1. Goto Paper Preset Management in the HP Utility and select the paper type and ICC profile to be exported.

2. Click {C}, then Export ICC profile.

3. Choose the pathname of the folder in which the ICC profile will be saved in your computer, and click
Continue.

Restore an original color profile

The ICC profile settings in a paper preset can be restored to their original values. This will remove any ICC profile
that you have associated with the selected paper and restore the default ICC profile provided by HP.

Windows procedure
1. Go to the HP Color Center in the HP Printer Utility. Click Profile Management.

2. Select the paper type whose ICC profile you want to restore. Click Restore.

Mac OS X procedure
1. Goto Paper Preset Management in the HP Utility and select the ICC profile.

2. Click {C}, then Restore factory ICC profile.
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Color management from printer drivers

Color management options

The aim of color management is to reproduce colors as accurately as possible on all devices: so that, when you
print an image, you see very similar colors as when you view the same image on your monitor.

% TIP: Make sure to select matching settings in the driver and in the application.

There are two basic approaches to color management for your printer:

e  Printer-Managed Colors: In this case your application program sends your image to the printer without any
color conversion, and the printer converts the colors to its own color space. The details of this process
depend on the graphics language that you are using. HP recommends this setting for the best experience
and results.

—  PostScript: The PostScript and PDF interpreter modules perform the color conversion using the
profiles stored in the printer and any additional ICC color profiles sent with the PostScript job. This
kind of color management is done when you are using the PostScript or PDF driver.

—  Non-PostScript (PCL3, HP-GL/2, CALS/G4): The color management is done using a set of stored color
tables. ICC profiles are not used. This method is somewhat less versatile than the alternatives, butis a
little simpler and faster, and can produce good results with standard HP paper types.

EJ?"” NOTE: In non-PostScript printing, the printer can convert to sRGB if you are using Windows, or to
Adobe RGB if you are using Mac OS X.

e  Application-Managed Colors: In this case your application program must convert the colors of your image to
the color space of your printer and paper type, using the ICC profile embedded in the image and the ICC
profile of your printer and paper type. To use this option, your printer’s ICC profiles must be installed in your
computer.

E‘% IMPORTANT:  Make sure to select matching settings in the driver and in the application.

You are recommended to consult the HP Support Center (see HP Support Center on page 169) to see how to use
the color management options of your particular application. See also Print a document with the correct colors

on page 87.

To choose between Application-Managed Colors and Printer-Managed Colors:
e  Inthe Windows driver dialog: Select the Color tab.

e Inthe Mac OS X Print dialog: Select the Color Matching panel. Vendor Matching or In Printer corresponds to
Printer-Managed Colors mode. ColorSync should be used only if you cannot choose Application-Managed
Colors in your application print dialog.

e Insome applications: You can make this choice in the application.

Color options

Printing in color

The printer prints in color by default.
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You can select color printing explicitly in the following ways:

In your application program: Many programs provide this option.

In the Windows driver dialog: Go to the Color tab and look at the Output Color or Color Options section
(whichever is available in your driver). Select Print in color.

In the Mac 0S X Print dialog: Go to the Color Options panel and select Color from the Mode drop-down list.

Printing in grayscale

You can convert all colors in your image to shades of gray in the following ways:

In your application program: Many programs provide this option.

In the Windows driver dialog: Go to the Color tab and look at the Output Color or Color Options section
(whichever is available in your driver). Select Print in grayscale.

In the Mac 0S X Print dialog: Go to the Color Options panel and select Grayscale from the Mode drop-down
list.

Printing in pure black and white

You can convert all colors in your image to pure black and pure white in the following way:

In the Windows driver dialog: Go to the Color tab and look at the Output Color or Color Options section
(whichever is available in your driver). Select Print in pure black and white.

HP Professional PANTONE Emulation

When you use a named PANTONE color in an image, your application will normally send to the printer a CMYK or
RGB approximation to that color. But the application does not take the printer or the paper type into account, it
merely produces a generic approximation of the PANTONE color, which will look different on different printers and
on different papers.

HP Professional PANTONE Emulation can do a much better job by taking into account the characteristics of the
printer and the paper type. The results look as similar to the original PANTONE colors as is possible on a given
printer using a given paper type. This technology is designed to produce emulations similar to those set up
manually by prepress professionals.

To use HP Professional PANTONE Emulation, all you have to dois to turn it on. In fact, it is normally on by default.

In the Windows PostScript/PDF driver dialog: Go to the Color tab and select HP Professional PANTONE
Emulation.

In the Mac 0S X Print dialog: Go to the Color Options panel and select HP Professional PANTONE Emulation.

From the front panel: Tap @ then Printing preferences > Color options > HP Pantone Emulation.

HP Professional PANTONE Emulation not only provides the closest match that can be achieved on your printer; it
also gives clear information on how close the emulation is to the original spot color.

Default color spaces

When a document or image does not specify the working color space in which the content is originally described,
the user can choose among different standards. That is, the user can determine how data should be interpreted
by the color management system during the rendering process.
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You can set source profiles in the following ways:
e Inthe Windows PostScript/PDF driver dialog: Select the Color tab, and Printer Managed Colors.

e Inthe Mac OS X Print dialog: Select the Color Option panel, then select Adobe RGB or SRGB as the source
profile to emulate an RGB device.

The standard way of encapsulating such information is in ICC profiles. As part of the solution, we provide the
most common standards for the different devices.

The options are as follows.

Default RGB source profiles
Your printer is provided with the following color profiles:

e  None (Native): No imitation, for use when the color conversion is done by the application or operating
system, and therefore the data arrive at the printer already color-managed. Available for PostScript and
PDF drivers only.

e SRGBIEC61966-2.1 imitates the characteristics of the average PC monitor. This standard space is endorsed
by many hardware and software manufacturers, and is becoming the default color space for many
scanners, printers and software applications.

e  ColorMatch RGB imitates the native color space of Radius Pressview monitors. This space provides a smaller
gamut alternative to Adobe RGB (1998) for print production work. Available for PostScript and PDF drivers
only.

e  Apple RGB imitates the characteristics of the average Apple monitor, and is used by a variety of desktop
publishing applications. Use this space for files that you plan to display on Apple monitors, or for working
with old desktop publishing files. Available for PostScript and PDF drivers only.

e  Adobe RGB (1998) provides a fairly large gamut of RGB colors. Use this space if you need to do print
production work with a broad range of colors.

Default CMYK source profiles

You can choose from a selection of CMYK source profiles recognized by the printer. The default CMYK profile is
Coated FOGRA39 (ISO 12647 - 2:2004), available for PostScript and PDF drivers only.

Color management from the front panel

You can color-calibrate the loaded paper type from the front panel by tapping \g then Color calibration. See

Color calibration on page 76.

The other color options in the front panel can all be found by tapping @ then Default printing configuration

> Color options (they can also be found under Advanced printing preferences).

All jobs

e (olor
e  Grayscale
e  Pure black and white

e  RGB source profile: You can choose from a selection of RGB source profiles recognized by the printer.
Default: sSRGB IEC 1966-2.1.
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PostScript and PDF jobs only

e  Select CMYK source profile: You can choose from a selection of CMYK source profiles recognized by the
printer. Default: US Coated SWOP v2.

e  Select rendering intent: You can select the rendering intent. Default: Perceptual.
e  Black point compensation: You can turn black point compensation on or off. Default: On.

° HP Professional PANTONE Emulation: You can turn HP Professional PANTONE Emulation on or off. Default:
On.
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Practical printing examples

° Print a draft for revision with the correct scale

° Print a PDF multipage job from Adobe Acrobat Reader or Adobe Acrobat Pro

° Print a document with the correct colors

° Print a project

° Print a presentation

° Print and scale from Microsoft Office
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Print a draft for revision with the correct scale

This section demonstrates how to print a draft for revision with the correct scale from Adobe Acrobat.

Using Adobe Acrobat

1. Inthe Acrobat window, bring the mouse cursor to the bottom left corner of the document pane to check
the page size.

P& HP Designlet T1700 Printer Series User Guide - Adobe Acrobat Pro
File Edit View Window Help

Dopn |- | E|le¢eozbhBH

®[Joom | O | =@ [>=]-]| & B
@|wmaru M0
P E iR R

——| P Introduction

&g [P Paper handling

2z I Working with two rolls (T1700dr only)
i Networking

[P Printing

[P Mobile printing

Tools

@ HP DesignJet T1700 Printer Series

User Guide

P Job queue management

[P color management

[P practical printing examples

i Retrieving printer usage information
[P Handling ink cartridges and printheads|
[P Maintaining the printer .
I Accessories

[P Troubleshooting paper issues

[P Troubleshooting print-quality issues

s Troubleshooting ink cartridge and
printhead issues

i Troubleshooting general printer issues
[P Front-panel error messages
[P HP Customer Care
[P Printer specifications
w Glossary
[P Index

2. Select File > Print and ensure that Page Sizing & Handling is set to Actual size.

[%”f NOTE: The page size will not be automatically selected according to the drawing size.

3. Click the Properties button and then select the Paper/Quality tab.

4.  Choose whatever Document Size and Print Quality you want to use. If you want to define a new custom
paper size, click the Custom button.

rCustomsiae —TTT ‘LM‘

Units
@ Inches

Size
Width: 8.27 (3.00 - 40.00)

Length: 1169 (5.51-7874.02)

Custom

5. Select the Features tab, and then Autorotate.

6.  Click OK, and check that the print preview in the Print dialog box seems correct.
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Print a PDF multipage job from Adobe Acrobat Reader or Adobe
Acrobat Pro

Using a raster driver

1.

5.
6.

Open a multipage job in Adobe Acrobat Reader or Adobe Acrobat Pro (HP recommends always using the
latest version).

Click File > Print.
Select the printer and driver.

Check the Choose paper source by PDF page size box.

Printer. | HP Designlet TI700dr «|[ " Properties Advanced Help @&
Copies: 1 e [ Print in grayscale (black and white)

Pages to Print Comments & Forms

[CH Document and Markups ~

O Current page

O Pages i 179
» More Options

Summarize Comments

Document: 8.3 x 11.7in

8.27 % 11.69 Inches.
Page Sizing & Handling @

A5 Poster [E] Muttiple [5) Booklet

OFit
@) Actual size
O Shrink oversized pages

() Custom Scale: 100 %

| Choose paper source by PDF page size

@ #0 Designiet T1700 Pinter Series

Orientation:

(@) Auto portrait/landscape
O Portrait

O Landscape

Page 1 of 187

Page Setup... Print Cancel

Adjust other properties in the driver properties window, as required.

Click the Print button.

The pages will be printed on the standard page size closest to the page size in the original document.

Using a PostScript driver

ENWW

1.

Open a multipage job in Adobe Acrobat Reader or Adobe Acrobat Pro (HP recommends always using the
latest version).

Click File > Print.

Select the printer and driver.

Print a PDF multipage job from Adobe Acrobat Reader or Adobe Acrobat Pro
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4.  Check the Choose paper source by PDF page size and Use custom paper size when needed boxes.

0]
Printer: w|| Properties Advanced Help (&)
Copies: |1 3 [l Print in grayscale (black and white)
[Jsaveink/toner (@
Pages to Print Comments & Forms
®an Document and Markups v
Current page
o i Summarize Comments
OPages  |i- 1%

» More Options Document: 8.3x11.7in

8.28 % 11.7 Inches

Page Sizing & Handling (1)
Size Poster Multiple Booklet
OFit
(®) Actual size
() Shrink oversized pages

() Custom Scale: 100 %

[ Choose paper source by PDF page size
Use custom paper size when needed

Ornentation:

(® Auto portrait/landscape
(O Portrait

(O Landscape

Page 1 of 204

Page Setup... Cancel

5. Adjust other properties in the driver properties window, as required.
6.  Click the Print button.

If you checked the Use custom paper size when needed box, the pages will be printed on paper sizes
corresponding to the page sizes in the original document.

Using a PDF driver

With the latest versions of Adobe Acrobat Pro or Adobe Acrobat Reader, this is managed by the application, and
the pages will be printed on paper sizes corresponding to the page sizes in the original document.

Printer: v|| Properties Advanced Help @

copesl =

Osaveinkitoner (@

Pages to Print Comments & Forms
| @an Document and Markups -
| O current page

Summarize Comments
| Opages |[i-196

» More Options Scale: 95%

827x 1169 Inches
Page Sizing & Handling (1)

Size Poster Multiple Booklet

Fit

Actual size

Shrink oversized pages

Custom Scale: 100

Choose paper source by PDF page size

Orientation:

Auto portrait/landscape

(®) Portrait
O Landscape
il :
Page 1 of 204
Page Setup... Print Cancel
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Print a document with the correct colors

Using Adobe Acrobat Reader

Acrobat Reader is the most basic application for PDF files; several color management tools common in more
sophisticated applications are not explicitly present, and work by default with presets that cannot be changed.
For example, there is no way to select a working color space; a default color space, most likely sRGB, is applied.
This color space is used for screen display, for example. Also, as an alternative color profile when no other is

ENWW

This section demonstrates how to print a document from Adobe Acrobat and Adobe Photoshop, with the
emphasis on color management.

specified by a file, as will be explained later.

The printing process is very simple.
1.
2.

Click File > Print.

Select the printer and driver from the Printer drop-down menu in the Print dialog box. Driver settings can

be adjusted by clicking the Properties button.

T HP Designlet

File Edit View Window Help

]

Do | Q8 2@ ES]=]

Y Jeam| @@~ 1) B0 | S|

| Printer: HP Designlet T1700dr

v | Properties Advanced

Copies: |1
Pages ta Print
®an

(O Current page

Opages  [i-167
* More Options

Page Sizing & Handiing @®

o G

@ Fit
() Actual size
() Shrink oversized pages

[ Choose paper source by PDF page size

(O Custom Scale:

Orientation:

() Auto portrait/landscape
@) Portrait

O Landscape

Page Setup...

[5) Bookiet

[ Print in grayscale (black and white)

Comments & Forms

Document and Markups
Summarize Commente

Scale: 97%
8.27x11.69 Inches

Page 1 of 175

Print

Print a document with the correct colors

Cancel
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3. Adjust the color settings in the driver properties window. Click the Properties button in the Print dialog and
set the Color option in the Color tab. Check the box Printer Managed Colors and, if you have a V4 driver,
select the most convenient source profile. Click OK.

Printer | HP Designlet T1700dr
Copies: |1 :

Pages to Print
Al
() Cusmrent page

V ] e @

[ Print in grayscale (black and whize)

Comments & Forms
Dacurnent and Markups >

Semmarnize Camments

CiPages |12 167
» Mare Opticns

Page Sizing & Handling [

[ size 3 Pester

OF&
8 HP Designle

Paper/Quaity Enlzpe Services  Advanced rere

Cuick s=bs:
Factory defaults

Color Opfons

@ Printin color

CIPrintin grayscale
(Pt in pure black and white

Color management:
() Apphcation managed colors

‘] Priler managed colrs

Decument: 8.3 % 11.7in
82727160 Inches

[E] Multiple [5] Beokiet |

~ S Dilmtn

Fage 1 of 175

Print Cancel

4.  If youhave a V3 driver, click the Advanced button in the Print dialog box to set color management options.
Check the box Let printer determine colors.

Printer: HP DesignJet T1700dr
Copies: 1 =
Pages to Print

@ AN
(O Current page

» More Options

() Pages

Page Sizing & Handling @
(®) Fit

() Actual size

() Shrink oversized pages
() Custom Scale:

I! 00

[[] Choose paper source by PDF page !
Orientation:

(O Auto portrait/landscape

(®) Portrait

() Landscape

Page Setup...

~ Properties Advanced Help
[1Print in grayscale (black and white)
PostScript Options E et
ments
Send by Range
VInches
Download Asian Fonts
[ Discolared background correction
Color Management
[] Let printer determine colors = Ceniguet im0 Fner Seten
T % a5 K-only grays L
ve Black
Preserve CMYK Primaries
[IPrint As Image
[] Simulate Overprinting
[]Print to File
OK Cancel
T L 2
Page 1of 175
Print Cancel

e

5. If the document contains several color profiles and you are not sure what the result will be, you can flatten

the document first and print it as seen on the screen. To do this, check the box Print As Image in the

Advanced Print Setup dialog box. In this case, the rasterization is performed by Acrobat Reader before
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Using Adobe Acrobat Pro

calling the driver; whereas, if you do not check this box, the rasterization is performed by the driver. So
checking the box may have a visible effect on the look of the printed document.

Acrobat Pro is a professional application that allows full color management. This section briefly describes the
options to select a working color space, convert images to a desired color space, and print.

1.

ENWW

PDF files may not contain a color profile. In the absence of a color profile, Acrobat uses a working color
space by default. To choose a working color space, first click Edit > Preferences.

@ HP Designlet T1700 Printer Series User Guide - Adobe Acrobat Pro

File [[ETY View Window Help

=

P e | ecozhlERE

dr only)

® &=

= Undo CtrlsZ
~| Redo ShiftsCtrl+Z
Cut Crl+X
Copy Ctrl+C
Paste Ctrl+V
Delete
Select All Cri+A
Deselect All Shifts Ctrl+ A
Copy File to Clipboard
Edit Text & Images
ke a Snapshot
Check Spelling v
Look Up Selected Word...
(), Find Ctrl+F
Advanced Search Shift+Ctrl+F

|g|ation

P Handling ink cartridges and printheads|

g Maintaining the printer

[P Accessaries

P Troubleshooting paper issues

@ HP Desii

User Guid

In the Preferences dialog box, you can choose RGB, CMYK, and grayscale working color spaces.

Categories:

Commenting
Documents

Full Screen
General
Page Display

3D & Muktimedia
Accessibility

Action Wizard

Adobe Online Services
Catalog

Color Management
Content Editing
Convert From PDF
Convert To PDF

Email Accounts
Forms

Identity

Internet

JavaScript

Language

Measuring (2D)
Measuring (3D)
Measuring (Geo)
Muttimedia (legacy)
Muttimedia Trust (legacy)
Reading

Reviewing

Search

Color Setup

@

Settings:

Synchronized: Your Creative Suite applications are synchronized using the same color settings for consistent color management.

North America General Purpose 2

>

Grayscale:

Working Spaces

RGB: | sRGB IEC61966-2.1

CMYK: | U.5. Web Coated (SWOP) v2

Dot Gain 20%

Conversion Optiens

Engine: | Adobe (ACE) ~

Use black point compensation

Description

oK Cancel
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3.  PDF files can contain elements with different color profiles. Some may have color profiles, some may not.
The working color space will affect only those without a color profile. If you want to attach a specific color
profile to the document, you must convert the contents of the document as follows. First, select Convert
Colors from View > Tools > Print Production or by clicking the icon in the status bar.

E HP DesignJet T1700 Printer Series User Guide - Adobe Acrobat Pro - o X
ES) opfftontn PO EE| e ET customize - | [
O e | ) [oo% : | = B Tools | Fill&Sign | Comment
» |
5

Zeom

= » Content Editing

| . » Pages
ol | ContentEditing
Fill & Sign Pages » Interactive Objects
Comment *| Interactive Objects » Forms
Show/Hide »| Eoms » Action Wizard
# Reag Mode g || e » Text Recognition

x: Jext Recognition -

{2 Eull Screen Mode Ctrl+L 2 » Protection

=  Protection - -

B Tracker... Document Processing ~ Print Production
Read Out Loud 0 1] B Prefight
Compare Documents... JayaScript

Bccesibility ik Output Preview
Analyze R it opject
[®] Flottener Preview
HP DesignJet T1700 Printer Series More Poduction
I (B setPage Boxes
[8) Add printer Marks
4 [ FoxHaiines
User Guide
ink Manager
& inkManag
] Trap Presets
[ Acrobat Distitier

4.  Select the elements you want to convert by specifying matching criteria (object type and/or color type) and
then the conversion attributes. If you want to change the embedded color profile, you can select Any Object
and Any Colorspace in the Matching Criteria section. In the Conversion Attributes section you can choose, for
example, to embed an Adobe RGB (1998) profile by selecting it as the Conversion Profile, checking the
Embed box, clicking the OK button, and saving the file to keep the changes. The saved file will have an
embedded Adobe RGB color profile.

X
Conversion Commands Document Colors
Any Object, Any Colorspace, Convert to Profile Movelp Add @
Move Down Delete
Save Commands Load Commands
Matching Criteria Conversion Attributes
Object Type: Any Object v Convert Command: Convertto Profile -
ColorType: | Any Colorspace - SR T Adobe RGB (1998) | HEmbed
Minimum Text Size: Rendering Intent: Use Dacument Intent -
Output Intent
Convert Colars to Output Intent Profile | U.S. Web Coated (SWOP) v2
Convert Options
[ Preserve Black [ Promate Gray to CMYK Black [ Preserve CMYK Primaries
Convert Pages
@Al O Current Page OFrom: 1 To: i
Ink Manager oK Cancel

5. To print the document, choose a printer from the Print dialog box, click the Properties button, and set the
color options in the Color tab.

@f IMPORTANT:  Select Print in color and Printer managed colors.

If you use the V4 driver, you can also select a default color profile, which will be used for any elements that
lack a color profile. HP suggests:
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6.

7.

e  sRGB or Adobe RGB (sRGB is the standard for most files)

e  (MVYK: Choose Coated FOGRA39 or US Web Coated (SWOP) v2.

L.
|

Paper/Quality Layout/Output Color  Job Storage Services Advanced

|
Quick sets:

Factory defaults

|
{
{  Color Options
{

(®) Print in color

(O Print in grayscale
(O Print in pure black and white

@

If you have a V3 driver, click the Advanced button in the Print dialog box, set Color Handling to Printer Color

Color management:

() Application managed colors

(®) Printer managed colors

Management, and click OK.

Printer: HP Designlet T1700dr

Copies: 1 e

Pages to Print
@Al
(O Current page

hd Save Delete

Help

oK Cancel

Print in grayscale (black and white)

Comments & Forms

Document and Markups

Opages  |i-
» More Optiony

Page Sizing & Hi

Size

@® Fit

(O Actual size
(O Shrink oversiz¢
O Custom Scalef
[ Cheose paper
Orientation:

(®) Auto portrait/|

(O Pertrait
(O Landscape

Page Setup..

Settings: | Custom

Printer:  HP Designlet T1700dr

Summarize Cnmments

~ Delete Save As

175

[ Print te File Print As Image

Cancel

Color Management

Color Handling:  Printer Color Management

Output
Marks and Bleeds
PostScript Options

mn or Management

() eome——

e

Color Profile:

Output Color:  Composite
Treat grays as K-only grays
Preserve Black

Preserve CMVK Primaries

Apply output preview settings

In the Print dialog box, click the Print button to print the document.

Using Adobe Photoshop

ENWW

1.

In Photoshop, click File > Print, then select your printer.

Print a document with the correct colors
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2.

3.

In the Color Management section, set the Color Handling option to Printer Manages Colors.

21.59 cm x 27.94 cm Printer Setup

Printer: ‘ ~

Copies: Print Settings...
Layout: [g] [&)

¥ Color Management ~

Remember to enable the printer’s color
management in the print settings dialog box.

Color Handling: ‘ Printer Manages Colors Vl

Printer Profile:  sGray

Mormal Printing
Rendering Intent: | Perceptual w

Black Point Compensation

¥ Description

¥ Position and Size
Paosition

Clcenter 1op:[7e1 ] 1o 255 ]

v
Sralad Drint Siza

Match Print Colors Gamut Warning Show Paper White
Gnce | [ oong

In the driver’s Color tab, ensure that the color management option is Printer managed colors. This is the

correct option because you have already selected Printer Manages Colors in Photoshop.

Print a project

This section demonstrates how to print a project from AutoCAD.

Using Autodesk AutoCAD

1. The AutoCAD window can show a model or layout. Normally a layout is printed rather than the model.

SN 571~ Tvpe a command
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Click the Plot icon at the top of the window.

Parametric

+
- b Move

& - % Co
Line Polyline Circle (O

c
T J§ - [ Stretch F Scale

Drawing2*

3. The Plot window opens.

You can see further options by clicking the circular button in the lower right corner of the window.

A Plot x
Page setup

Name: <None>

Printer plotter
Name: Properties...
Plotter:

Where: File

Description:

Plot to file

Paper size Number of copies
ANST expand A (3.50 x 11,00 Inches) v 1 =

Plotarea Plot scale
What to plot: [AIFit to paper
Extents ~

Scale: |Custom

Plot offset {origin set to printable area)

X: | 1.175375 inches  []Center the plot
y: |0.000000 | inch Scale [neweights

Preview... Apply to Layout Cancel Help

[%f NOTE: The Quality option here does not refer to the final print quality but to the quality of AutoCAD
viewport objects that are sent for printing.

1 inches  ~

315.9

5. Select your printer and click the Properties button.
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6.  Select the Device and Document Settings tab, and click the Custom Properties button.

A

Page setup

Name: <None>

Printer fplotter &

Name: S HP Design

Plotter: HP Designlet T!

General Pots  Device and Document Setiings

Where: EMEA /BarcelonZ

Description:

[CPlot to file

Paper sige

Oversize: Letter (portrait)

Plot area

© HP Designlel T1700dr
£ Media
I Source and Size <Size: Oversize: Letter [portrait)s
1 £F Media Destination <Defaults
- Graphics
&4 Custom Properties
g Lﬁ User-defined Paper Sizes & Caltration
Custom Paper Sizes
Modify Standard Paper Sizes [Printable Area)
Filter Paper Sizes
Plotter Calibration
= PMP File Name <Hones

What to plot:

Extents ~

Plot offset (origin set to printa

X | 1175375 | inches
y. |0.000000 | inch

Preview... Apply to

7. Inthe Paper/Quality or Paper tab, select the paper type that you intend to use.

Access Custom Dialog

Fiess the folloing button ta access the
devics diiver-specilic user nterface.

=

Custom Propertiss.

Impart... Save ds.. Defaults

oK Cancel Help

[%f NOTE: If you select neither the paper source nor the paper type, the printer will not print on any protected

roll (see Protect

a paper type on page 62).

8.  Select the print quality (your own choice between speed and quality of printing).

9. Ifyouintend to print on roll paper, you must decide where the printer should cut the paper.

e With a Windows V3 driver: Click the Paper/Quality tab, then the Margins/Cutter Settings button, and

select Clip

content by margins.

e  With a Windows V4 driver: Click the Layout tab; then, in the Layout Mode area, select With margins >
Clip content by margins.

You can also adjust the crop lines, which indicated where to cut the paper after printing.

Layout and margins:

® O

Use application settings

Respect settings defined previously | Content within printer margin not
in application printed

Preserve paper size

(o]
Clip contents by margins Oversize
Add the printer margin on four
document edges
I h

W - - - -

v

v

x

Cutter

Adjust

[“Horizontal cutter
[Iremove blank areas
[C]braw cutting lines

OK

Cancel

10. Select the Layout/Output tab, then select the Autorotate option. Autorotation can help to avoid wasting

paper.

11. Click the OK button and save your configuration changes to a PC3 file.

94  Chapter 9 Practical printing examples

ENWW



12. When you have clicked the OK button in the Plot window, the printer will construct a print preview.

Plot Job Progress 1

How Pracessing Sheek: Layoutt (tower.dwg - Read Onl) ‘ﬂ
Status: < Regenerating shest » o
Progress:

Using clip contents by margins

You can select this margins option from Advanced settings > Paper > Layout/Margins > Print with margins >
Layout > Clip contents by margins.

Use this option when the contents to be printed have white borders and a size equal to that of the paper you
have selected. The printer will use the white border for its margins and you will get a page of size equal to that
which is selected in the driver.

Print a presentation

This section demonstrates how to print a presentation from AutoCAD and from Photoshop.

Using Autodesk AutoCAD

1. Openthe AutoCAD file and select a layout.

EREN 50|~ Tvpe a command

ENWW Print a presentation
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Click the Plot icon at the top of the window.

Line Polyline Circle

Draw «

Drawingl

Parametric anage  Output

— - S Move () Rotate
~ O Copy d Mirror
~ A stretch g1 Scale

Modify +

. @
T

Drawing2*

Ensure that the correct printer is selected, then click the Properties button.

Select the Device and Document Settings tab, and click the Custom Properties button.

A plot
Page setup

Name: <None>

Add...

Printer fplotter
Name: & HP Design
Plotter: HP Designlet T!
Where: EMEA /Barcelong

Description:

[IFiot to file

Paper size
Oversize: Letter {portrait)
Plotarea

What to plot:
Extents

Plot offset (origin set to printa

& Plotter Configuration Editor - HP Designlet T1700d

General Pots  Devise and Document Settings

[0\ Source and Size <Size: Oversize: Latter [portrait]>
£ Medis Destination <Default>

8, Custom Propertiss
[e.? User-defined Paper Sizes & Calibration
Custom Paper Sizes
Modify Standard Paper Sizes [Printable drea]
Fiter Paper Sizes
Plotter Calibration
= PMP File Name <None>

Access Custom Dislog

Press the following button to access the
device diver-specific user-interface.

% | 1175375 | inches Eg
y. |0.000000 | inch Custom Praperties...
Breview... Apply to
Impart Save s Defaults
oK Cancel Help

5. Inthe Paper/Quality tab, select the paper type that you intend to use.

[1?? NOTE: If you select neither the paper source nor the paper type, the printer will not print on any protected
roll (see Protect a paper type on page 62).

Select the print quality (your own choice between speed and quality of printing).

If you intend to print on roll paper, you must decide where the printer should cut the paper.
e With a Windows V3 driver: Click the Paper/Quality tab, then the Margins/Cutter Settings button, and
select Clip content by margins.

e  With a Windows V4 driver: Click the Layout tab; then, in the Layout Mode area, select With margins >

Clip content by margins.
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Layout and margins:

Preserve paper size

®

o]

O

Use application settings

Respect settings defined previously
in application

clip contents by margins

Content within printer margin not
printed

Oversize

Add the printer margin on four
document cdges

L [ ]
x _________

v v

x Vs

x

Cutter
Adjust

Herizontal cutter
[CJRemove blank areas
[ oraw cutting lines

oK

Cancel

8.  Select the Layout/Output tab, then select the Autorotate option. Autorotation can help to avoid wasting

paper.

9.  Click the OK button and save your configuration changes to a PC3 file.

10. When you have clicked the OK button in the Plot window, the printer will construct a print preview.

Plot Job Progress N

How Processing Sheet: Layout1 (tower.dwg - Read Only)

Status: < Regenerating sheet >

Progress:

“

[ ]

Using Adobe Photoshop

1. InPhotoshop, click File > Print and then select your printer.

ENWW

Print a presentation
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2. Click Print settings, then select the Paper/quality tab.

80 HP Designlet T1700dr Properties
Paper/Quality ) ayout/Output Color  Job Storage  Services Advanced
Quick sets:

Factory defaults

Paper Options

Printer Setup

Printer: | HP Designlet T1700dr

Copies: - Print Settings... |
Layout: B]

¥ Color Management

Remember to enable the printer’s color
management in the print settings dialog box.

° file: Untagged RGE

g: ‘ Printer Manages Colors

le: | CIE RGB
Printing
ntent: | Relative Colorimetric =

int Compensation

Delete

| Document size:

A4 v gustom...

Margins/Cutter: Settings...

Layout Options: Use application settings, Horizantal
cutter

# | currently loaded paper:

Roll 1: Plain paper, 1066.80 mm
Single sheet: Not loaded

Cance\| | Dong. | | Print

Print Quality
(®) Standard options
Paper source: speed Quaity
‘ Use printer settings - ‘
(O Custom options Settings...
Paper type:
‘ Use printer settings v‘ Rendering resolution (ppi): 600
Printing resolution (dpi): Automatic
@ La
OK Cancel

3. Choose from the available paper sizes.

If you do not find the paper size that you intend to use, click the Custom button. Enter the width, the length
and the name of your custom paper size. Click the Save and OK buttons.

rCustmsize I M‘
o e
Milimeters
Size
Width: 8.27 (3.00 - 40.00)
Length: 1169 (5.51-7874.02)
[ Cancel -
4.  Select Show preview before printing. You may also wish to change the default paper source, paper type and
print quality.
5.

In the Color tab, the default color management option is Printer managed colors, and this is the correct
option because you have already selected Printer Manages Colors in Photoshop.

Print and scale from Microsoft Office

This section demonstrates how to print and scale from Microsoft Office 2013.

Using Microsoft PowerPoint

1. Click File > Print, and select the name of your printer.
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©

New

Open

Save

Save As

Save as Adobe
PDF

Print

Share

Export

Close

Account

Options

Feedback

Printer

HP Designlet T1700dr

= Offline: 1 document waiti

ng

Printer Properties

Settings
=

Print All Slides

Print entire presentation

Full Page Slides
Print 1 slide per page
Collated

123 123 123

Color

Edit Header & Footer

To clip contents by margins:

select Clip content by margins.

Clip content by margins.

Layout and cutter options

Layout and margins:

Preserve paper size

O]

@]

o]

Use application settings

Respect settings defined previously
in application

Clip contents by margins

Content within printer margin not
printed

Oversize

dd the printer margin on four
document edges

L [ ]
x ,,,,,,,,,

v v

x v

x

Cutter

Adjust

Horizontal cutter
[JRemove blank areas
[] Draw cutting lines

Click Printer properties > Layout/Output > Resizing options to scale the document to a particular size.

Select the Paper/Quality tab, then select Paper Source and Paper Type.

With a Windows V3 driver: Click the Paper/Quality tab, then the Margins/Cutter Settings button, and

With a Windows V4 driver: Click the Layout tab; then, in the Layout Mode area, select With margins >

OK Cancel

Using Microsoft Project

1. Click File > Print.

2. Select your printer's name.

ENWW

Print and scale from Microsoft Office 99



3. Inthe Settings section, you can choose the pages to print, the orientation, and the paper size.

©

Print

N =

e = Copies: |1 =

Open =

Print
Save
Save As Printer
HP DesignJet T1700dr

Save as Adobe == fend 9 -
PDF eacy

Printer Properties
Print

Settings
Share Print Entire Project
= v

Print the project from start to finish

Expart

Dates: [10/31/2017 ~ o [1/2272018 -
Closs Pages: |1 2 o 3 :

=Y Landscape Orentation -
Account

D A4
Dptoes 827" x 11.69"

Page Setup

4.  Click Page Setup to choose the Paper Size you want.

ge Setu s
Page | Margins | Header| Footer | Legend| view |

Orientation

O Portrait (® Landscape

Sealing

(® Adjustto: | 100 |-> % normal size

O Fitto: |1 2 pageswide by |1 = tall

Other

Paper Size: [ A4 -

First page number: | Auto

Print Preview... Options... Print. Cancel

5. Select Options to go to the printer driver.

Page | Margins| Header| Footer | Legend| view |

Orientation
() Portrait (®) Landscape
Sealing

Adjust to: 2+ % normal size
Adjustto: | 100 % I
OFitte: |1 S pageswideby |1 < tall

Other

Paper Sige: | A4 v

First page number: | Auto

Print Preview... Print. oK Cancel

The default options in the Paper/Quality tab are probably suitable: Paper source: Use printer settings and
Paper Type: Use Printer Settings.

6.  Click Layout/Output > Resizing options to scale the document to a particular size. Alternatively, you can
scale the document in Project.
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Using Microsoft Excel

1.
2.

ENWW

Click File > Print. Select your printer's name, then click the back arrow to leave the File menu.

Select the Page Layout tab, then Size, and choose the paper size you want.

Page Layout

gins Onentatmn

fe

Formulas Data Review

a2 4]
42 cmx 594 cm

ARCH A
22,86 cm x 3048 cm

ARCH B
3048 cmx 4572 cm

ARCH C
4572 cm x 60.96 cm

ARCHD
50,96 cm x 91.44 cm

ARCHE
9144 cmx121.92 cm

ARCH E1
76.2 cm x 106,68 cm

ARCH E2
66,04 cm x96.52 cm

ARCH E3
68,58 cm x 99.06 cm

Al

594 cm x 84.1 cm
A0

841 cmx118.88 cm

AS_P
148 tmx 21 cm

IMore Paper Sizes...

n

a

| E—T—

View

) [

S\ZE Prmt Breaks Background Print

Titles

F]

Click File > Print > Printer properties to go to the printer driver. In the Paper/Quality tab, select Paper source,
Paper Type and Print Quality.

Click Layout/Output > Resizing options to scale the document to a particular size. Alternatively, you can
scale the document in Excel.
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10 Retrieving printer usage information

Get printer accounting information

There are different ways of getting accounting information from your printer.

e \View printer usage statistics for the whole lifetime of the printer, see Check usage statistics on page 102.

e \iewink and paper usage for each of your recent jobs, see Check usage statistics for a job on page 105.

e  Use athird-party application to request printer status, printer usage or job accounting data from the printer
through the Internet. The printer provides data in XML to the application whenever requested. HP provides
a Software Development Kit to facilitate the development of such applications.

Check usage statistics
Check usage from the front panel

Tap @ on the front panel to display the usage information.

Print categories usage | Ink | Paper

Ink usage A
Paper area usage A
Paper length usage A

The following information can be retrieved:

e Inthe tab Print categories usage, you can see the ink, paper area, and paper length usage divided into
categories:

—  Mono lines: Between 0% and 10% of non-white pixel coverage, printed on standard paper, with less
than 1% of color pixel coverage

—  Color lines: Between 0% and 10% of non-white pixel coverage, printed on standard paper, with more
than 1% of color pixel coverage

—  Low density image: Between 10% and 50% of non-white pixel coverage printed on standard paper

—  High density image: Over 50% of non-white pixel coverage printed on standard paper
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—  Blueprint: Any content type printed on blueprint paper
—  Premium guality image: Any content type printed on premium paper

e Ink usage displays the ink consumed in milliliters, by category, and the total amount.

CATEGORY INK (ML)
Mono lines 0.92
Color lines 1.93
Low density image 0.86
High density image 431.09 @
Rliianrint n

e  Paper area usage displays the paper area usage in English or metric units of area, by category, and the total

amount.
CATEGORY USED (M2)
Mono lines 0.22
Color lines 3.16
Low density image 0.51
High density image 17.45 @
Rluienrint n

e  Paper length usage displays the paper usage in English or metric units of length, by category, and the total

amount.
CATEGORY LENGTH (M)
Mono lines 0.2
Color lines 2.76
Low density image 0.46
High density image 15.12 @
Rlienrint n
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e  TheInk tab displays the ink consumed by each cartridge in milliliters, and the total amount of ink

consumed.
Print categories usage | Ink | Paper
Ink usage A
Paper area usage A
Paper length usage A

e  The Paper tab displays the amount of paper used and the total at the top, divided into paper categories or
families.

Usage can be seen at each level.

Print categories usage | Ink Paper

PAPER TYPE PAPER AREA (M)  PAPER LENGTH (M)

g:::r"“d e 3231 29.92
Plain Paper 14.90 13.74
Coated Paper 6.48 5.99

HP Coated Paper 6.90 @

When you tap @ , @ message is displayed: The usage report was sent to the job queue and will be printed
soon.

All the values can be displayed in English or metric units.

Print the usage information

There are two different ways to print the usage information from the front panel's home screen:

e Tap % to launch the usage information screen, then tap the Print usage report button.

e Tap @ then Internal prints > User information prints > Print usage report.

Check usage from the Embedded Web Server
The same information can be retrieved from the Embedded Web Server as from the front panel.

1. Access the Embedded Web Server, see Embedded Web Server on page 14.

2. Inthe menu at the side, click Usage.
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The usage page shows all the printer usage information separated into various tables:
e  Summary: The total ink usage and the total paper usage (in units of area and length).

e  Print categories usage: The ink and paper usage and the number or pages printed for the different print
categories (content type, such as mono lines, color lines, premium quality image, blueprint paper). This
table information is shown only if the Show application categories printer setting is enabled. There are
further conditions depending on the following settings:

—  The paper printed usage is shown if the Paper area used and paper area printed setting is enabled.
—  The blueprint category is shown if the Enable the blueprint category setting is enabled.

—  The premium guality image category is only shown if the Enable the premium quality image category
setting is enabled.

—  If the printed-paper column information is shown, the paper area used field changes the string to
"Paper area (m2 used)". Otherwise, the string shown is "Paper area (m?)".

e Inkusage: The ink usage for the whole life of the printer (with approximate values). The ink consumption
table lists the ink consumed in each color, ignoring the product number of the cartridge.

e  Paper usage: All the papers that have been used throughout the life of the printer.

Check usage statistics for a job

[:?’”r NOTE: The accuracy of the usage statistics is not guaranteed.

1. Access the Embedded Web Server, see Embedded Web Server on page 14.

2. Inthe menu at the side, click Usage > Accounting.

The accounting page shows a table of the latest printed jobs, with the following information per job (not per
page):

e Name: The name of the job

The job name is shown only if the Show user name and job name in job accounting setting is enabled for
users under Security > Security settings.
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fit Homs ~
Mass storage

Job queue

USE drives [ ]
) Ink v
© Paper 4 Protect stored data
B Usage v

Secure Tile erase mode Non-Secure Mode ~
& Security ~

Administrator password

Security settings
Printer settings

Access Control

Show user name and job name

@ About printer ~ in job accounting

Network v
Anonymous usage information 9
@ Support v

~

e  Number: The number of the job
e  Time: The date and time when the job was completed

e  User: The name entered by the person who submitted the job (this item is present only if the corresponding
security setting is enabled)

The user name is shown only if the Show user name and job name in job accounting setting is enabled for
users under Security > Security settings.

e  Type: The type of job (print)

e  Source: The source of the job: USB, network, and so on

e  Print quality: The print quality used to print the job

e  Copies: The number of copies requested (cumulative after reprints)
e  Pages: The number of pages completed

e  Status: The status of the job: printed, canceled by user, and so on

e  Total cost: The total cost of the job (visible if cost assignment is enabled)
e  Paper type: The paper type used for the job

e  Paper area: The used paper area of the job

e  Paper length: The used paper length of the job

e Inkused: The volume of ink consumed by the job

Ajobis considered completed when all its pages have been printed, or canceled by the user, or canceled by the
printer itself. An ongoing job (waiting for printing, being printed, being canceled, on hold for preview, and so on)
will not appear on this list.

You can filter the jobs shown on the accounting page by using a drop-down control available on the same page.
This control just changes the view, the job accounting information is not deleted in the printer. Essentially, this
page will report the last N jobs (or fewer if there are not enough completed jobs), where N is the value of this
configuration parameter. By default, Nis 10.
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Two buttons appear in the accounting table:
e  Help: This button opens a window displaying help information.

e  Export to CSV: This button opens a window with a progress bar, and generates and downloads a CSV file.
The downloaded file contains similar information to the accounting page, in CSV format. If the cost
assignment is enabled, the CSV displays more detailed information about the cost of the job.

Check cost assignment

' NOTE:  The accuracy of the usage statistics is not guaranteed.

1. Access the Embedded Web Server, see Embedded Web Server on page 14.

2. Gotothe Main tab.
3. Click Usage > Cost assignment configuration.

The cost assignment page allows you to enable or disable the cost assignment setting, using the checkbox next
to Enable accounting assignment configuration at the top of the page. If the setting is enabled, you can insert or
maodify the cost of the following sections.

[:?’”r NOTE: At least one of these sections must be enabled in order to save the configuration.

e  Units
—  Currency: Enter any three-letter currency code.
—  Paper usage: Select the units, English or metric.

e  Print categories cost: Can be enabled or disabled. When enabled, you can assign a cost to each category,
and select the units of the cost (per millimeter, or the option selected in the previous Units section). The
cost is a number with two decimal digits of precision. Disabled categories are displayed grayed out.

e Inkusage cost: Can be enabled or disabled. Allows you to apply a cost to ink usage, and displays the
available inks with a field to indicate the cost.

e  Paper usage cost: Can be enabled or disabled. Allows you to apply a cost to the papers displayed. You can
add papers from the list of supported papers. The costs can be removed or edited; they cannot be empty,
but may be 0 (zero). The units selection is the same as for print categories.

° Fixed cost: Can be enabled or disabled. Allows you to add a fixed cost to all print, scan, and copy jobs.

Enabling the cost assignment setting causes the total cost column to appear in the accounting information, and
detailed information is added to the exported CSV.
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11 Handling ink cartridges and printheads

e  About theink cartridges

e  (heck theink cartridges status

° Remove an ink cartridge

° Insert an ink cartridge

e  About the printheads

° Check the printhead status

° Remove a printhead

° nsert a printhead

e  Safe mode
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About the ink cartridges

Ink cartridges store the ink and are connected to the printheads, which distribute the ink on the paper. To
purchase additional cartridges, see Accessories on page 124.

A CAUTION:  Observe precautions when handling ink cartridges because they are ESD-sensitive devices (see the
Glossary on page 175). Avoid touching pins, leads and circuitry.

E;? NOTE: Dynamic security enabled printer. Only intended to be used with cartridges using an HP original chip.
Cartridges using a non-HP chip may not work, and those that work today may not work in the future. More at:
http://www.hp.com/go/learnaboutsupplies.

99

B NOTE: This printer is not designed to use continuous ink systems. To resume printing, remove any continuous
ink system and install genuine HP (or compatible) ink cartridges.

E;? NOTE: This printer is designed for ink cartridges to be used until they are empty. Refilling cartridges prior to
depletion might cause your printer to fail. I this happens, insert a new cartridge (either genuine HP or
compatible) to continue printing.

Check the ink cartridges status

To view the ink levels of your ink cartridges, tap @ on the front panel, then tap the cartridge on which you

want information. There is a Replace ink cartridges option on the ink information page in case you want to do so
(see also Remove an ink cartridge on page 109).

To get more information on your ink cartridges, you can tap the color of the cartridge on which you want
information.

You can also get this information from the HP DesignJet Utility.

For an explanation of the ink cartridge status messages, see Ink cartridge status messages on page 156.

HP DesignJet Utility procedures

e Inthe HP DesignJet Utility for Windows, go to the Overview tab, each cartridge's status is under Supplies
Status > Cartridges.

e Inthe HP DesignJet Utility for Mac OS X, select Supplies Status in the Information group.

Remove an ink cartridge

There are two occasions when you need to remove an ink cartridge.

e  Theink cartridge is very low and you want to replace it with a full cartridge for unattended printing (you can
use up the remaining ink in the first cartridge at a more convenient time).

e Theink cartridge is empty or faulty, and you must replace it to continue printing.

A CAUTION: Do not try to remove an ink cartridge while printing.
CAUTION:  Remove anink cartridge only if you are ready to insert another one.

CAUTION:  Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer from
moving.

[f’g'/”f NOTE: When a cartridge runs out of ink, the current job is not automatically canceled: unless you cancel it
manually, it will resume printing when the empty cartridge has been replaced. If there is a delay in replacing the
cartridge, you may see some banding effect on the print.
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1. From the front panel, tap , then e,then Replace ink cartridges.

2. Opentheink cartridge cover on the right-hand side of the printer.

3.  Grip the cartridge you wish to remove.

4.  Pull the cartridge straight up.

E?q”f NOTE: Avoid touching the end of the cartridge that is inserted into the printer, as there may be ink on the
connection.

B NOTE:  Avoid storing partially used ink cartridges.

5. The front-panel display identifies the missing ink cartridge.

Insert an ink cartridge

1. Before removing the cartridge from its wrapping, shake it vigorously.

2. Unwrap the new ink cartridge, find the label identifying the ink color. Check that the letter or letters (for
example, M for magenta) marking the empty slot, matches the letter or letters on the cartridge label.
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3.

4.

5.

6.

Insert the ink cartridge into its slot.

If you have difficulty, see Cannot insert an ink cartridge on page 156.

When all cartridges have been inserted, close the cover.

The front-panel display confirms that all cartridges have been correctly inserted.

Use of refilled or altered cartridges

HP recommends that you replace the empty cartridge with a new HP cartridge. See Accessories on page 124,
Remove an ink cartridge on page 109, and Insert an ink cartridge on page 110.

The use of refilled or altered ink cartridges has several serious disadvantages:

ENWW

There is some risk of damaging the printer. In this case the printer warranty will not be valid for any printer
repairs that are related to the cartridge, nor for any problems due to ink contamination.

You will invalidate the warranty of all printheads of the same color used in the printer subsequently.
Print quality may be impaired.

The printer will be unable to estimate the ink level in the cartridge, and will not report it.
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To force the printer to accept a cartridge, you can tap , , , on the front panel.

1. Install the cartridge in the printer (see Insert an ink cartridge on page 110).

2. The front panel notifies you that the cartridge is altered, and the cartridge removal process will start. If you
believe that you purchased a non-Original HP cartridge, HP recommends that you abort the process. To
check the authenticity of your cartridges, see http://www.hp.com/go/anticounterfeit.

3. If you proceed, the front panel displays a series of warning messages.

[%f NOTE: The printer detects cartridges that are non-Original HP. The printer is only intended to be used with
cartridges using an HP original chip. Cartridges using a non-HP chip may not work, and those that work today
may not work in the future. More at: http://www.hp.com/go/learnaboutsupplies.

When the process is finished, the front panel will give the usual ink cartridge display but the cartridge will not
report the ink level.

About the printheads

The printheads are connected to the ink cartridges and jet ink onto the paper.

A CAUTION: Observe precautions when handling printheads because they are ESD-sensitive devices (see the
Glossary on page 175). Avoid touching pins, leads and circuitry.

Check the printhead status

The printer automatically checks and services the printheads after each print. Follow the steps below to get more
information on your printheads.

1. From the front panel, tap @ then tap the printhead on which you want information.

2. The front panel displays:
e  (olors
e  Product name
e  Product number
e  Serial number

° Status, see Front-panel error messages on page 167

e  Volume of ink it has used
e  Warranty status

You can also get most of this information from the HP DesignJet Utility. In the HP DesignJet Utility for Windows,
go to the Overview tab, then the Supplies tab.

For an explanation of the printhead status messages, see Printhead status messages on page 162.

If the warranty status is See warranty note, this indicates that non-HP ink is being used. See the Legal
Information document provided with your printer for details of the warranty implications.
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Remove a printhead

A CAUTION:  Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer from
moving.

A CAUTION:  Printhead replacement must be performed with the printer powered on.

1. From the front panel, tap @ then Printheads, then e,then Replace.

2. The printer moves the carriage into the correct position.

A CAUTION:  If the carriage is left in the removal position for more than three minutes without inserting or
removing any printheads, it tries to move back to its normal position in the right-hand end.

3. When the carriage has stopped moving, the front-panel display asks you to open the window.

4.  Locate the carriage on the right side of the printer.

5. Pull the handle up and toward you to release the wire loop.
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6. Push the handle back to raise the lid.

7. This gives you access to the printheads.

8.  Toremove a printhead, lift up the blue handle.

9. Using the blue handle, use steady force to disengage the printhead.
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10. Pull the blue handle upward until the printhead is released from the carriage.

A CAUTION: Do not pull abruptly because this can damage the printhead.

11. The front-panel display identifies the missing printhead.

Insert a printhead

@ NOTE: You cannot insert a new printhead successfully if either of the connected ink cartridges is empty, or
nearly empty. In this case, you should replace the ink cartridge before inserting the new printhead.

1. Remove the orange protective caps by pulling them down.
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2. The printhead is designed to be inserted into any of the available slots. Once the printhead is inserted into a
specific slot, it will be set up to work only with that combination of colors. For this reason, it is important to
mark the printhead with its specific color, on the label that comes with it, matching the color of the carriage
slot into which the printhead is to be inserted.

3. Insert the new printhead into its correct slot in the carriage.

A CAUTION: Insert the printhead slowly and vertically, straight down. It may be damaged if you insert it too
fast, or at an angle, or if you rotate it as you insert it.

4.

A CAUTION:  When installing the new printhead there may be some resistance, so you need to press it down
firmly but smoothly. You should hear a beep and see confirmation on the front-panel display that the
printhead has been inserted. If you have difficulty, see Cannot insert a printhead on page 156.
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5. Insert all other printheads that need to be installed, and close the carriage lid.

&

6.  Ensure that the end of the blue handle catches the wire loop on the near side of the carriage.

7. Lower the handle to rest on the carriage cover.

When all the printheads have been inserted correctly and are accepted by the printer, the printer beeps.

@7 NOTE: If the printer does not beep when you insert the printhead and the Replace message appears on
the front-panel display, the printhead may need to be reinserted.
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8.  (lose the window.

9.  The front-panel display confirms that all printheads are correctly inserted. The printer starts checking and
preparing the printheads. The default routine process, when all printheads are changed, takes 10 minutes.
If the printer finds problems in preparing the printheads, it takes longer, up to 45 minutes. For a single
printhead insertion, the times vary between 2 and 45 minutes. After all printheads are checked and
prepared, the printhead realignment procedure runs automatically if paper is loaded, see Align the
printheads on page 160.

10. You are recommended to perform a color calibration after inserting a new printhead. See Color calibration
on page 76.

Safe mode

Under certain conditions, including printer operation outside of environmental specifications, and when a used,
refilled, or counterfeit ink cartridge has been detected, the printer will operate in safe mode. HP is unable to
warrant the performance of the printing system when operated outside of environmental specifications or when
a used, refilled, or counterfeit ink cartridge is installed. Safe mode is designed to protect the printer and the
printheads from damage due to unexpected conditions, and is in operation when the icon is displayed on the
printer’s front panel and by the Embedded Web Server and HP Utility.

For optimal performance, use original HP ink cartridges. HP DesignJet printing systems, including original HP inks
and printheads, are designed and engineered together to provide uncompromising print quality, consistency,
performance, durability, and value—with every print.

[% NOTE: This printer is not designed to use continuous ink systems. To resume printing, remove the continuous
ink system and install genuine HP (or compatible) cartridges.

[%’ NOTE: This printer is designed for ink cartridges to be used until they are empty. Refilling cartridges prior to
depletion might cause your printer to fail. If this happens, insert a new cartridge (either genuine HP or
compatible) to continue printing.

[%’ NOTE: Dynamic security enabled printer. Only intended to be used with cartridges using an HP original chip.
Cartridges using a non-HP chip may not work, and those that work today may not work in the future. More at:
http://www.hp.com/go/learnaboutsupplies.
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Maintaining the printer

° Check printer status

° Clean the exterior of the printer

° Maintain the ink cartridges

° Move or store the printer

e  Update the firmware

° Update the software

° Printer maintenance kits

° Secure File Erase

e  Disk Wipe
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Check printer status

You can check the current status of the printer in the following ways:

e Ifyouaccess the Embedded Web Server, you see information about the general status of the printer. The
Supplies page in the Home tab describes the status of the paper and ink supplies.

e Atthe front panel, you can see information about paper, ink levels, ink cartridges, and printheads by
pressing the corresponding icon.

If there are any current alerts, the upper row of the home page shows the top-priority alert. Tap the alert
message to see a list of all current alerts, with an icon indicating the severity of each alert. You can tap an
individual alert to get help in solving the problem.

Clean the exterior of the printer

Clean the outside of the printer and all other parts of the printer that you regularly touch as part of normal
operation with a damp sponge or a soft cloth and a mild household cleaner such as non-abrasive liquid soap.

AWARNING! To avoid an electric shock, make sure that the printer is turned off and unplugged before you clean
it. Do not let water get inside the printer.

A CAUTION: Do not use abrasive cleaners on the printer.

Maintain the ink cartridges

During the normal lifetime of a cartridge, no specific maintenance is required. However, in order to maintain the
best print quality, replace a cartridge when it reaches its expiration date. The printer's front panel notifies you
when any cartridge reaches its expiration date.

You can also check a cartridge's expiration date at any time: see Check printer status on page 120.

See also Handling ink cartridges and printheads on page 108.

Move or store the printer

If you need to move the printer, prepare it correctly to avoid possible damage to it. To prepare the printer, follow
the instructions below.

1. Do not remove the ink cartridges or printheads.
2. Make sure that no paper is loaded.
3. Make sure that the printer is idle.

4.  Disconnect any cables connecting the printer to a network or computer.

A CAUTION: Before moving the printer through a doorway, remove the foot extensions if necessary, and make
sure to reassemble them before you set up the printer.
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If you need to leave the printer turned off for a long time, follow the additional steps below:

1. Turn off the power using the power key on the front panel.

2. Disconnect the printer's power cable.

A CAUTION: Do not turn the printer upside down: ink could escape from the service station and damage the
printer.

When reconnecting the power cable, remember to route the cable tidily along the back gutter. When the printer
is turned back on, it takes about three minutes to initialize itself and to check and prepare the printheads.
Preparing the printheads normally takes just over a minute. However, if the printer has been off for a six weeks or
more, preparing the printheads could take up to 45 minutes.

A CAUTION:  If the printer remains off for a long period of time, the printheads may become unusable. In this case,
you need to replace the printheads with new ones.

% TIP:  Because preparing and purging the printheads uses both time and ink, you are strongly recommended to
leave the printer always on or in sleep mode, whenever possible, to maintain the health of the printheads. In both
cases, the printer wakes up from time to time to maintain the printheads. Thus you can avoid going through
lengthy preparation processes before using your printer.

Update the firmware

The printer's various functions are controlled by firmware that resides in the printer.

From time to time firmware updates will be available from HP. These updates increase the printer's functionality,
enhance its features, and may correct minor problems.

M IMPORTANT:  You are strongly recommended to update the firmware periodically in order to take advantage of
the latest improvements.

There are various ways of downloading and installing firmware updates; you can choose whichever you find most
convenient. They can be divided into two categories: automatic and manual updates.

[?f> NOTE: The firmware includes a set of the most commonly used paper presets. Extra paper presets can be
downloaded separately; see Paper presets on page 33.
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Automatic firmware updates

Automatic firmware updates are a convenience that is possible with Web-connected printers. Your printer can
automatically download the latest firmware release, store it in the printer, and install it for you.

Important notes

Your printer must be connected to the Internet; see Set up printer services on page 17.

To configure automatic firmware updates, you can use the front panel or the Embedded Web Server; see
Configure firmware updates on page 19.

If an administrator password has been set, it will be required to change these settings.

A firmware update package can be large; you may want to consider whether there are any implications for
your network or Internet connection.

A firmware update is downloaded in the background: the printer can be printing at the same time. However,
it cannot be installed in the background: printing must stop, and installation is always a manual process.
You can install firmware at any time after the download has completed.

Manual firmware updates

Manual firmware updates can be performed in the following ways:

Using the Embedded Web Server, click About printer > Firmware update. Click Check now to check whether
new firmware is available. If new firmware is available, some information about the new firmware is
displayed, and you are given the opportunity to download and install it.

Using the HP DesignlJet Utility under Windows, select your printer, the Support tab and then Firmware
Update.

Using the HP DesignJet Utility under Mac 0OS X, select Firmware Update in the Support group.
Using HP Web Jetadmin, with which you can make manual firmware updates or request automatic updates.

Using a USB flash drive, which should be formatted as FAT32 and should be able to store at least 4 GB.
Download the firmware file from http://www.hp.com/go/T1700/firmware into the USB flash drive and
insert it into the Hi-Speed USB host port beside the front panel. A firmware update assistant will appear on
the front panel to guide you through the update process.

Update the software

To update printer drivers and other software for your printer, go to http://www.hp.com/qgo/T1700/drivers.

Additionally:

Under Windows, the HP DesignJet Utility may offer you automatic updates when restarted.

Under Mac 0S X, Apple SW Update offers you software updates when available.

Printer maintenance kits

Three maintenance kits are available for your printer, containing components that may need to be replaced after
long use. When one of them is needed, a message is displayed on the front panel and by the HP DesignJet Utility.

When you see the message, you should contact HP Support (see Contact HP Support on page 170) and request
the maintenance kit. The kits are installed by service engineers only.
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Secure File Erase

The printer's hard disk is used as a temporary storage area for print jobs. The Secure File Erase facility can
completely erase your information from the hard disk to protect it from unauthorized access. It begins to do so
as soon as you turn it on, but old temporary files that were already on the hard disk are not erased retroactively.
If you want to erase the old files too, see Disk Wipe on page 123.

Secure File Erase provides three different levels of security:

e  Non-Secure Mode: all pointers to the information are erased. The information itself remains on the hard
disk until the disk space it occupies is needed for other purposes, and it is then overwritten. While it remains
on the disk, it is difficult for most people to access, but may be accessed using software designed for the
purpose. This is the normal method in which files are erased on most computer systems; it is the fastest
method but the least secure.

e  Secure Fast Erase: all pointers to the information are erased, and the information itself is also overwritten
with a fixed character pattern. This method is slower than Non-Secure Mode, but more secure. It may still
be possible to access fragments of the erased information by using special tools to detect residual
magnetic traces.

e  Secure Sanitizing Erase: all pointers to the information are erased, and the information itself is repetitively
overwritten using an algorithm designed to eliminate any residual traces. This is the slowest method, but
the most secure. Secure Sanitizing Erase meets the US Department of Defense 5220-22.m requirements
for clearing and sanitization of disk media. This is the default security level when using Secure File Erase.

These settings can be changed from the Embedded Web Server (Security > Security settings). Secure File Erase
is one of the facilities provided by Web JetAdmin, which is HP's free Web-based print management software: see
http://www.hp.com/go/webjetadmin.

If you have difficulty in using Secure File Erase from Web JetAdmin, contact HP Support: see Contact HP Support
on page 170.

Disk Wipe

Disk Wipe is the same as Secure File Erase (see Secure File Erase on page 123), except that it erases all
temporary files, including old ones.

The Disk Wipe configuration can be changed from Web JetAdmin or the Embedded Web Server.

[% NOTE: If you choose to erase the whole hard disk, you may be asked to restart the printer several times during
the process, which will take about 6 hours with Secure Fast Erase or 24 hours with Secure Sanitizing Erase.
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13 Accessories

° How to order supplies and accessories

° Introduction to the accessories

° Disposal instructions
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How to order supplies and accessories

There are two alternative ways to order supplies or accessories for your printer:

e  \Visit http://www.hplfmedia.com on the Web.

e  (ontact HP Support (see Contact HP Support on page 170).

The rest of this chapter lists the available supplies and accessories, and their part numbers.

Order ink supplies

The following ink supplies can be ordered for your printer.

Ink cartridges

Cartridge Product number

HP 730 130-ml Cyan DesignJet Ink Cartridge pP2v62A

HP 730 130-ml Magenta DesignJet Ink Cartridge pP2V63A

HP 730 130-ml Yellow DesignJet Ink Cartridge pP2v6e4A

HP 730 130-ml Matte Black DesignJet Ink Cartridge P2V65A

HP 730 130-ml Gray DesignJet Ink Cartridge P2V66A

HP 730 130-ml Photo Black DesignJet Ink Cartridge pP2v6e7A

HP 730 300-ml Cyan DesignJet Ink Cartridge P2V68A

HP 730 300-ml Magenta DesignJet Ink Cartridge P2V69A

HP 730 300-ml Yellow DesignJet Ink Cartridge P2V70A

HP 730 300-ml Matte Black DesignJet Ink Cartridge P2V71A

HP 730 300-ml Gray DesignJet Ink Cartridge pP2V72A

HP 730 300-ml Photo Black DesignJet Ink Cartridge pP2v73A
Printhead

Printhead Product number

HP 731 DesignJet Printhead p2v27A

Order paper

The following paper types are currently provided for use with your printer.

l% NOTE: This list is likely to change over the course of time. For the latest information, see
http://www.hplfmedia.com.

[f% NOTE: Paper types that HP does not support may nevertheless be compatible with your printer.

Key to availability:
e (A)indicates papers available in Asia (excluding Japan)

e (Q)indicates papers available in China
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e (E)indicates papers available in Europe, the Middle East and Africa

e  (J)indicates papers available in Japan
e (L)indicates papers available in Latin America

e  (N)indicates papers available in North America

If the part number is not followed by parentheses, the paper is available in all regions.

Roll paper

Paper type g/m? Length Width Product number

HP Bond and Coated Paper

HP Super Heavyweight Plus Matte 210 30.4m (100 ft) 610 mm (24 in) Q66268

Paper
914 mm (36 in) Q66278
1066 mm (42 in) Q6628B

HP Universal Bond Paper 80 45.7m (150 ft) 419 mm (16.5in) (A2) Q1446A (EJ)
594 mm (23.39in) (A1) Q8003A (A)J)

SAOB9A (2 Pack) (J)

610 mm (24 in)

Q1396A

SAQ025A (2 Pack) (J)

974 mm (36 in) Q1397A
1066 mm (42 in) Q1398A
1117 mm (44 in) 2NC45A
91.4 m (300 ft) 594 mm (23.391in) (A1) Q8004A (EA))
840 mm (33.11in) (AD) Q8005A (EA))
174.9m (574 ft) 914 mm (36 in) Q8751A (ELN)
HP Bright White Inkjet Paper 90 45.7m (150 ft) 419 mm (16.5in) Q1446A (EJ)
594 mm (23.4in) (A1) Q1445A (E))
610 mm (24 in) C1860A (LN)
610 mm (24 in) (6035A (EA))
840 mm (33.11 in) (AQ) Q1444A (EA))
914 mm (36 in) C6036A (EA)
914 mm (36 in) C18671A (LN)
91.4m (300 ft) 914 mm (36 in) C6810A
HP Heavyweight Coated Paper 130 30.4m(100ft) 610 mm (24 in) 6029C
914 mm (36 in) €6030C
1066 mm (42 in) 6569C
67.5m (225 ft) 1066 mm (42 in) Q1956A (ELN)
HP Coated Paper 90 45.7m (150 ft) 419 mm (16.54 in) (A2) Q1443A ()
594 mm (23.41in) (A1) Q1442A (AE))
610 mm (24 in) 60198
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Roll paper (continued)

Paper type g/m2 Length Width Product number
840 mm (33.17in) (A0) Q1441A (E))
974 mm (36in) C6020B
1066 mm (42 in) C6567B
91.4 m (300 ft) 914 mm (36in) C6980A
HP Universal Coated Paper 90 45.7m (150 ft) 610 mm (24 in) Q1404B

SA029B (2 Pack) (J)

914 mm (36 in) Q1405B
1066 mm (42 in) Q1406B
HP Universal Heavyweight Coated 131 30.4m (100 ft) 610 mm (24 in) Q14128
Paper
974 mm (36in) Q1413B
1066 mm (42 in) Q1414B
HP Technical Paper
HP Translucent Bond Paper 63 45.7m (150 ft) 610 mm (24 in) (3860A (AJLN)
914 mm (36 in) (3859A (AJLN)
HP Natural Tracing Paper 90 45.7m (150 ft) 594 mm (23.4in) (A1) Q1439A(J)
610 mm (24 in) (3869A
914 mm (36in) (C3868A
HP Film (Technical and Graphic)
HP Clear Film 174 22.8m(75ft) 610 mm (24 in) C3876A
914 mm (36in) (C3875A
HP Matte Film 160 38.1m(125ft) 610 mm (24 in) 51642A
974 mm (36in) 51642B
HP Photographic Paper
HP Universal Gloss Photo Paper 200 30.4m (100 ft) 610 mm (24 in) Q14268
974 mm (36in) Q1247B
1066 mm (42 in) Q1428B
HP Universal Satin Photo Paper 200 30.4m(100ft) 610 mm (24 in) Q1420B
914 mm (36in) Q1421B
1066 mm (42 in) Q1422B
HP Universal Instant-dry Gloss Photo 200 30.4m(100ft) 610 mm (24 in) Q6574A
Paper
914 mm (361n) Q6575A
1066 mm (42 in) Q6576A
60.9 m (200 ft) 1066 mm (42 in) Q8754A (ELN)
HP Universal Instant-dry Satin Photo 200 30.4m (100 ft) 610 mm (24 in) Q6579A
Paper
974 mm (36in) Q6580A
1066 mm (42 in) Q6581A
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Roll paper (continued)
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Paper type g/m2 Length Width Product number
60.9 m (200 ft) 1066 mm (42 in) Q8755A (AELN)
HP Premium Matte Photo Paper 210 30.4m (100 ft) 610 mm (24 in) (G459B
974 mm (36 in) (G460B
HP Backlit Material
HP Premium Vivid Color Backlit Film 285 30.4m (100 ft) 914 mm (36 in) Q8747A
1066 mm (42 in) Q8748A (AELN)
HP Self-Adhesive Material
HP Everyday Adhesive Matte 120 22.8m (75 ft) 610 mm (24 in) COF18A (AELN)
Polypropylene
168 with 914 mm (361in) COF19A (AELN)
iner 1066 mm (42 in) COF20A (AELN)
HP Everyday Adhesive Gloss 140 22.8m (75 ft) 914 mm (36 in) COF28A (AELN)
Polypropylene
190 with 1066 mm (42 in) COF29A (AELN)
liner
HP Universal Adhesive Vinyl 160 20 m (66 ft) 610 mm (24 in) W4Y93A (ELN)
300 with 914 mm (36in) C2T51B (2 Pack) (ELN)
iner 1066 mm (42 in) (27528 (2 Pack) (ELN)
HP Banner and Sign Material
HP Everyday Matte Polypropylene 120 30.4m (100 ft) 610 mm (24 in) CHO22A (AELN)
914 mm (36 in) CHO23A (AELN)
1066 mm (42 in) CHO25A
60.9 m (200 ft) 914 mm (36 in) CHO24A (AELN)
Order other accessories
The following accessories can be ordered for your printer.
Name Product number
HP DesignJet PostScript/PDF Upgrade Kit COCe6B
HP DesignJet 44-inch Roll Feed Spindle Q6709B
HP DesignJet 3-in Spindle Adaptor Kit CN538A
HP SD Pro 44-in Scanner C6H50B
HP HD Pro 42-in Scanner G6H51B
HP USB 3.0 to Gigabit LAN Adapter N7P47AA
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Introduction to the accessories

Spindle

With extra spindles, you can change rapidly from one paper type to another.

Disposal instructions

HP provides many free and convenient ways to recycle your used original HP ink supplies. Additionally, HP
provides a free program for business customers to return signage printed using selected recyclable HP large-
format substrates. For more information about these HP programs, see http://www.hp.com/recycle.

For your printer, the following items can be recycled by the HP supplies recycling program:
e  HP 730 Series 130ml DesignJet Ink Cartridges

e  HP 730 Series 300ml DesignJet Ink Cartridges

e  HP 731 Series DesignJet Printheads

e  HPrecyclable large-format substrates

HP recommends that you wear gloves when handling ink-system components.
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14 Troubleshooting paper issues

° Paper cannot be loaded successfully

° Paper type is not in the driver

° Printer printed on the wrong paper type

° Automatic cut not available

e  Onhold for paper

° Roll paper will not advance

° Paper has jammed

° A strip stays on the output tray and generates jams

° Printer displays out of paper when paper is available

° Prints do not fall neatly into the basket

e  Sheet stays in the printer when the print has been completed

° Paper is cut when the print has been completed

e  (utter does not cut well

° Rollis loose on the spindle

° Recalibrate the paper advance
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Paper cannot be loaded successfully

e  Ensure that no paper is already loaded.
° Ensure that the paper is far enough inside the printer: you should feel the printer grab the paper.

e Do not attempt to straighten the paper during the aligning process, unless instructed to do so by the front-
panel display. The printer automatically attempts to straighten the paper.

e  The paper may be crumpled, or warped, or may have irregular edges.

e |t can be difficult to insert a particularly stiff paper from the upper roll. Try moving it to the lower roll.

General unsuccessful roll load issues

e |If the paper does not load, the leading edge of the paper may not be straight or clean and needs to be
trimmed. Remove the initial 2 cm (1 in) from the roll and try again. This may be necessary even with a new
roll of paper.

e  Ensure the roll ends are tight against the spindle ends.
e  (heck that the spindle is correctly inserted.

e  (Check that the paper is correctly loaded on the spindle. See Load a roll onto the spindle on page 25.

e  (heck that all roll end plugs have been removed.

e  (heck that the paper is wound tightly on the roll.

e Do not touch the roll or paper at during the alignment process.

e  When loading aroll, the roll cover must remain open until the front panel prompts you to close it.

e  When loading the upper roll, avoid inserting the paper into the cut sheet slot.

Unsuccessful roll load
If the paper has not been inserted straight, the printer attempts to straighten the roll.

If you would like to start the load process again, cancel the process on the front panel and rewind the roll from
the end of the spindle until the edge is removed from the printer.

Ej?)y NOTE: If the roll has become loose around the core, the printer cannot load the paper.

Unsuccessful sheet load
e  Guide the sheet, especially thick papers, when the printer initially feeds the sheet.

e  Ensure that the sheet is aligned with the reference line on the roll cover.
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e Do not attempt to straighten the sheet during the loading process, unless instructed to by the front-panel
display.

e Do not use hand-cut sheets, which may be of irregular shapes. Use only purchased sheets.
In case of any problem, follow the instructions given on the front-panel display.

If you would like to start the load process again, cancel the process on the front panel; the printer ejects the
sheet.

Paper loading error messages

Here is a list of front-panel messages related to paper loading, with the suggested corrective action.

Front-panel message Suggested action
Paper incorrectly loaded The paper has not been loaded correctly. Remove the paper.
Paper loaded with too much skew During the paper load process the printer detected that the paper had too much skew.

Follow the instructions on the front-panel display.

Paper loose around core The end of the roll has become loose around the core. Tighten the paper to the core or
insert a new roll.

Paper not detected During the paper load process the printer did not detect any paper. Ensure the paper is
inserted fully and is not transparent.

Roll cover closed during paper load process Do not close the roll cover until you are prompted to do so by the front panel.

Sheet too big During the load process the printer has detected that the sheet of paper is either too wide
or too long to be loaded correctly. Follow the instructions on the front-panel display.

Sheet too small During the load process the printer detected that the sheet of paper is too narrow or too
short to be loaded in the printer. Follow the instructions on the front-panel display.

Upper roll load and paper is inserted through  Avoid inserting roll paper into the cut sheet slot.
the single sheet path

Paper type is not in the driver

To work with a paper not in the driver, you can use your paper as one of the presets already in the driver,
however, you must identify whether your paper is transparent or translucent, glossy or matte.

949

B NOTE: For glossy paper, it is important to use a glossy paper type, as matte black ink does not print well on
glossy paper.

Glossy paper

If your paper is a photo paper, use the Photo Paper category.

Matte paper

If your paper is a matte paper, use any of the papers in the Bond and Coated Paper category. If your paper is
classified as photo matte, its category depends on whether it can hold matte black ink. In this case, try both with
Heavyweight Coated Paper and with Photo Semi Gloss/Satin Paper, and choose the best result.
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General-purpose paper

e  For natural tracing papers, select paper type Natural Tracing Paper < 65 g/m2 or Natural Tracing Paper >
65 g/m2, depending on the weight of the paper.

e  For thin papers (< 90 g/m?) uncoated papers (for example plain paper or bright white paper) select paper
type Bond and Coated Paper > Plain Paper.

e  For light coated papers (< 110 g/m?), select paper type Bond and Coated Paper > HP Coated Paper.

e  For heavyweight coated papers (< 200 g/m?), select paper type Bond and Coated Paper > Heavyweight
Coated Paper.

e  For cockle-free very thick coated papers (> 200 g/m?), select paper type Bond and Coated Paper > Super
Heavyweight Coated Paper.

Black ink is easily removed when touched

This happens when your paper is incompatible with matte black ink. To use non-matte black ink, select any of the
papers in the Photo Paper category.

After printing, the paper has wrinkles or there is too much ink

This happens when too much ink is used. To use less ink, select a thinner category. Matte paper categories from
thinnest to thickest are:

e  Plain Paper

e  (oated Paper

e Heavyweight Coated Paper

e  Super Heavyweight Coated Paper

For other image quality problems, see Troubleshooting print-quality issues on page 141.

Printer printed on the wrong paper type

If the printer prints your job before you were able to load your desired paper, you may have Use Printer Settings
selected for the Paper Type in the printer driver. When either of these is selected, the printer will print
immediately on whichever paper is loaded. Load your desired paper, see Paper handling on page 24, and select
your paper type specifically in the driver.

e Inthe Windows driver dialog: select the Paper/Quality or Paper tab (depending on the driver version), then
select your paper type from the Paper Type list.

e Inthe Mac OS X Print dialog: select the Paper/Quality panel, then select your paper type from the Paper
Type list.

Bf NOTE: Use Printer Settings (Windows) or Any (Mac OS X) is the driver default.

Automatic cut not available

Some paper types, such as canvas, cannot be cut by the automatic cutter. When such a paper type is loaded and
active, the printer cannot switch automatically to the other roll: the active roll must first be unloaded manually.
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On hold for paper

Based on a set of conditions that you can set when sending a job (see Solve paper mismatch on page 71), the
printer will decide which of the loaded rolls of paper is more suitable to print the job. If there is no roll of paper
available that meets all the conditions, the printer will put the job on hold for paper. You can manually resume
the job, forcing it to print on a paper other than the one originally specified, otherwise it will stay on hold.

r.%’ NOTE: When an uncuttable roll is active, every job sent to any other paper source is put on hold until you
manually unload the uncuttable roll.

Which criteria are used to decide on which roll a job will be printed?

When a user sends a job, the desired paper type can be set in the driver. The printer will print the job on a roll of
paper of the chosen paper type that is large enough to print the drawing without clipping. If there is more than
one roll on which the job could be printed meeting all the criteria, the roll will be chosen according to your
preferences. These can be set from the front panel: see Roll policies on page 70.

When is a job put on hold for paper?

If the paper mismatch action is set to Pause and ask (see Solve paper mismatch on page 71), ajob is put on hold
for paper in the following cases:

e  The paper type that has been selected by the user is not currently loaded on the specified roll—or on either
of the rolls, if no roll has been specified.

e  The paper type that has been selected by the user is loaded on the specified roll, but the drawing is too
large to fit on the roll—or on either of the rolls, if no roll has been specified.

If | load a new roll of paper, will jobs that were on hold for paper be automatically
printed?

Yes. Every time a new roll of paper is loaded, the printer will check if there are any jobs on hold for paper that
could be printed on the loaded roll.

| don’t like jobs being put on hold for paper. Can | prevent it?

Yes, this can be done from the front panel: see Solve paper mismatch on page 71.

My job is exactly as wide as the roll of paper that is loaded on the printer, but is put on
hold for paper

Margins are managed in different ways depending on the file type:

e  For HP-GL/2 and HP RTL files, by default, margins are included inside the drawing, so @ 914 mm (36 in) HP-
GL/2 and HP RTL file can be printed on a 914 mm (36 in) roll of paper and will not be put on hold for paper.

e  For other file formats, such as PostScript, PDF, TIFF, or JPEG, the printer assumes that margins need to be
added outside the drawing (as, in many cases, these formats are used for photographs and other images
that do not include margins). This means that, to print a 914 mm (36 in) TIFF, the printer needs to add
margins, and the drawing needs 925 mm (36.4 in) of paper to be printed; this would cause the job to be put
on hold if the paper that is loaded on the printer is only 914 mm (36 in) wide.

If you wish to print these file formats without adding extra margins outside of the drawing, the Clip
contents by margins option can be used. This option will force the margins to be set inside of the drawing,
50 a 914 mm (36 in) TIFF can be printed ona 914 mm (36 in) roll of paper without being put on hold.
However, if there is no white space already included in the drawing’s borders, some contents could be
clipped because of the margins.
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Roll paper will not advance

If you have pushed the printer up against a wall, the roll may be touching the wall at the rear of the printer. Use
the wall spacers to ensure a minimum distance between printer and wall. See Wall spacers (some models only)

on page 9.

Paper has jammed

When a paper jam occurs, you normally see the Possible paper jam message in the front-panel display.

1. Turn off the printer at the front panel.

2. Open the window.

3. Tryto move the printhead carriage out of the way.
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4.  Carefully remove any of the jammed paper that you can lift up and out from the top of the printer.

A CAUTION: Do not move the paper sideways, as it could damage the printer.

5. Rewind the roll.

6.  If the paper is stuck and cannot be rewound further, cut it from the roll.
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7.  Remove all pieces of paper from the rear of the printer.

8.  (Close the window.

9.  Turnon the printer.

10. Reload the roll, or load a new sheet see Paper handling on page 24.

[%9 NOTE: If you find that there is still some paper causing an obstruction within the printer, restart the procedure
and carefully remove all pieces of paper.
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A strip stays on the output tray and generates jams

If a small piece of paper (200 mm or smaller) has been cut, such as before (if new roll) and after a full-bleed print
or after the front-panel option Form feed and cut has been used, the cut strip remains in the output tray. Only
when the printer is not printing, reach into the tray and remove the strip.

Printer displays out of paper when paper is available

If the roll has become loose from its core, it will not feed correctly and the printer will not load the paper. If
possible, tighten the paper to its core or load a new roll.

Prints do not fall neatly into the basket

e  Ensurethat the basket is correctly installed.
e  Ensure that the basket is open.
e  Ensure that the basket is not full.

e  Paper often tends to curl near the end of a roll, which can cause output problems. Load a new roll, or
remove prints manually as they are completed.

Sheet stays in the printer when the print has been completed

The printer holds the paper to allow the print to dry after printing, see Change the drying time on page 36. If the
paper is only partially ejected after the drying time, gently pull the sheet out of the printer. If the automatic cutter
is disabled, use the Form feed and cut option in the front panel, see Feed and cut the paper on page 36.

Paper is cut when the print has been completed

By default the printer cuts the paper after the drying time has been completed, see Change the drying time
on page 36. You can disable the cutter, see Turn the automatic cutter on and off on page 36.

Cutter does not cut well

By default, the printer is set to cut the paper automatically after the drying time has been completed. If the
cutter is turned on but not cutting correctly, check that the cutter rail is clean and clear of any obstacles.

If the cutter is turned off, Form feed and cut only advances the paper. Use it to move the print far enough out of
the front of the printer, until it is convenient to cut manually with a straight edge or scissors.

Roll is loose on the spindle

The roll may need to be replaced or reloaded.

138 Chapter 14 Troubleshooting paper issues ENWW



Ensure that you are using the right core, and use the HP DesignJet 3-in Core Adapter when needed.

Recalibrate the paper advance

Accurate paper advance is important to print quality because it is part of controlling the proper placement of dots
on the paper. If the paper is not advanced the proper distance between printhead passes, light or dark bands
appear in the print and image grain may increase.

The printer is calibrated to advance correctly with all the papers appearing in the front panel. When you select
the type of loaded paper, the printer adjusts the rate at which to advance the paper while printing. However, if
you are not satisfied with the default calibration of your paper, you may need to recalibrate the rate at which the
paper advances. See Troubleshooting print-quality issues on page 141 for steps to determine if paper advance
calibration will solve your issue.

You can check the paper advance calibration status of the currently loaded paper from the front panel at any

time by tapping \g then o then Calibration status. The status may be one of the following:

e  DEFAULT: This status appears when loading any paper that has not been calibrated. HP papers in the Front
Panel have been optimized by default and unless you experience image quality problems in your printed
image such as banding or graininess it is not recommended to recalibrate the paper advance.

e  OK: This status indicates that the loaded paper has been calibrated before. However you may need to
repeat the calibration if you experience print-quality problems such as banding or graininess in your printed
image.

[’_ﬁ”r NOTE: Whenever you update the printer’s firmware, the paper advance calibration values are reset to
factory default, see Update the firmware on page 121.

Recalibrating the paper advance procedure

A CAUTION:  If you are using a transparent paper or film, go directly to step 3 of this procedure.

1. Fromthe front panel, tap \g then Paper advance calibration > Paper advance calibration. The printer
automatically recalibrates the paper advance and prints a paper advance calibration image.

2. Wait until the front panel displays the status page, and reprint your print.

[’_ﬁ”f’ NOTE: The recalibration procedure takes approximately three minutes. Do not worry about the paper
advance calibration image. The front-panel display shows any errors in the process.

If you are satisfied with your print continue using this calibration for your paper type. If you see
improvement in your print, continue with step three. If you are dissatisfied with the recalibration, return to
the default calibration, see Return to default calibration on page 140.

3. If you would like to fine-tune the calibration or are using a transparent paper, tap \g then Paper

advance calibration > Adjust paper advance.

ENWW Recalibrate the paper advance 139



4.  Select the percentage of change from —=100% to +100%. To correct light banding, decrease the percentage.

To correct dark banding, increase the percentage.

5. Tap @ on the front panel to return to the all-apps page.

Return to default calibration

Returning to the default calibration sets all the corrections made by the paper advance calibration to zero. To
return to the default paper advance calibration value, you must reset the calibration.

1. From the front panel, tap \g then {C}, then Reset calibration.

2. Wait until the front panel displays the operation has completed successfully.
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General advice

When you have any print-quality problem:

e  To achieve the best performance from your printer, use only genuine manufacturer's supplies and
accessories, whose reliability and performance have been thoroughly tested to give trouble-free
performance and best-quality prints. For details of recommended papers, see Order paper on page 125.

e  Make sure that the paper type selected in the front panel is the same as the paper type loaded into the
printer (see View information about the paper on page 33). At the same time, check that the paper type has
been calibrated. Also make sure that the paper type selected in your software is the same as the paper
type loaded into the printer.

A CAUTION: If you have the wrong paper type selected, you could experience poor print quality and
incorrect colors, and perhaps even damage to the printheads.

e  (heckthat you are using the most appropriate print-quality settings for your purposes (see Printing
on page 49). You are likely to see lower print quality if you have moved the print-quality slider to the 'Speed'
end of the scale, or set the custom quality level to Fast.

e  (Check that your environmental conditions (temperature, humidity) are in the recommended range. See
Environmental specifications on page 174.

e  (Check that your ink cartridges and printheads have not passed their expiration dates: see Maintain the ink
cartridges on page 120.

Horizontal lines across the image (banding)

If your printed image suffers from added horizontal lines as shown (the color may vary):

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in
your software. See View information about the paper on page 33.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 49). In
Some Cases, you can overcome a print-quality problem merely by selecting a higher print-quality level. For
instance, if you have set the Print Quality slider to Speed, try setting it to Quality. If you change the print-
quality settings, you may wish to reprint your job at this point in case the problem has been solved.

3. Print the Image Diagnostics Print and follow the instructions in Image Diagnostics Print on page 152,
including printhead cleaning if recommended.

4.  If the printheads are working correctly, go to the front panel and tap \g then Paper advance

calibration. Choose the paper source and then Paper advance calibration. See Recalibrate the paper
advance on page 139.
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If the problem persists despite all the above actions, contact your customer service representative for further
support.

Whole image is blurry or grainy

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in
your software. See View information about the paper on page 33.

2. (Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings (see Printing on page 49). In some cases, you
can overcome a print-quality problem merely by selecting a higher print-quality level. For instance, if you
have set the Print Quality slider to Speed, try setting it to Quality. If you change the print-quality settings,
you may wish to reprint your job at this point in case the problem has been solved.

4.  Realign the printheads. See Align the printheads on page 160. After alignment, you may wish to reprint
your job in case the problem has been solved.

5. Clean the printhead drop detector. See Clean the printhead drop detector on page 158.

6.  Goto the front panel and tap \g then Paper advance calibration. Choose the paper source and then

Paper advance calibration. See Recalibrate the paper advance on page 139.

If the problem persists despite all the above actions, contact your customer service representative for further
support.
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Paper is not flat

If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely to see
defects in the printed image, such as vertical stripes. This can happen when you use thin paper that becomes
saturated with ink.

Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in
your software. See View information about the paper on page 33.

Try changing to a thicker paper type, such as HP Heavyweight Coated Paper or HP Super Heavyweight Plus
Matte Paper.

Select a paper type that is slightly thinner than the paper you have loaded; this will cause the printer to use
less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper,
Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

Print is scuffed or scratched

The black ink pigment can be scuffed or scratched when touched by a finger, a pen or some other object. This is
particularly noticeable on coated paper.

Glossy paper may be extremely sensitive to the basket or to anything else that it contacts soon after printing,
depending on the amount of ink used and the environmental conditions at the time of printing.

To reduce the risk of scuffs and scratches:

Handle prints carefully.
Avoid stacking prints on top of each other.

Catch your prints as they are cut from the roll and do not let them fall into the basket. Alternatively, leave a
sheet of paper in the basket so that freshly printed sheets do not make direct contact with the basket.

Try loading the paper in sensitive-paper mode: see Sensitive-paper mode (T1700dr only) on page 32.

Ink marks on the paper

This problem can occur for several different reasons.
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Horizontal smears on the front of coated paper

If a lot of ink is used on plain or coated paper, the paper absorbs the ink quickly and expands. As the printheads

move over the paper, the printheads may come into contact with the paper and smear the printed image. This
problem is normally seen only on cut sheets of paper (not on roll paper).

Whenever you notice this problem, cancel the printing job immediately. Tap . and also cancel the job from your

computer application. Soaked paper can damage the printheads.

Try the following suggestions to avoid this problem:

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in

your software. See View information about the paper on page 33.

2. Usearecommended paper type (see Order paper on page 125) and the correct print settings.

3. Ifusing sheet paper, try rotating the sheet 90 degrees. The orientation of the paper fibers may affect
performance.

4.  Trychanging to a thicker paper type, such as HP Heavyweight Coated Paper and HP Super Heavyweight
Plus Matte Paper.

5. Select a paper type that is slightly thinner than the paper you have loaded; this will cause the printer to use

less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper,
Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

6.  Trytoincrease the margins by relocating the image to the center of the page using your software
application.

Ink marks on the back of the paper

Clean the platen with a soft cloth. Clean each rib separately without touching the foam between the ribs.
Black horizontal lines on yellow background
This problem may be caused by storing the printer in a cold environment.

Go to the front panel and tap \g then Clean printheads.

Black ink comes off when you touch the print

This problem may be caused by printing with matte black ink on glossy paper. The printer will not use matte
black ink if it knows that the paper will not retain it. To be sure of avoiding matte black ink, you can select any
paper type from the Photo Paper category.
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Edges of objects are stepped or not sharp

1. If edges of objects or lines appear to be poorly defined or lighter in density, and you have already set the
print-quality slider to Quality in the driver dialog, select the custom print-quality options, and try setting the
quality level to Normal. See Printing on page 49.

2. Theissue may be related to orientation. Try rotating the image: you may find that the result looks better.

Edges of objects are darker than expected

1. If edges of objects seem darker than expected, and you have already set the print-guality slider to Quality
in the driver dialog, select the custom print-quality options, and try setting the quality level to Normal. See
Printing on page 49.

2. Theissue may be related to orientation. Try rotating the image: you may find that the result looks better.

Horizontal lines at the end of a cut sheet print

This type of defect affects only the end of a print, within approximately 30 mm of the trailing edge of the paper.
You may see some very thin horizontal lines across the print.

To avoid this problem:
1. Consider using larger margins around your image.

2. Print the Image Diagnostics Print. See Image Diagnostics Print on page 152.

3. Consider printing with roll paper.

Vertical lines of different colors

If your print has vertical bands of different colors along it:
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Try using thicker paper, choosing from the recommended paper types such as HP Heavyweight Coated
Paper and HP Super Heavyweight Paper. See Order paper on page 125.

Try using higher print-quality settings (see Printing on page 49). For instance, if you have set the Print
Quality slider to Speed, try setting it to Quality.

White spots on the print

You may notice white spots on the print. This is probably due to paper fibers, dust, or loose coating material. To
avoid this problem:

1.
2.

Try cleaning the paper manually with a brush before printing, to remove any loose fibers or particles.

Always keep the cover of your printer closed, and avoid actions that may introduce dust into the printer,
such as handling or cutting paper on the printer cover.

Protect your paper rolls and sheets by storing them in bags or boxes.

Colors are inaccurate

ENWW

If the colors of your print do not match your expectations, try the following:

1.

Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in
your software. See View information about the paper on page 33.

Tap \g then 0 then Calibration Status to check the color calibration status. If the status is PENDING

or OBSOLETE, you should perform color calibration: see Color calibration on page 76. If you have made any
changes, you may wish to reprint your job in case the problem has been solved.

Check that you are printing on the correct side of the paper.

Check that you are using appropriate print-quality settings (see Printing on page 49). If you have selected
the Speed or Fast options, you may not get the most accurate colors. If you change the print-quality
settings, you may wish to reprint your job at this point in case the problem has been solved.

If you are using Application Color Management, check that the color profile you are using corresponds to
the selected paper type and print-quality settings. If you have doubts about which color settings to use, see
Color management on page 75.

If a grayscale image shows a color cast in some of the gray shadows, click Color > Grayscale in the driver.

If the problem consists of color differences between your print and your monitor, try calibrating your
monitor. At this point, you may wish to reprint your job in case the problem has been solved.

Print the Image Diagnostics Print. See Image Diagnostics Print on page 152.

White spots on the print 147



If the problem persists despite all the above actions, contact your customer service representative for further
support.

Colors are fading

If you print on instant-dry photo paper, your prints will fade rapidly. If you plan to display the prints for more than
two weeks, you should laminate them to achieve longer life.

Alternatively, prints on swellable coated papers such as HP Universal Gloss Photo Paper or HP Universal Satin
Photo Paper will fade much less rapidly.

Lamination can increase the life of prints on all paper types, depending on the type of lamination. For more
information, consult your laminate provider.

Image is incomplete (clipped at the bottom)

Did you tap ° before all the data were received by the printer? If so, you have ended the data
transmission and will have to print the page again.

The I/0 timeout setting may be too short. This setting determines how long the printer waits for the
computer to send more data, before deciding that the job is finished. From the front panel, increase the 1/0

timeout setting to a longer period and then send the print again. Tap @ then Connectivity > Network

> 1/0 timeout.

There may be a communications problem between your computer and the printer. Check your USB or
network cable.

Check to make sure that your software settings are correct for your current page size (for example, long-
axis prints).

If you are using network software, make sure it has not timed out.

Image is clipped

Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and the
printable area as understood by your software. You can often identify this kind of problem before printing by
previewing your print (see Preview a print on page 57).

Check the actual printable area for the paper size you have loaded.
printable area = paper size —margins

Check what your software understands to be the printable area (which it may call "printing area" or
"imageable area"). For example, some software applications assume standard printable areas that are
larger than those used in this printer.

If you have defined a custom page size with very narrow margins, the printer may impose its own minimal
margins, clipping your image slightly. You may want to consider using a larger paper size.

If your image contains its own margins, you may be able to print it successfully by using the Clip Contents
by Margins option (see Select margin options on page 55).

If you are trying to print a very long image on a roll, check that your software is capable of printing an
image of that size.
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If you try to print an image larger than your software can handle, the bottom of the image may be clipped.
To print the whole image, try these suggestions:

—  Save the file in another format, such as TIFF or EPS, and open it with another application.
—  Use aRIP to print the file.
You may have asked to rotate the page from portrait to landscape on a paper size that is not wide enough.

If necessary, reduce the size of the image or document in your software application, so it fits between the
margins.

Some objects are missing from the printed image

Large quantities of data may be necessary to print a high-quality large-format print job, and in some specific
workflows there may be issues that can lead to some objects missing from the output. Here are some
suggestions to help you to avoid this problem:

Select a smaller page size and scale to the desired final page size in the driver or in the front panel.
Save the file in another format, such as TIFF or EPS, and open it with another application.

Use HP Click software to print the file.

Use a RIP to print the file.

Try printing from a USB flash drive.

Reduce the resolution of bitmap images in your application software.

Select a lower print quality in order to reduce the resolution of the printed image.

Ej?)y NOTE: If you are working under Mac 0S X, not all of these options are available.

These options are suggested for troubleshooting purposes and may adversely affect the final output quality or
the time necessary to generate the print job. Therefore, they should be canceled if they do not help to solve the
problem.

Lines are too thick, too thin or missing

S

2/1

2.

3.
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1.

Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in
your software. See View information about the paper on page 33.

Check that you are using appropriate print-quality settings for your purposes (see Printing on page 49).
Select the custom print-quality options in the driver dialog, and try turning on the Maximum detail option (if
available). You may wish to reprint your job at this point in case the problem has been solved.

If the resolution of your image is greater than the printing resolution, you may notice a loss of line quality.
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4.  Iflines are too thin or missing, print the Image Diagnostics Print. See Image Diagnostics Print on page 152.

5. If the problem remains, go to the front panel and tap \g then Printhead alignment to align the

printheads. See Align the printheads on page 160. After alignment, you may wish to reprint your job in
case the problem has been solved.

6.  Go to the front panel and tap \g then perform paper advance calibration: see Recalibrate the paper

advance on page 139.

If the problem persists despite all the above actions, contact your customer service representative for further
support.

Lines appear stepped or jagged

If lines in your image appear stepped or jagged when printed:

1. The problem may be inherent in the image. Try to improve the image with the application you are using to
edit it.

2. Check that you are using appropriate print-quality settings. See Printing on page 49.

3. Select the custom print-quality options in the driver dialog, and turn on the Maximum detail option (if
available).

Lines print double or in the wrong colors

This problem can have various visible symptomes:

e  C(olored lines are printed double, in different colors.

N

N\

e  The borders of colored blocks are wrongly colored.

To correct this kind of problem:
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1. Reseat the printheads by removing them and then reinserting them. See Remove a printhead on page 113
and Insert a printhead on page 115.

2. Align the printheads. See Align the printheads on page 160.

Lines are discontinuous

If your lines are broken in the following way:

1. Check that you are using appropriate print-quality settings. See Printing on page 49.

2. Reseat the printheads by removing them and then reinserting them. See Remove a printhead on page 113
and Insert a printhead on page 115.

3. Align the printheads. See Align the printheads on page 160.

Lines are blurred

Humidity can cause ink to soak into the paper, making the lines blurred and fuzzy. Try the following:

1. Check that your environmental conditions (temperature, humidity) are suitable for high-quality printing.
See Environmental specifications on page 174.

2. Check that the paper type selected in the front panel is the same as the paper type you are using. See View
information about the paper on page 33.

3. Select the custom print-quality options, then select Best and Maximum detail (if available). See High-guality
printing on page 58.

4. Try changing to a heavier paper type, such as HP Heavyweight Coated Paper or HP Super Heavyweight Plus
Matte Paper.

5. Select a paper type that is slightly thinner than the paper you have loaded; this will cause the printer to use
less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper,
Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

6. If you are using glossy paper, try changing to a different type of glossy paper.

7. Align the printheads. See Align the printheads on page 160.
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Line lengths are inaccurate

If you have measured your printed lines and find that the lengths are not sufficiently accurate for your purposes,
you can try to improve line length accuracy in the following ways:

1. Print on HP Matte Film, for which your printer's line length accuracy is specified. See Functional
specifications on page 172.

Polyester film is about ten times more dimensionally stable than paper. However, using film that is thinner
or thicker than HP Matte Film will reduce line length accuracy.

2. Set the Print Quality slider to Quality.
3. Maintain the room at a steady temperature between 10 and 30°C (50 and 86°F).
4.  Load the roll of film and let it rest for five minutes before printing.

5. If you are still not satisfied, try recalibrating the paper advance. See Recalibrate the paper advance
on page 139.

Image Diagnostics Print

The Image Diagnostics Print consists of patterns designed to highlight printhead reliability problems. It helps you
to check the performance of the printheads that are currently installed in your printer, and whether any printhead
suffers from clogging or other problems.

To print the Image Diagnostics Print:
1. Use the same paper type that you were using when you detected a problem.

2. (Check that the selected paper type is the same as the paper type loaded into the printer. See View
information about the paper on page 33.

3. Atthe printer's front panel, tap \g then o then Print diagnostic image.

It takes about two minutes to print the Image Diagnostics Print.
The print is divided into two parts, both of which test printhead performance:

e  Part 1 (top) consists of rectangles of pure colors, one for each printhead. This part represents the print
quality that you will get from each color.

e  Part 2 (bottom) consists of small dashes, one for each nozzle on each printhead. This part complements
the first, and aims more specifically to detect how many faulty nozzles each printhead has.

Look carefully at the print. The names of the colors are shown above the rectangles and in the center of the
patterns of dashes.
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First look at the upper part of the print (part 1). Each colored rectangle should be a uniform color without any
horizontal lines across it.

Then look at the bottom part of the print (part 2). For each individual colored pattern, check that most of the
dashes are present.

If you see horizontal lines in part 1 and also missing dashes in part 2 for the same color, the printhead
responsible needs cleaning. However, if the rectangles look solid, do not worry about just a few missing dashes in
part 2; these are acceptable because the printer can compensate for a few clogged nozzles.

Here is an example of a gray printhead in a good state:

G

And here is an example of the same printhead in a bad state:

ENWW Image Diagnostics Print 153



Corrective action

1.

Clean any faulty printheads (see Clean the printheads on page 157). Then reprint the Image Diagnostics
Print to see whether the problem has been solved.

If the problem remains, clean the printheads again, and reprint the Image Diagnostics Print to see whether
the problem has been solved.

If the problem remains, consider cleaning your printheads manually (see Clean the printheads
on page 157). You could also try reprinting your current print job, in case it now prints satisfactorily.

If the problem remains, try cleaning the printhead drop detector. The printer normally notifies you when
this is necessary, but it may be worth trying even if the printer has not suggested it. See Clean the printhead
drop detector on page 158.

If the problem still remains, replace any persistently faulty printheads (see Handling ink cartridges and
printheads on page 108), or contact HP Support (see Contact HP Support on page 170).

If you still have a problem

If you still experience print-quality problems after applying the advice in this chapter, here are some further
things that you can do:

Try using a higher print-quality option. See Printing on page 49.

Check the driver you are using to print with. If it is a non-HP driver, consult the driver vendor about the
problem. You could also try using the correct HP driver, if feasible. The latest HP drivers can be downloaded
from http://www.hp.com/go/T1700/drivers.

If you are using a non-HP RIP, its settings may be incorrect. See the documentation that came with the RIP.

Check that your printer's firmware is up to date. See Update the firmware on page 121.

Check that you have the right settings in your software application.
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16 Troubleshooting ink cartridge and printhead
issues

° Cannot insert an ink cartridge

° Ink cartridge status messages

° Cannot insert a printhead

° Front panel recommends reseating or replacing a printhead

° Clean the printheads

° Clean the printhead drop detector

e  Align the printheads

° Printhead status messages
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Cannot insert an ink cartridge

1.
2.
3.

Check that you have the correct type of cartridge (model number).

Check that the colored label on the cartridge is the same color as the label on the slot.

Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label right-side

up and readable.

A CAUTION:  Never clean inside the ink cartridge slots.

Ink cartridge status messages

These are the possible ink cartridge status messages:

Cannot

Front panel recommends reseating or replacing a printhead
1.
2.

OK: The cartridge is working normally, with no known problems.

Missing: There is no cartridge present, or it is not correctly connected to the printer.

Low: The ink level is low.

Very low: The ink level is very low.

Empty: The cartridge is empty.

Reseat: You are recommended to remove the cartridge and then reinsert it.
Replace: You are recommended to replace the cartridge with a new cartridge.
Expired: It is past the cartridge's expiration date.

Non-HP: The cartridge contains ink not made by HP.

Wrong: The cartridge family or model is wrong, or it has been inserted wrongly.

Altered: The cartridge has been altered (refilled).

insert a printhead

Check that you have the correct type of printhead (model number).
Check that you have removed the two orange protective caps from the printhead.

Check that the printhead is correctly oriented (compare with the others).

Check that you have correctly closed and latched the printhead cover, see Insert a printhead on page 115.

From the front panel, turn the power off then on.

Check the front-panel display message, if it shows the ready message, the printer is ready to print. If the

problem remains continue with the next step.

Remove the printhead, see Remove a printhead on page 113.
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4.  (lean the electrical connections on the backside of the printhead with a lint free cloth. You can carefully use
a mild rubbing alcohol if moisture is needed to remove residue. Do not use water.

A CAUTION: Thisis a delicate process and may damage the printhead. Do not touch the nozzles on the
bottom side of the printhead, especially not with any alcohol.

CAUTION: Do not leave the printhead outside the printer for a long time. If this is absolutely necessary,
cover the printhead with the original orange caps, then store it in a horizontal position.

5. Reinsert the printhead, see Insert a printhead on page 115.

6.  Check the front-panel display message. If the problem remains, try a new printhead.

Clean the printheads

As long as the printer is kept turned on, automatic cleaning is performed periodically. This ensures there is fresh
ink in the nozzles and prevents nozzle clogs, which ensures color accuracy. If you have not already done so, see
Image Diagnostics Print on page 152 before proceeding.

To clean the printheads, go to the front panel and tap \g then Clean printheads. If you have gone through

the Image Quality Diagnostic print process, you know which colors are failing. Select the pair of printheads which
contain the failing colors. If you are not sure which colors to clean, you can also select to clean all printheads.
Cleaning all printheads takes about nine minutes. Cleaning a single pair of printheads takes about six minutes.

[%”Nf NOTE: Cleaning all printheads uses more ink than cleaning a single pair.

If you have cleaned the printheads using the Clean printheads procedure from the front panel and are still
experiencing print-quality problems, you can try cleaning the printhead nozzles manually using the following
procedure.

A CAUTION: This is a delicate process, which may damage the printhead. Do not touch the electrical connections
on the rear of the printhead.

First remove the printhead (see Remove a printhead on page 113), then use a lint-free cloth to clean the bottom
of the printhead until the residue is removed.
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Clean the printhead drop detector

The printhead drop detector is a sensor that detects which nozzles on the printheads are not printing in order to
substitute them for good printing nozzles. If particles, such as fibers, hair or paper pieces, block the sensor print-
quality is affected.

When the front panel displays a warning message that the clean process is needed, you are recommended to
clean the printhead drop detector. If you do not clean the printhead drop detector immediately, the printer
continues working normally, however, the front panel display continues to show the warning.

A CAUTION:  Wear gloves to avoid getting ink on your hands.

W

Turn off the printer at the front panel.

2. Toavoid an electric shock, turn off the printer and unplug it.

158 Chapter 16 Troubleshooting ink cartridge and printhead issues ENWW



3. Open the window.

4.  Find the printhead drop detector beside the stored printhead carriage.

5. Remove any debris blocking the printhead drop detector.

6.  With adry, lint-free cloth, wipe the surface of the drop detector to remove any non-visible debris.

e

7.  Close the window.
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8. Pluginand turnon the printer.

9.  Power the printer on at the front panel.

Align the printheads

Precise alignment between printheads is essential for accurate colors, smooth color transitions and sharp edges
in graphical elements. Your printer has an automatic printhead alignment process which runs whenever a
printhead has been accessed or replaced.

In cases where the paper has jammed or you are experiencing problems with color accuracy, see Color
management on page 75; you may need to align the printheads.

[%’ NOTE: If the paper has jammed, it is recommended that you reinsert the printheads and initiate the

realignment procedure by tapping \g then Printhead alignment.

A CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

Reinsert printheads procedure

1. If the realignment process is running and the wrong paper is loaded, tap ° on the front panel.

A CAUTION: Do not print if the realignment process has been canceled. You can restart the alignment by

tapping \g then Printhead alignment.

2. Load the paper you wish to use, see Paper handling on page 24. You can use a roll that is at least 610 mm
(24 in) wide or a cut sheet that is A2 landscape or larger.

A CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

3. Remove and re-insert all the printheads, see Remove a printhead on page 113 and Insert a printhead
on page 115. This starts the printhead alignment procedure.

160 Chapter 16 Troubleshooting ink cartridge and printhead issues ENWW



4.  Ensure the window is closed, as a strong light source near the printer during printhead realignment can
affect alignment.

5. The process takes about six minutes. Wait until the front-panel display shows the process complete before
using the printer.

@ NOTE: The printer prints a calibration image. Do not worry about the image. The front-panel display
shows any errors in the process.

Image-quality maintenance menu procedure

1.  Load the paper you wish to use, see Paper handling on page 24. You can use a roll or cut sheet, however, it
must be A3 landscape or larger (420 by 297 mm).

A CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

2. Fromthe front panel, tap ‘g then Printhead alignment. The printer checks to see if it has enough
paper to run the realignment.

3. Ifthe loaded paper is satisfactory, the printer runs the realignment and prints a realignment pattern.
Ensure the window is closed, as a strong light source near the printer during printhead realignment can
affect alignment.

4. The process takes about five minutes. Wait until the front-panel display shows the process complete before
using the printer.
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Scanning errors during alignment

If the alignment process fails, a Scanning problems message appears on the front panel. This means that the
alignment has not completed successfully. Therefore the printer is not aligned and the alignment should be
repeated in order to print with good print quality. The problem may have various causes:

e  The paper used was not valid, repeat the alignment with valid paper.

e  Printhead health problems, clean printheads, see Clean the printheads on page 157.

e  Thealignment was done with the window open, repeat the alignment with the window closed.

If the problem persists after using valid paper, cleaning the printheads and keeping the window closed, there
may be a failure in the scanning system needing repair; or the printheads, although clean, may not work and
need to be replaced.

Printhead status messages

These are the possible printhead status messages:
e  OK:the printhead is working normally, with no known problems.
e  Missing: there is no printhead present, or it is not correctly installed in the printer.

e  Test printhead separately: you are recommended to test the printheads individually to find the failing
printhead. Remove all the printheads and insert them alone one by one, closing the latch and the carriage
cover after every insertion. The front-panel display indicates the failing one showing the reseat or replace
message.

e  Reseat: you are recommended to remove the printhead and then reinsert it. If that fails, clean the electrical
connections, see Front panel recommends reseating or replacing a printhead on page 156. If that fails,
replace the printhead with a new printhead, see Remove a printhead on page 113 and Insert a printhead
onpage 115.

e  Replace: the printhead is failing. Replace the printhead with a working printhead, see Remove a printhead
on page 113 and Insert a printhead on page 115.

e  Replacement incomplete: a printhead replacement process has not completed successfully, re-launch the
replacement process and let it finish completely (it is not needed to change the printheads).

e  Remove: the printhead is not a suitable type for use in printing.
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17 Troubleshooting general printer issues

° Printer does not print

° Front panel fails to initialize

° Printer seems slow

° Communication failures between computer and printer

° Cannot access the Embedded Web Server

° Cannot connect to the Internet

° Web Services issues

e  Automatic file system check

° Alerts
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Printer does not print

If all is in order (paper loaded, all ink components installed and no file errors), there are still reasons why a file
you have sent from your computer may not start printing when expected:

You may have an electrical power problem. If there is no activity at all from the printer, and the front panel
does not respond, check that the power cable is connected correctly and that there is power available at the
socket. Press the power key for 5 seconds to reset the printer.

You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic fields or
severe electrical disturbances, which can cause the printer to behave strangely or even stop working. In this
case, turn off the printer using the power key on the front panel and unplug the power cord, wait until the
electromagnetic environment has returned to normal, then turn it on again. If you still experience
problems, contact your support representative.

Nesting may be on, and the printer is waiting for the specified nest wait time before calculating the
appropriate nests. In this case, the front panel shows the remaining time needed for nesting.

You may have the wrong graphic language setting, see Change the graphic language setting on page 21.

You may not have installed in your computer the correct driver for your printer, see the Assembly
instructions.

If you are printing on a sheet, you must specify Single sheet as the paper source in your printer driver.

The printer may be holding the job for suitable paper (see On hold for paper on page 134) or accounting ID
information (see Reqguire account ID on page 20).

You may have requested a print preview from your printer driver. This is a function you can use to check
that the image is the one you want. In this case, the preview is displayed on your screen, and you must click
the Print button to start printing.

Front panel fails to initialize

If the printer will not start (the front panel is blank or the diagnostic LEDs are all off), you are recommended to
replace the firmware, in the following way:

1.
2.

Go to the HP Support Center (see HP Support Center on page 169) and download the firmware.

Save the firmware on a USB flash drive. Ideally, the USB flash drive should be empty and formatted with the
FAT filesystem.

Ensure that the printer is turned off. Connect the USB flash drive to the Hi-Speed USB host port beside the
front panel, then turn the printer on.

The printer takes about a minute to read the firmware file, then asks you to remove the USB flash drive.

The printer automatically installs the new firmware and restarts.

Printer seems slow

Here are some possible explanations:

Did you set the print quality to Best or Maximum detail? Best-quality and maximum detail prints take
longer.

Did you specify the correct paper type when loading the paper? Some paper types require more time for
printing; for example, photo and coated papers require more drying time between passes. To find out the
printer's current paper type setting, see View information about the paper on page 33.
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e If your printer is connected by network, check that all components used in the network (network interface
cards, hubs, routers, switches, cables) are capable of high-speed operation. Is there a lot of traffic from
other devices on the network?

e Didyou specify Extended drying time in the front panel? Try changing the drying time to Optimal.

Communication failures between computer and printer

Some symptoms are:

e The front-panel display does not show the Receiving message when you have sent an image to the printer.
e  Your computer displays an error message when you are trying to print.

e  Your computer or printer hangs (stays idle), while communication is taking place.

e  Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)

To solve a communication problem:

e  Ensure that you have selected the correct printer in your application, see Printing on page 49.

e  Ensure that the printer works correctly when printing from other applications.
e  Remember that very large prints may take some time to receive, process and print.

e If your printeris connected to your computer through any other intermediate devices, such as switch boxes,
buffer boxes, cable adapters, cable converters, and so on, try using it when connected directly to your
computer.

e  Tryanother interface cable.

e  Ensure that the graphic language setting is correct, see Change the graphic language setting on page 21.

e Ifthe printer is connected by network, check that your printer has a static IP address. If it is using DHCP, the
IP address may change every time it is turned on, in which case the driver may not be able to find it.

Cannot access the Embedded Web Server

If you have not done so already, read Embedded Web Server on page 14.

From the front panel, tap @ then Security > Embedded Web Server.

If you are using a proxy server, try bypassing the server and accessing the Web server directly:

e Ininternet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN Settings, and check
the Bypass proxy server for local addresses box. Alternatively, for more precise control, click the Advanced
button and add the printer's IP address to the list of exceptions, for which the proxy server is not used.

e InSafari for Mac OS X, go to Safari > Preferences > Advanced and click the Proxies: Change Settings button.
Add the printer's IP address or its domain name to the list of exceptions, for which the proxy server is not
used, in the Bypass proxy settings for these Hosts & Domains field.

If you still cannot connect, turn the printer off and back on with the power key on the front panel.

Cannot connect to the Internet

If your printer has difficulty in connecting to the Internet, it may start the Connectivity Wizard automatically.

ENWW Communication failures between computer and printer 165



The Connectivity Wizard performs a series of tests automatically.

If any test fails, the printer describes the problem and recommends how to solve it. You can modify settings and
rerun the test, unless the settings are protected.

Web Services issues

For any issues with HP ePrint, see HP Connected: http://www.hpconnected.com.

Automatic file system check

When you turn on the printer, you will occasionally see a front panel message: File system check.

A file system check is taking place; it can take up to 40 minutes. Please wait until it finishes.

A CAUTION: If you turn the printer off before the file system check has finished, the file system could be seriously
damaged, making the printer's hard disk unusable. In any case, the file system check will restart from the
beginning whenever you turn the printer on again.

A file system check is scheduled every 90 days, in order to maintain the hard disk’s file system integrity.

[%/]’9 NOTE: When the printer is powered back on, it takes about three minutes to initialize and check and prepare the
printheads. However, it can take up to 40 under some conditions, for example, when the printer has not been
used for a long period of time and requires more time to prepare the printheads.

Alerts

Your printer can communicate two types of alerts:

e  Errors: Mainly alerting you to the fact that the printer is unable to work normally. However, in the printer
driver, errors can also alert you to conditions that could ruin the print, such as clipping, even if the printer is
able to print.

e  Warnings: Alert you when the printer needs attention either for an adjustment, such as a calibration or for a
possible unprintable situation, such as a preventive maintenance or low ink.

There are four different alerts communicators within your printer's system:

e  Front-panel display: The front panel shows only the most relevant alert at a time. In the case of a warning,
it disappears after a timeout. There are permanent alerts, such as "ink cartridge low on ink", that reappear
when the printer becomes idle and there is not another more severe alert.

¥ TIP: From the front panel display you can configure paper mismatch alerts, see Solve paper mismatch
on page 71.

e Embedded Web Server: The upper-right corner of the Embedded Web Server window shows the printer
status. If there is an alert in the printer, the status shows the alert text.

e  Driver: The driver warns about job configuration settings that may produce a problem in the final output. If
the printer is not ready to print, it displays a warning.

e  HP DesignJet Utility: To see alerts, go to the Overview tab and review the Items needing attention list on the
right-hand side.

By default, alerts are displayed only when you are printing. If alerts are enabled and there is a problem that
prevents a job from completing, you see a pop-up window, which explains the reason for the problem.
Follow the instructions to achieve your required result.
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18 Front-panel error messages

The printer may occasionally display a system error, consisting of a numerical code of 12 digits followed by the
recommended action that you should take.

In most cases you will be asked to restart the printer, because when the printer starts it can diagnose the issue
better and may be able to fix it automatically. If the problem persists after restarting, you should contact your
support representative and be ready to give the numerical code from the error message.

If the error message contains some other recommended action, follow the printer’s instructions.

System error log

The printer saves a log of system errors that you can access in the following way.

Using a USB flash drive
1. Take astandard USB flash drive, formatted as FAT32.

2. Create an empty file in the USB flash drive (right-click, New > Text Document), and name it
pdipu_enable.log.

3. Whenan error message is displayed on the front panel, insert the USB flash drive into the Hi-Speed USB
host port at the front of the printer. The log is automatically copied into the drive. You can remove the USB
flash drive when prompted by the front panel.

4.  Contact your support representative (see Contact HP Support on page 170) to share the file created in the
USB flash drive.

Using the Embedded Web Server
1. Inyour Web browser, go to https://printer IP address/hp/device/support/serviceSupport.
2. Click the Download button to get the Diagnostic package.

3. Save the package in your computer and contact your support representative (see Contact HP Support
on page 170).
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19 HP Customer Care

° Introduction

° HP Professional Services

] Customer Self Repair

e  (ontact HP Support
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Introduction

HP Customer Care offers award-winning support to ensure you get the most from your HP DesignJet, providing
comprehensive, proven support expertise and new technologies to give you unigue end-to-end support. Services
include setup and installation, troubleshooting tools, warranty upgrades, repair and exchange services, phone
and Web support, software updates and self-maintenance services. To find out more about HP Customer Care,
see Contact HP Support on page 170.

To register your warranty, visit http://register.hp.com/.

HP Professional Services

HP Support Center

Enjoy a world of dedicated services and resources to ensure you always get the best performance from your
HP DesignJet printers and solutions.

Join the HP community at the HP Support Center, your large-format printing community, for 24x7 access to:

e  Multimedia tutorials

e  Step-by-step how-to guides

e  Downloads: the latest printer firmware, drivers, software, paper presets, etc.

e  Technical support: online troubleshooting, customer care contacts and more

e  Workflows and detailed advice for completing various printing tasks from particular software applications
e  Forums for direct contact with the experts, both HP and your colleagues

e  Warranty tracking online, for your peace of mind

e  Latest product information: printers, supplies, accessories, software, etc.

e  Supplies Center for all you need to know about ink and paper

The HP Support Center can be found at http://www.hp.com/go/T1700/support.

By customizing your registration for the products you have purchased and your type of business, and by setting
your communication preferences, you decide the information you need.

Download printer software

Install the printer software from http://www.hp.com/go/T1700/drivers. Be sure to follow the software
installation instructions.

HP Care Packs and Warranty Extensions
HP Care Packs and Warranty Extensions allow you to extend your printer's warranty beyond the standard period.

They include remote support. On-site service is also provided if necessary, with two alternative response-time
options:

e  Next business day
e  Same business day, within four hours (may not be available in all countries)
There is an HP Installation service that unpacks, sets up, and connects the printer for you.

For more information on HP Care Packs, see http://cpc.ext.np.com/portal/site/cpc.
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Customer Self Repair

HP's Customer Self Repair program offers our customers the fastest service under either warranty or contract. It
enables HP to ship replacement parts directly to you (the end user) so that you can replace them. Using this
program, you can replace parts at your own convenience.

Convenient, easy to use

e  AnHP Support Specialist will diagnose and assess whether a replacement part is required to address a
defective hardware component.

e  Replacement parts are express-shipped; most in-stock parts are shipped the very same day you contact

HP.

e  Available for most HP products currently under warranty or contract.

° Available in most countries.

For more information about Customer Self Repair, see http://www.hp.com/go/selfrepair.

Contact HP Support

HP Support is available to you by telephone. What to do before you call;

e  Review the troubleshooting suggestions in this document.

° Review the relevant driver documentation.

e Ifyou have installed third-party software drivers and RIPs, see their documentation.

e Ifyou call your support representative, please have the following information available to help us answer
your questions more quickly:

The product you are using (the product number and the serial number, found on the label at the back
of the product).

If there is an error code on the front panel, note it down; see Front-panel error messages
on page 167.

The computer you are using.

Any special equipment or software you are using (for example, spoolers, networks, switch-boxes,
modems or special software drivers).

The type of interface used on your product (USB or network).
The software and driver name and version number that you are currently using.

The Printer Service information, which you can get from the Embedded Web Server. In a Web browser,
enter the IP address of your printer to access the Embedded Web Server. Then click Support > Service
support > Service information > Display. If you need to send the information by email, you can
download it as a file from your browser, and later send the file.

'L%y NOTE: After you click Display, your browser may prevent the pop-up window from opening. In this

case, you have to find the browser option that allows the window to open.

Alternatively, from your browser you can send the page directly: click File > Send > Page by email.

Telephone number

Your HP Support telephone number is available on the Web: see http://welcome.hp.com/country/us/en/
wwcontact_us.html.
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20 Printer specifications

° Functional specifications

° Physical specifications

° Memory specifications

° Power specifications

° Ecological specifications

° Environmental specifications

° Acoustic specifications
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Functional specifications

HP ink supplies

Printheads Universal printheads, which can be inserted into any of the available slots. Once initialized in
a particular slot, they cannot be moved to another.

Ink cartridges Cartridges containing 130 ml of ink: matte black, photo black, light gray, cyan, magenta,
yellow
Cartridges containing 300 ml of ink: matte black, photo black, light gray, cyan, magenta,
yellow

Paper sizes

Minimum Maximum

Roll width 279 mm (11 in) 1118 mm (44 in)

Roll length 91 m (300 feet)

Roll diameter 135mm (5.3 in)

Roll weight 11.9kg (26.3 b)

Sheet width 210 mm (8.26 in) 1118 mm (44 in)

Sheet length

279 mm (11 in)

1676 mm (66 in)

Paper thickness

0.5 mm (19.68 mil)

Paper weight

60 g/m2

328 g/mz

Printing resolutions

Self-adhesive material, banner, backlit, glossy

paper Coated, bond, film, technical

Maximum Rendering resolution  Printing resolution Rendering resolution  Printing resolution
Print quality detail (ppi) (dpi) (ppi) (dpi)
Best On 1200 x 1200 2400 = 1200 600 x 600 1200 x 1200

Off 600 x 600 1200 x 1200
Normal On/Off 600 x 600 1200 x 1200 600 x 600 1200 x 1200
Fast On/Off - - 600 x 600 1200 x 1200
Economode On/Off - - 300 = 300 600 x 1200

Margins

Top, right and left margins

3 mm (0.1 in) (default)

5 mm (0.2 in) (optional)

Bottom margin (trailing edge)

3 mm (0.1 in) (roll, default)
5 mm (0.2 in) (roll, optional)

17 mm (0.67 in) (sheet)
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Mechanical accuracy

+0.1% of the specified vector length or +0.2 mm (whichever is greater) at 23°C (73°F), 50-60% relative humidity, on E/AQ printing material
in Best or Normal mode with HP Matte Film roll feed.

Graphic languages supported

HP DesignJet Languages

T1700, T1700dr HP-PCL3GUI, HP-GL/2, CALS G4, TIFF, JPEG

T1700PS, T1700dr PS HP-PCL3GUI, HP-GL/2, CALS G4, TIFF, JPEG, Adobe PDF 1.7 ext. 3, Adobe PostScript 3

Physical specifications

Printer physical specifications

T1700 T1700dr
Weight 88.9kg (196 b) 89.4kg (197.1 lb)
Width 1802 mm (70.9in)
Depth 695 mm (27.4in)
Height 997 mm (39.3in)

The depth is measured without the upper spindle; wall spacers up; ink cover opened; roll covers and basket
closed.

Memory specifications

Memory specifications
Virtual memory 128 GB
Hard disk 500 GB

Power specifications

Printer power specifications

Input voltage 100-240V ac +10%, auto-ranging
Frequency 50/60 Hz

Maximum current 2A

Power 100 W

Ecological specifications

This product complies with the WEEE Directive 2012/19/EU and RoHS Directive 2011/65/EU. To determine the
ENERGY STAR and EPEAT registration status of your product model, see http://www.hp.com/go/ecolabels.

ENWW Physical specifications 173


http://www.hp.com/go/ecolabels

Environmental specifications

Printer environmental specifications

Operating temperature 510 40°C (41 to 104°F)

Recommended operating temperature 15 to 35°C (59 to 95°F), depending on paper type
Storage temperature —25t055°C (<13 to 131°F)

Recommended operating humidity 20 to 80% RH, depending on paper type

Storage humidity 0to95% RH

Acoustic specifications
Printer acoustic specifications (declared according to ISO 9296).

Printer acoustic specifications

Idle sound pressure 32dB(A)
Idle sound power <5.0B(A)
Operating sound pressure 45 dB (A)
Operating sound power <6.1B(A)
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Glossary

AirPrint
Atechnology used by iPod, iPhone, iPad, and Mac 0S X that allows immediate printing to a printer on the same network
without the need for a printer-specific driver.

AppleTalk
A suite of protocols that Apple Computer developed in 1984 for computer networking. Apple now recommends TCP/IP and
Bonjour networking instead. HP DesignJet products no longer support AppleTalk.

Bonjour

Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a computer network
technology used in Apple's Mac OS X from version 10.2 onwards. It is used to discover services available on a local area
network. It was originally known as Rendezvous.

Color accuracy
The ability to print colors that match the original image as closely as possible, bearing in mind that all devices have a limited
color gamut and may not be physically capable of matching certain colors precisely.

Color consistency
The ability to print the same colors from a particular print job from print to print and from printer to printer.

Color model
A system of representing colors by numbers, such as RGB or CMYK.

Color space

A color model in which each color is represented by a specific set of numbers. Many different color spaces can use the same
color model: for instance, monitors generally use the RGB color model, but they have different color spaces, because a
particular set of RGB numbers results in different colors on different monitors.

Cutter
A printer component that slides back and forth across the platen to cut the paper.

ESD

ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door, or the cling of
clothing. Although controlled static electricity has some useful applications, uncontrolled electrostatic discharges are one of
the main hazards to electronic products. Therefore, to prevent damage some precautions are needed when setting up the
printer, or handling ESD sensitive devices. This type of damage may reduce the life expectancy of the device. One way to
minimize uncontrolled ESDs, and therefore reduce this type of damage is by touching any exposed grounded part of the
printer (mainly metal parts) before handling ESD sensitive devices (such as the printheads or ink cartridges). Additionally, to
reduce the generation of electrostatic charge in your body try to avoid working in a carpeted area, and keep your body
movements to @ minimum when handling ESD sensitive devices. Also, avoid working in low humidity environments.

Ethernet
A popular computer networking technology for local area networks.

Firmware
Software that controls your printer's functionality and is stored semi-permanently in the printer (it can be updated).

Gamut
The range of colors and density values reproducible on an output device, such as a printer or monitor.
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Gigabit Ethernet
An Ethernet network capable of transferring data at up to 1,000,000,000 bits/second. Gigabit Ethernet interfaces are
capable of negotiating slower speeds when required for compatibility with older Ethernet devices.

HP-GL/2
HP Graphics Language 2: a language defined by HP to describe vector graphics.

HP RTL
HP Raster Transfer Language: a language defined by HP to describe raster (bitmap) graphics.

I/0
Input/Output: this term describes the passing of data between one device and another.

ICC
The International Color Consortium, a group of companies that have agreed on a common standard for color profiles.

Ink cartridge
A removable printer component that stores ink of a particular color and provides it to the printhead.

IP address
May mean an IPv4 address (most likely) or an IPv6 address.

IPSec

A sophisticated mechanism for providing network security by authenticating and encrypting IP packets sent between nodes
on a network. Each network node (computer or device) has an IPSec configuration. Applications are usually unaware
whether IPSec is being used or not.

IPv4 address
A unique identifier that identifies a particular node on an IPv4 network. An IPv4 address consists of four integers separated
by full stops. Most networks in the world use IPv4 addresses.

IPv6 address

A unique identifier that identifies a particular node on an IPv6 network. An IPv6 address consists of up to 8 groups of
hexadecimal digits separated by colons. Each groups contains up to 4 hexadecimal digits. Only a few new networks in the
world use IPv6 addresses.

Jetdirect
HP's brand name for its series of print servers that allow a printer to be connected directly to a local area network.

LED
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

MAC address
Media Access Control address: a unigue identifier used to identify a particular device on a network. It is a lower-level identifier
than the IP address. Thus, a device may have both a MAC address and an IP address.

Network

A network is a set of connections that pass data between computers and devices. Every device is able to communicate with
every other device in the same network. This allows data to be moved between computers and devices, and allows devices
such as printers to be shared between many computers.

Nozzle
One of many tiny holes in a printhead through which ink is deposited onto the paper.

Paper
A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which are pulped,
dried and pressed.

Platen
The flat surface within the printer over which the paper passes while it is being printed on.

Printer driver
Software that converts a print job in a generalized format into data suitable for a particular printer.
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Printhead
A removable printer component that takes ink of one or more colors from the corresponding ink cartridge(s) and deposits it
on the paper, through a cluster of nozzles. In your printer, each printhead prints two different colors.

Spindle
Arod that supports a roll of paper while it is being used for printing.

TCP/IP
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is based.

USB
Universal Serial Bus: a standard serial bus designed to connect devices to computers.

USB host port
A rectangular USB socket such as those on found on computers. A printer can control USB devices that are connected to
such a port. Your printer has two USB host ports, which it uses to control accessories and USB flash drives.
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